@
USER’S GUIDE

Step-by-step instructions for:
Managing your workspace
Working with files and disks
Using applications
Working with text and graphics

Sending mail and faxes

Plus: A complete reference

NEXTSTEP

Object-0riented Software




We at NeXT have tried to make the information contained in this manual as accurate and reliable as
possible. Nevertheless, NeXT disclaims any warranty of any kind, whether express or implied, as to any
matter whatsoever relating to this manual, including without limitation the merchantability or fitness for
any particular purpose. NeXT will from time to time revise the software described in this manual and
reserves the right to make such changes without obligation to notify the purchaser. In no event shall
NeXT be liable for any indirect, special, incidental, or consequential damages arising out of purchase or
use of this manual or the information contained herein.

Copyright © 1992-1994 NeXT Computer, Inc., 900 Chesapeake Drive, Redwood City, CA 94063.
All rights reserved.
[6513.00]

NEXTSTEP Release 3 copyright © 1988-1994 NeXT Computer, Inc. All rights reserved.
Certain portions of the software are copyrighted by third parties.

NeXT, the NeXT logo, NEXTSTEP, the NEXTSTEP logo, NeXTmail, Digital Librarian, Digital Webster, Lip
Service, and Workspace Manager are trademarks of NeXT Computer, Inc. PostScript is a registered
trademark of Adobe Systems, Inc. Macintosh is a registered trademark of Apple Computer, Inc. VT100
is a trademark of Digital Equipment Corporation. Webster’s Ninth New Collegiate Dictionary, Collegiate,
and Wreath & Monogram are registered trademarks of Merriam-Webster Inc. and used herein pursuant
to license. Novell and NetWare are registered trademarks of Novell, Inc. Helvetica and Times are
registered trademarks of Linotype AG and/or its subsidiaries. PANTONE is a registered trademark of
Pantone, Inc UNIX is a registered trademark in the United States and other countries, licensed
exclusively through X/Open Company Limited. All other trademarks mentioned belong to their
respective owners.

U.S. Pat. No. 4,982,343. Other patents pending.

Restricted Rights Legend: Use, duplication, or disclosure by the Government is subject to restrictions as
set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at
DFARS 252.227-7013 [or, if applicable, similar clauses at FAR 52.227-19 or NASA FAR Supp. 52.227-86].

PANTONE®* Computer Video simulations used in this product may not match PANTONE-identified solid
color standards. Use current PANTONE Color Reference Manuals for accurate color.

*Pantone, Inc.’s check-standard trademark for color.

Written and edited by Helen Casabona, Kathleen Vian, and Roy West
Book design by Jeff Yaksick

llustrations by Nancy Serpiello and Jeff Yaksick

Production by Jennifer Sherer and Adrienne Wong

Localization management by Jennifer Yu

With help from John Hammett and Chona Reyes

User publications management by Gary Miller

Cover design by CKS Partners, San Francisco, California

This manual was designed, written, and produced with NEXTSTEP. Proofs were printed on a NeXT
400 dpi Laser Printer. Final pages were transferred directly from NEXTSTEP files to film using
NEXTSTEP computers and an electronic imagesetter.



" USER’S GUIDE



3 e

Where to find what you’re looking for. . .

‘PasteandLink  V

- Emily Bright.rtfd — /Netpublicity/Press Releases’s b

T R

‘Show Links .

A

i

Bt

- Link >

Tootts

‘Select All

Link Inspector....

PO Box 334578
San Francisco, CA 94105
-& Blue Planet Productions
FOR IMMEDIATE RELEASE
San Francisco Contact: Jason Starr
May 1, 1994 ) . Phone: 415-111-2222

Email: jstarr@blues.com

Emily Bright releases first album:
Git on down the road

Bright’s first alburn is a bright spot on a stormy horizen. The
en-year-old singer from the streets of Chicago combines the aching

‘of old-time blues with a searing message from her generation. But

ice—full of energy and open-throated passion—doesn’t let you
w7 in despair, It makes you want to make a difference.

e cutis a tribute to old-time blues legend, Skip James, but Brightis

to become alegend in her own right. Bright leamed her craft hanging
1 outside the backdoors of bars and clubs on Chicage’s South Side,

bt her message from kids like herself, kids living on the streets. The
ge is not what you might expect. These kids are not justlocking for a
eal or a dealer. They're looking for a future, not only for themselves
the planet. And Bright sings the message loud and clear.




> You’ve gotall the pieces put together. Now you want
to know how to do something, anything. Just turn
the page.

> Ormaybe you want to start fast, learn the basics, and
get on with your work. See the Quick Start book.

> You want to learn as you go? Choose Info from the
main menu and then choose Help.

> Wait a minute. You haven’t even got the thing out
of the box? You need set-up instructions. See the

owner’s guide for your computer and, if necessary,
Installing and Configuring NEXTSTEP,

The NEXTSTEP workspace is a complete environment

with color; sound, graphics, text, and the intelligence to

support the most extraordinary tasks—as well as your

day-to-day work.
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Its like learning anything. You start with
the basics. In this case, the basics are the
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Workspace Manager.”

Workspace Manager; well, manages.

1t opens and closes windows to get you
Jrom one task to another: It starts up
applications—ihe tools you use to do
Yyour work. And it keeps track of files
and folders, which contain the fruits of
your labors.

Sure, you’ll be churning out works of
genius in no time. You just need 1o settle
into Your workspace first.
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the principles. Now you have the tools.
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Sometimes 1t seems like things never
change. You start out learning the
alphabet, shaping those letters, oh, so
carefully. Coloring in circles and
triangles and squares. And here you
are, years later; still worrying
about letters and shapes and colors
on a page.

But things do change. Now you don’r

struggle with pencils, leaky pens,

and grubby crayons. Maybe you don’t

like the way a letter is shaped. So
you just choose a different font. You
don’t like the color of a triangle?
Click, you’ve got another one.

You wonder what it all means? You
look it up in the on-line dictionary.
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Maybe your father was a postman.
Maybe you feel a little disloyal. But, ok
man, it’s so efficient.

Instant mail delivery anywhere in the
world. And not just quick little notes either:
These things can be works of art with
designer fonts, designer colors, and
designer graphics. And voices—you can
even send your voice along.

115 not ordinary mail, you tell yourself.
Not the sort of thing your father delivered.
They should call it something different.
Something like NeXTmail."
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There are all those little electrical signals
running around like crazy in your
machine. Your information. You know
ir’s there, right at your fingertips.

Still, sometimes you really want something
Yyou can hold in your hands. Printed pages
you can stack up to see what you’ve
accomplished in the last ten months. To
show others what you’ve accomplished in
the last ten months.

And faxing, well, that’s a natural
extension of printing, isn't it? Same little
electrical signals jogging along the phone
lines and landing in formation on a piece
of paper at the other end.

Uh-huh. Now where’s that Print

command?
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1% your choice.
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Other things, too. Units of measurement.
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When you work with NEXTSTER, you start your work session by entering the

workspace. Once you're in the workspace, you use a mouse and a keyboard to do

most of your work—ito choose commands from menus, open and close files, start

up applications, and get on-line help.

\Infa Panel...

‘Legal..

Preferences...

Help.

Backtrack

Turn off the computer

The Basics

Browse files and folders

{Li'stﬂles’andftsld rs

The Basics

The Workspace Manager manages your
files, folders, and applications.

WOrkspace
menu

Commanhds




Turning on your
computer

Selecting your
language

Logging in

Using the mouse
Choosing commands
Clicking for help
Getting help by topic

Ending your work
session

Starting and Ending a
Work Session

It’s just you and your new computer. The screen is
shiny and dark, waiting for your first move. Closing
your eyes, you see prizewinning magazine spreads,
earth-shattering breakthroughs in molecular
modeling, full-color three-dimensional animations,
and vast networks of linked business systems.

All right, so you have to take care of a few other
things, first—like selecting a language, checking out
the workspace, getting the hang of the mouse. Stuff
that will take just a few minutes.

You hold on to your thoughts, open your eyes, and
press the power switch. It’s time to begin.



The Workspace Chapter 1: Starting and Ending a Work Session

Turning on your computer

If your display and As the computer starts up, various messages appear on the screen. If you have
other peripheral devices any operating system in your computer in addition to NEXTSTEP, a message
have power switches, asks you to type n and press Return to run NEXTSTEP.

turn them on. '

Press the power switch A

on your computer. o0 I , / /

If a message asks you to, j e ’

type n and press Return e

to choose NEXTSTEP. j =

Caution: Don't turn on the computer when a floppy disk is in the computer’s disk
drive, or else NEXTSTEP won't start up.

If you’re turning on the computer for the first time, you then have to select a
language. Otherwise, you either log in or enter your workspace.

While the Computer Is Starting Up

After you turn on the computer, it messages that inform you of its
searches for a set of files known progress.

as system files, which it needs in
order to operate. It gets these files
from a startup disk (or boot disk),
and loads them into its internal
memory. The startup disk is usually
a hard disk in your computer.

If the computer is on a network,
and it reports a problem with the
network or simply doesn’t keep
loading the system files, it may

not be properly connected to the

, . network. For help, see your system
While the files are being loaded, administrator—the person in charge
the computer displays a [ist of of the computer or network.



Selecting your language

Move the mouse to
position the cursor over
the language you want

and click a mouse button.

Position the cursor over
the name of the keyboard
arrangement you want,
and click again.

Press the Return key.

When a second window
asks you to confirm your
selection, press Return
to confirm. Or click the
Cancel button in the
window and select
another language and
keyboard.

If you’re not familiar with using
a computer mouse, see “Using
the Mouse” in this chapter.

The Return and Shift keys are
located as on a standard
typewriter. See “Keyboard
Basics” in Chapter 9.

You can change what language
and keyboard you use later.
See “Working in Your Own
Language” in Chapter 20

and “Selecting a Keyboard
Arrangement” in Chapter 21.

"The first time you turn on your computer after NEXTSTEP is installed, the
large window shown below appears. Use it to select the language and keyboard
arrangement you want to use.

This window appears
only once.

Use the mouse to click

- Welrome Bienvenue Willbommen Bienvenido Benvenuto Vilkommen

the language you plan
to work in.

Select your language

! I Eran‘sh ;’Frangaisl Deutschl Espafiol I ltaliano lSvenskal

Then click a keyboard

arrangement in this list. |}

To see the entire

list, drag this i
knob up and down. \;\

Finally, click this button i

NextUSA
Norsk
Portugués
Espafiol
Svenska
Suisse

Schweizer

NextJapanese |

Selectyour keyboard

or press Return.

O 007 T 17
[ le]e e s s 7 dels o ]- -]
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als [alr Jolnli 6l s ]
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Caution: If your hard disk or NEXTSTEP partition is 300 megabytes or smaller, select
the language you plan to work in. Other languages are deleted from your disk.

If your hard disk or NEXTSTEP partition is larger than 300 megabytes, you
can select languages to use later. After clicking your primary language, hold
down the Shift key and click the button for each additional language. Your
primary language is then marked with an underline.

Try the NeXTUSA Keyboard Arrangement

Instead of the USA keyboard

arrangement, you

NeXTUSA and get these benefits:

can choose

» Keys for adjusting screen

brightness and speaker volume.

+ Akey that turns the computer off.

» An extra Command and Alternate
key, making certain tasks easier.

See “The NeXTUSA Keyboard
Arrangement” in Chapter 21.




The Workspace Chapter 1: Starting and Ending a Work Session

Logging in

1 Type your user name in If you work on a network or share your computer with other people, you must
the login window. log in to use the computer. The login process prevents unauthorized people
from using your computer. It also protects your work by allowing only you to

2 Press Return. .
access it.

3 If you have a password,

. When NEXTSTEP finishes starting up, the window shown below appears on
type it and press Return.

your screen. You log in by typing your #ser name, which is either me or one your
system administrator gives you. Your system administrator may also give you a
temporary password.

If you make a mistake while typing your user name or password, you can press
the Backspace key to back up over the characters you want to retype.

Type your user name here.

37

 Name[stdi,
- Password| N\

The blinking vertical bar
shows where you type.

If you don’t have a password, you need only to type your user name and press
Return to log in. The login window goes away and you enter the workspace.

If you don’t enter the correct information, the login window shakes and you
must try typing your user name again.

You can use the buttons in the

login window to restart your

computer or turn it off. See
“Ending Your Work Session”

in this chapter.

Your system administrator may
have changed the appearance of
the login window and the login
process. See that person for
more information.



You create and change your
password using the Preferences
application. See “Setting a
Password” in Chapter 22.

If you have a password, pressing Return moves the insertion point to the
Password field and you must type your password to log in.

CriEin
B

NETS

Name | starr e

Password L-,\ II .

Mﬂ_l Jﬂl

The blinking vertical bar
moves forward as you type.

But your password doesn't
appear as you type.

After you enter the correct information, the login window goes away and you
enter your workspace. If you don’t enter the correct information, the login
window shakes and you must try typing your user name and password again.

If your computer doesn’t initially require logging in, you can make it require
logging in by creating a password. Once you have a password, you should
change it periodically to reduce the risk of anyone else being able to log in with

your uscr name.

If you leave the computer on while the login window is showing, but you don’t
use the mouse or keyboard for a while, the screen’s contents are replaced by
the NeXT™logo. The contents reappear as soon as you start working,



The Worlkspace

Chapter 1: Starting and Ending a Work Session

Your Wbrkspace

The workspace is where you do all your work on
your computer. It's where you both create and
organize your creations. When you first enter the
workspace, it contains the elements shown below.

Most icons in the application dock represent’
applications such as Edit—a text processor for
creating formatted documents—or the electronic
Mail application. The dock makes it easy to start
up applications you use frequently.

Applications present information in windows, which
open and close in your workspace. The File Vieweris
a window that belongs to the Workspace Manager
application. The File Viewer gives you access to your
files, including all your applications.

The Workspace Manager has a menu titled
Workspace, which lists commands you can choose
to make the application do something.

The cursoris usually an arrow & for pointing to
objects, but it can change depending on what you're
doing. Other common forms are:

Y An l-beam for editing text

¢% A spinning disk, or busy cursor, which means the
application you're working in is busy and you have to
either wait or switch to another application

2 A question mark for pointing to something you
want to find out about

A menu lists
commands you choose
to make an application
do something.

[

File

3
S
Edit oo
Disk r
View I
Tools rfo
v
v
h
9

Windows
Services
Hide
Log Out

The cursor is the small
black arrow that moves la

File Viewer

KRN ZEst

: st Nexapps -
] EaTMB swalabie on yemota disk. -

o repetaire a7

when you move the
mouse.

Anicon is a small
pictorial representation
of something, such as a
file or application.

:
CONGEAY)
bright fax fax

Gorary LS i

)
5
- Biue Planet

Follow This Uptrf stiars

g[8

The File Viewer provides | =
access to your files. .

<

This column of icons is
the application dock, or
dock, for short.




Using the mouse

1 Move the cursor by
sliding the mouse over
a smooth, flat surface.

2 Position the cursor on an
item such as a button,
slider, or icon.

3 Use a mouse button to
click, press, drag, or
double-click.

You can use the Preferences
application to make one mouse
button have a special effect, to
adjust the responsiveness of the
computer to multiple-clicking,
and to adjust the responsiveness
of the cursor to mouse
movement. See “Hiding
Menus” in Chapter 20 and
“Changing the Responsiveness
of the Mouse” in Chapter 21.

Except for typing text, you can do almost everything on the computer with the
mouse (or whatever pointing device you're using). The mouse controls

the movement of the cursor. You slide the mouse on your desk or any other
smooth, flat surface to point the cursor at something on the screen.

You can normally use
either the left or right
mouse button—they each
have the same effect.

\

If you run out of room while sliding the mouse, you can lift it and put it back
down somewhere else without moving the cursor. No matter how far you
move the mouse, the cursor stays on the screen.

Basic Mouse Actions

Once the cursor is pointing to
something—it's over an icon or
word, for example—you use a
mouse button to perform one of
these actions:

Click Without moving the mouse,
press and release a mouse button.

Press Without moving the mouse,
press a mouse button and hold it
down. Pressing usually has the
same effect as repeated clicking.

Drag Press and hold down a mouse
button. Then move the cursor by
sliding the mouse. Finally, release
the mouse button.

Double-click Click twice in quick .
succession. This often extends the
action caused by a single click. In
text editing, for example, clicking
once selects a location between .
characters and clicking twice selects
a word. An application may even .

use triple-clicking, for example, to ;
select a paragraph. g




The Workspace
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~ Buttons, Text Fields, and Sliders

10

Buttons You often use the mouse to operate buttons
in windows to make something happen in an
application. Buttons come in all shapes and sizes.

They're labeled with text or graphics to indicate what -

they do. You click or press a button with the mouse,
and the button responds visually—it's usually
highlighted in white until its function is completed.

Ol

Delete

If you decide that you don’t want to click a button
after all, you can move the cursor out of the button
before releasing the mouse button.

Clicking a button might turn something on. To turn
it off again, you may need to click the button again.
A visual clue tells you whether it's on or off. For
example, clicking a button with the image of a book
on it may open or close the book.

7
H
i
i
H
i
¥

5

Clicking a check box button places or removes a
check mark in the box.

You can click a check box

rrerern

Pressing a button with a 4 on it displays a
pop-up list of options that you can choose from.
When printing, for example, you use such a button
to choose between automatic paper feed from a
cassette or manual paper feed.

A label above the button
describes its function.

The name on the button is
the current option.

' Manual

b ped |

Press and hold down the
button to open the list.

Cassette Ry =

Manual R |-

=5

Drag through the list until
the cursor points to the
option you want.

|| Cassette

~ Paper Feed

Release the button to
choose the option, and
the list closes.

Pressing a button with a T on it displays a
pull-down list of commands that cause actions
to occur. You drag the cursor through the list
to the option you want and then release the
mouse button.

Transactlig v J gtsTranéaCticin T J;

“Deposit - [ 7 Deposit 5
Withdraw Withdraw &
Transfer Transfer




When buttons are grouped together, clicking one to
select it might deselect another. Often you can drag
through the group and operate one button by
releasing the mouse button when the cursor is in it.
You can do this in the Preferences application, for
example, when selecting one of four rates at which
character keys on the keyboard repeat when you
hold them down.

Key Repeat Rate

a.a a.a | aa | aa |

A dimmed button—shown in gray rather than in

black—is currently unavailable for use. For example,

the Save button in a panel is dimmed when you
haven't yet typed a name for a file you're saving.

f Save <“"|

The ¢5 symbol in a button means you can operate
the button (when it's not dimmed) by pressing the
Return key on the keyboard.

Text fields Sometimes telling an application whatto
do involves typing in a white area called a text field.
A label indicates the text field's function. =

Find:| legend], N |
‘ Previous\]\  Next <o
k\ S ’
N A i N
Label Insertion point Text field

When you work in a window that contains text fields,
an insertion point often appears in the first field,
indicating that you can insert text there.

To move the insertion point to another text field, click
in the other field. You can also press the Tab key to
move to the next field in a window. Or hold down the
Shift key and press Tab to go to the previous field.

If you type more than can fitin a text field, text you‘ve
already typed moves to the left, out of vigw, SO you
can see what you're typing.

© Find: Icreatwe/grey/FestwaUBlue PIanetFestlvah‘I I

You can type past the edge of a text field.

Find: hiNeb’creatwefgrey!FestwaI.fBlue PIanetFestw

Drag back to the left to see what you already typed.

Sliders You sometimes use a slider to specify a
setting in a range. Simply move a knob back and
forth in a bar by dragging it. Or click in the bar to

make the knob jump to the position under the cursor.

Text field

Bar Knob

If a text field next to the slider shows a value
representing the current setting, you can type in
the field to change the setting.

i bk e s it

1



The Worlspace Chapter 1: Starting and Ending a Work Session

- Choosing commands

» To choose a command, "To tell an application what to do, you often use commands. Commands appear

click it, type its keyboard in menus. Each application has a main menu that appears when you’re working
alternative, ordragtoit.  jj the application.

» Tokeepasubmenuopen,  Some commands perform an action on something you’ve selected, such as
drag it by its title bar. text, an icon, or a window. Other commands open a pare/—a small window
that may ask for more instructions. Still other commands open another menu,

» To close a detached called a submenit.

submenu, click its
close button.

,_._.A [ marks a command that opens a submenu.

}cht! ‘ d _ F When you choose a command, it's
Text r highlighted in white until it's carried out.

Page Layout., P/
N A €llipsis (...) marks a command that opens a panel.

If you prefer to use the keyboard, you can type a command’s Command-key
equivalent. Hold down the Command key and type the character shown next
to the command. For an uppercase character, hold down the Shift key, too.

-

Finder fl=mmee Typing Command-f chooses the Finder command.
'Processes.. Pl Type Command-Shift-P to choose Processes.

[Console

If the command opens a submenu, the submenu appears, as shown below.

Submenu

Preferences

Onfo S rf x|

Edit Nrefcopy & You can move a menu and its submenu
win Ei"dw?u T e lPae ~ by dragging the first menu’s title bar.
'Hide  h|[Selectall a

e

"To find out which is your
keyboard’s Command key, see
“Keyboard Basics” in Chapter 9.

You can use the Preferences
application to make pressing
one mouse button put a copy of
the main menu under the cursor
that you can then drag into to
chooseacommand. See “Hiding
Menus” in Chapter 20.

12



You can also choose a command while dragging through a menu. Start with the
cursor pointing to any command, drag to the one you want, and release the
mouse button. As you drag through a menu, each command is highlighted in
turn. If a command opens a submenu, the submenu stays open until you
move to another command.

l— ,——_— You can drag into a submenu
1
Preferences ’ Vindows to choose a command. The

Info | tiniaturize Window m submenu closes afterward.
Edit i~ | Close Wingdowk W

Windows —etide———o""

"Hide h

Quit q

A submenu normally closes when you choose a command from another menu.
If you don’t want the submenu to keep closing, you can detach it. The
submenu remains open until you close it yourself.

[roterences

Drag asubmenu ~ Click the

b by its title bar ) R button to
Info I~ ot B, 8 to detach it. Cut ® close the
Edit - Lcu % Copy o submenu.
“Windows " ’POpty' L ?pﬁggfsb”“"“ ‘Paste n
Hide Y [ —. ' SelectAll a
—_— ‘Selectall a
Quit o0

If you press and hold down the mouse button in the command that opened
a detached submenu, a copy of the submenu appears that you can drag
into to choose a command. When you complete the drag, the copy of the
submenu closes.

A dimmed command | %], shown in gray rather than in black, is
currently unavailable. This happens, for example, when the command doesn’t
apply to what you’re currently doing in an application.

13
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Chapter 1: Starting and Ending a Work Session

Clicking for help

» Hold down the F1 key
and click any command,

window, or panel.

14

In some applications, you can find out about an item by clicking it with the
question mark cursor. You get this cursor by holding down the F1 key.

Mail =l Mail Help Panel
 Info ~ : o
Mailbox_ 1~ G, : @ PTIER

0 i
Compose I Sl e e Find ) “hden 1 'Ba/:kmak
St ” : Chnl:se howto eln;wmessages S :
7 " . 9 B
Format ?f‘l" Hide Mail -~ ‘<
Windows i . Quit Mall i
Print.. - p Reference i
B - Commands, buitons, and Eanels lé{
’Servlces r ~Tha Clrsor "
Hide h Index - N
it . SR P

Format menu

layout options.

20 {Foms]

Lists commands for changing fonts, ruler settings, and page

-

———————

 Page Layout..

Morw open amenu of commands for changing the

appearance of text

.z < To open amenu of commands for aligning text in

amessage

P wrepare amessage for printing

. —

TR

v ywn
i Format a message

© Setanewfont
9 Previewafont
<& Prepare a message for printing
| Use colorin amessage

When you click
something with the
question mark, the
Help panel opens.

The help you requested
appears here.

You may need to drag
this knob downward
to see more.

Click a < button to
see a related topic.

Clicking with the question mark cursor usually provides help on a command,
window, or panel. In some cases, however, you can find out about a specific
button or icon in a window by using the question mark to click it.

If your keyboard doesn’t have an F1 key, you can try getting the question mark
cursor by holding down the Alternate and Control keys at the same time.



Getting help by topic

1 Choose Info from the
application’s main menu.

2 Choose Help from the
Info menu.

3 Click a topic in the Help
panel.

You can find out how to do something in an application by selecting a topic
from the table of contents in the Help panel.

— Ma]lHélpF:anel —

. @ | [ ()
Find ‘ Index Backtrack

ron Adjust brighitness and volume
%\ __The Basics
Open a LY

Stud amessage
Delety.a message

Click a topic in the table of contents.

\ Open aftile or folder in a message
isten to arecording In a message
4]
CQreating MESS oS
- L+

Open a message \ ‘

summary area. 2 Click the down arrow button to select the next
message, or click the up arrow button to selectthe previous one.

To see all topics, you can
drag this knob up or down.

1 Selectthe message youwanttoloolw—' Drag this knob to resize

the two areas in the panel.

Click to Date and

step time the

through message

messages. —t— W33 sent

Summary

area

"] Dragtosee —

more or fewer

summaries at

once. [ The
message
areashows
the current
message,

v Messages you receive are listed in the summary area of your

Active mailbox. When you select amessage in the summary
area, its contents appear inthe message area below.

4];';

g s |

The topic appears here.

You can also click a » button to see a related topic.

Buttons in the Help Panel

Three buttons in the Help panel
provide other ways to find a topic.

Index Click this button to view an
index of topics in the application.
Then click the index entry you want
to find out about.

Backtrack Click this button to see
the topic you viewed last. Click it
again to see the topic before that.

Find You can type a keyword in the
- textfield at the top of the Help panel.

Then click Find to view the next topic
that contains the keyword. Help is
organized like a stack of topics. The
Find button searches through the
stack starting from the current topic.
You can click Find again and again -
until you find the topic you want.

15
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Ending your work session

To log out, choose Log
Out from the Workspace
menu and click the Log
Out button.

To turn off your
computer, choose Log
Out and click the Power
Off button. When a
message says it's OK,
press the power switch
on your computer.

To restart the computer,
log out and click the
restart button.

If you’re using the
NeXTUSA keyboard
arrangement, you can press a
key to turn off the computer.
See “The NeXTUSA
Keyboard Arrangement” in
Chapter 21.

For information on how to
save work before logging out
or turning off the computer,
see Chapter 5, “Creating and
Saving Files.”

For some computers, you can
use the Preferences
application to make the
computer turn on
automatically after 2 power
failure. See “Setting the
Computer to Turn On
Automatically” in Chapter 21.

16

At the end of a work session, you can log out to put all your work away. Or if
you don’t expect to use the computer for a while—such as a day or two—you
should turn it off. Before doing either of these things, make sure to save any
work you’ve done in an application.

You log out or turn off the computer with the Loog Out command in the menu
titled Workspace. If this menu isn’t visible, you can make it appear by clicking
in the File Viewer, or by double-clicking the NeX'T" icon at the top of the dock.

When you choose Log Out, a panel opens. If you click Log Out by accident,
click Cancel in the panel to make the panel close so you can keep working.

dnfo Log Out

Fie \/ og LU

Edit ™ -
D'Sk SRS ~ Doyourealywanttolog out? i

: View I Pl SRy B
took___ o} | conesl [ Piweron | [ Logopien]
Windows I — /’ - ,/, =
‘Services T Choose Log Out Click hereto  Click here to
Hide 7 h from the turn off the log out (or
Log Out X o Workspace menu.  computer. press Return).

Logging out quits all running applications. If you have unsaved work, another
panel asks if you want to save. The login window then appears and you must
log in again to reenter the workspace. (If you’re not required to log in, logging
out just quits all applications, and you reenter the workspace automatically.)

Choosing to turn off the computer first logs you out—if you have any unsaved
work, a panel asks if you want to save. After a few moments, a message tells
you it’s OK to turn off the power.

Caution: Don't turn off the power to your computer before a message says it's OK
to. Otherwise you might damage your startup disk.

On some computers, power goes off automatically after you click Power Off.

If the computer has a floppy disk in its disk drive, logging out, turning off the
computer, or restarting removes the disk’s contents from the file system. You
should then remove the disk from its drive.



You should restart your
computer every few days to
free up space on its disk. A
panel may even warn you
when it’s time to do so. See

“When You Run Out of Room
on Your Hard Disk” in
Chapter 8.

You can also turn the computer off or restart it from the login window.

Name | starr|

]

Password | -

l Click here to restart

rirmera e the cOMpUter.
A

&
_\_7_’_ @ .Lr Click here to turn the
Restart | Power I computer off.

‘Restarting the computer reloads its system files, just as when you turn on the
computer. You might have to do this after installing new software. When you
click the Restart button, a panel asks you to confirm that you really want to

restart. It also gives you the choice to restart in another operating system, if one
is installed on your startup disk.

Do you really want to restart 'theftbmpku'ter‘?

Click here to restart using DOS
instead of NEXTSTEPR.

‘Cancel | RestathhD

= Click here to restart NEXTSTER

When the Log Out Command Doesn’t Work

On rare occasions, the computer
may have a problem and your
actions may have no effect. The
cursor might not move and you may
not be able to choose commands or
operate buttons. Try restarting the
computer by holding down the
Alternate key and pressing the
upper-left key on the numeric
keypad (often labeled Num Lock).

This message appears:

Restart or halt? Type r to
restart or type h to halt.
Type n to cancel.

If you type r, the screen clears and
the computer restarts by loading its
system files. This method is “safe”
foryour startup disk, but unsaved
work is lost.

17



In the workspace, you work in windows. Some windows show what’s in your files
and folders. Others show what options you have. You can have lots of windows

open at once—and move from one to another as you work.

Find:llegend . r\ . | | | ;

Replace with:
| T Replabe All Scope _..... Find Options ——
S | CiEntireFile | | ¥lignore Case
£0 Coveryird — e . (" Selection | Regular Expression

Tj Previbu’% || Ne}dk@ ‘V : :

Y BRIGHT

E&% Blue Plunet Py

FOR IMMEDIATE RELEASE

San Francisco
May 1, 1994

Emily Bright re
Git on d

Emily Bright's first album is a brigh
eighteen-year-old singer from the
sound of old-time blues with a sear
her voice—full of energy and open




Selecting a window
to work in

Reordering windows
that overlap

Moving a window
Resizing a window
Scrolling to see more
Miniaturizing a window

Closing a window

Working with
Windows

You’re window shopping—you know, walking
down the street to catch a glimpse of the wares in
all the stores. A velvet Elvis and the shoulder of a
nude in the art gallery. A stack of titles in a
bookstore. Pens and palettes in a writing shop.
Envelopes in the post office.

Your feet start to ache. You sit on a bench and
think about it. What you need are windows that
come to you. Windows that you can move around.
You’d want to change the view in them, too, to see
more goods. Make them larger or smaller. Make
them go away.

You shake your head. Then you shake it again when
you see the gallery window. Wasn’t it just next to the
bookstore? And did that picture of the nude... move?
You certainly didn’t see #at before.

19
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Chapter 2: Working with Windows

Types of Windows

Windows can look different from one another, but
they generally have a few things in common.

A title bar at the top of the window shows the
window’s name.

You use scrollers—shaded areas along the left side
and sometimes the bottom of a window—to adjust
the view in the window when there’s more there than
you can currently see.

A resize bar at the bottom of many windows is for
changing the window's size.

There are two types of windows: standard windows
and panels.

A standard window is where the action in an
application occurs. If you're creating a document,
you type in a standard window like the Edit window
shown below. The File Viewer is also a standard
window—it's where you do Workspace Manager
tasks such as organizing files.

The title bar usually
contains one or

two buttons for

miniaturizing or
closing the window.

The title bar is
— —_— — : \w light gray, or it's
CD Coverrifd — /Met/creativelgrey « X highlighted in
A dark gray or black.

GIT ON DOWN THE ROAD

Scrollers adjust the
view when there's
IMOTE 10 SEE. mummmmmmn

s
oy

A

=t

4

T
|

S

A resize bar changes the window's size.

20



Panels are windows where you tell an application
what to do. Often they open when you choose a
command, asking you for more instructions or to
confirm the command. When you choose to quit an
application, for example, a panel might ask if you
want to save the changes you just made to the
document you were working in.

A panel might have
places for you to enter

A -

Some panels act on the contents of a standard
window. For example, a Find panel locates specific
text in a document.

A panel might also just contain a message.

A panel with a blank title bar (no title or buttons) is an
attention panel. When one of these panels opens,
you have to respond to it before you can do anything
else in the application.

Find;[@y

text or buttons for

telling an application T Simer -
what to do. \ Replace W'H‘( |
heplace All Scope Find Options
; (S Entire File Ylignore Case
(" Selection _ |Reguiar Expression

Repla‘;?eﬂll ‘ ‘Replace | Replace & Find I Previous l Next <"|

A blank title bar Marks wecsmeemo——
an attention panel. :

A Cancel button is for getting

you can operate the

rid of the panel without e . D === buitton by pressing the
performing any function. Cahcel I  Dont Save ] | save & Return key.
Password changed. You often click an OK

button to close a panel

after reading its message.
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The Workspace Chapter 2: Working with Windows

Selecting a window to work in

» Click in the window "To work in a window, you make it the 4ey window—the window where you
where you want to work.  type, or that accepts your keystrokes. There’s only one key window at a time.

The key window's title e : 70 Box 334573

; Son froncisca, CA 94105
bar is black. ‘
Eﬁ& Blue Planet Productions

Other standard Windows weses— . N
and panels have gray . : FOR IMMEDIATE RELEASE
title bars. , : A — oo oo i

Emall Jstarr@blues.com

Emily Bright releases first album:
Git on down the road

Emily Bright’s first album s a bright spot on a stormy herizon. The
eighteen-year-old singer from the streets of Chicago combines the aching
sound of old-tme blues with a searing message from her generation. But
her voice—full of energy and open-throated passion—doesn’t let you
wallow in despair. Itmakes you wantto make a difference.

If a panel opens that applies to the standard window you’re working in, the
panel becomes the key window—its title bar becomes black. So you can tell
which window the panel applies to, your standard window then gets a dark
gray title bar and is known as the main window. ?

Here, the Find panel is
the key window.

Fingt[Rlbum b Eﬁ Blue Planet Produttions

* Replacs wit|
" Replace All Scope =
) Entire File

FOR IMMEDIATE RELEASE

San Franclsco

i e Contact: Jason Starr
Replace A1l | - My 1, 1584

Phone: 415-111-2222
Email: jstarr @blues com

The window it SEarches s : ‘ : — i
is the main window—its Emily Bright releases first album:

title bar is dark gray. Giton down the road

Emily Bright's first Ebm is abright spot on a stormy horizon. The
eighteen-year-old singer from the streets of Chicago combines the aching
sound of eld-time blues with a searing message fromher generation. But
her voice—full of energy and open-throated passion—doesn’tlet you
wallow in despair. Itmakes you wantto make a difference.

A standard window with a black title bar is both the key window and the
main window.

22



Reordering windows that overlap

» To bring a window Like sheets of paper on your desk, windows can overlap or completely cover
forward, click in it. each other. You bring a window forward so you can work in it by clicking in it.
Or

> Choose WIndOWS from ol Emily Brightrtfd — /Netipublicity/Press Releases’s May X

the Workspace menu and
then choose the window
from the Windows menu. i

Replace wi

PO Box 234578
San Francisco, CA 94195

’% Blue Planet Productions
=

IMEDIATE RELEASE

Fisco Contact: Jason Starr

Replace #

Clicking in a window
brings it forward and
makes it the key window.

94 Phone: 415-111-2222
Email:fstarr @biuea com

Emily Bright releases first album:
Git on down the road

right’s first album {s a bright spot on a stormy horizon, The
p-year-old singer from the streets of Chicago combines the aching
If old-time blues with a searing message from her generatdon, But
e—full of energy and open-throated passion—doesn’tlet you

in despair. Itmakes you want to make a difference.

| —

No windows can cover an attention panel, and menus stay in front of standard

windows and ordinary panels.

More Ways to Reorder WindowsV ;

You can use keys on the kéyboard to reorder wi'ndows'in special ways.
(To find out which are your computer’s Alternate and Command keys, see

“Keyboard Basics” in Chapter 9.)

Action

Effect

Hold down the Alternate key
and click in the window's title bar

Brings the window forward without
making it the key window

Hold down the Command key
and click in the window's title bar

Sends the window to the back of
other windows

Hold down the Command key
and press the up arrow key

Brings the backmost window to
the front

Hold down the Command key
FOr more information abou[ thc and prGSS the down arrow key
Windows menu, see “Standard :

Sends the frontmost window to
the back

Commands” in the Reference at e
the end of this book. Edmcbii e
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Moving a window

» Drag the title bar of

the window you want
to move.

24

You can move a window around the screen by dragging its title bar (but don’t
press a title bar button). As you drag, the entire window follows the cursor.
When the window is where you want it, release the mouse button.

Former location

Find:{album

Replace wim:l )

— Al Scope — Find Options
(" Entire File ‘Yignore Case
(" Selection _IRegutar Expression

" i Find'All ‘ f‘Raplace l ‘Réﬁlaéa'& Find I ~Pvevinusy' ‘Next (""] |

New location

Dragging a window brings it to the front of other windows. It also makes it the
key window (unless you hold down the Alternate key while you drag).

You can drag a window anywhere on the screen, even partially off its edge.
Since the cursor can’t leave the screen, part of the window’s title bar—the part
where the cursor is—always remains visible, and you can drag the window
back into full view.

You can drag a
window partially off
the edge of the screen.

— All Scope ——— ~——— Find Options ——
(i Entire File | |- yIgnore Case
( Selection




Resizing a window

» To change the width You can make a window larger to see more of its contents or smaller so it takes
of a window, drag up less space. You drag its resize bar—the narrow gray border along the bottom
horizontally from of most windows.
either end region
of its resize bar. T - 1 , o

A Y — 7 The resize bar is divided
End region Middle region Endregion into three regions.

» To change its height,
drag vertically from
the middle region.

» To change width and ‘ S Fonc T30S
hEight at the same E@E Blue Planet Productions
time, drag diagonally
from an end region' FOR IMMEDIATE RELEASE
. San Francisco Contact: Jason Starr
o e certhr N
: i e AS yOU drag the
| g resize bar, an outline
j of the window
3; follows the cursor.
| |
| N

70 Box 334578
San Frondisco, CA 94105

E:m Blue Planet Productions

FOR IMMEDIATE RELEASE

San Francisco Contact: Jason Starr
May 1, 1934 Phone: 415111-2222
Email: starr@blues.com

o zummmn YOU S€€ MoOTe Or less

Emily Bright releases first album: //"/ of the window's
Git on down the road contents when you
i i finish dragging.

Emily Bright's first album is a bright spot on 2 stormy horizon. The i
eighteen-year-ald singer from the streets of Chicago combines the aching
sound of old-time blues with a searing message from her generadon. But
o her veice—full of energy and open-throated passion—doesn’t letyou

Al wellowin despair. Itmakes you wantto make a difference.

Y
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Chapter 2: Working with Windows

Scrolling to see more

To scroll one line or
other increment, click
the scroll button that
points in the direction
you want to scroll.

To scroll a “windowful,”
hold down the
Alternate key and

click a scroll button.

" To scroll to an
approximate location,
drag the scroll knob or
click in the bar.

To find out which is your
keyboard’s Alternate key, see
“Keyboard Basics” in Chapter 9.

Some applications have their
own buttons for scrolling a page
ata time. See the user’s guide

that comes with the application.
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Often there’s more in a window than you can see at once. To see what isn’t

visible, you scro//. If only one page of a 25-page document is showing, for

example, you can scroll to see the other pages. You use a scroller.

Emily Bright.rtfd — /Hetfpublicity/Press Releases/s May
N TTancisco ONLaCL, Jason Slart
May 1, 1934 Phone: 415-111-2222
Emajl: jstarr@blues com

’\

Emily Bright releases first album:
Git on down the road

Emily Bright's first album is a bright spot on 2 stormy horizon. The

] || cighteen-year-old singer from the streets of Chicago combines the aching
sound of old-time blues with a searing message from her generation. But
her voice—full of energy and open-throated passion—doesn’tlet you
wallow in despair. Itmakes you want to make 2 difference.

T

e title cutis a tribute to old-time blues legend, Skip James, but Brightis
ab®yt to become alegend in her ownright, Brightleamned her craft hanging
aro utside the backdoors ef bars and clubs on Chicage’s South Side.
She oot m_'u;p'__

Emily Bright releasas first album:

G on down the roed

Emiy Bright's St album b w bright spoton a tormy borizon, The,

B

her v
wallow i despair. [t makes you want t make & dfference.

Skip James, but Brights

TRNSTEC B AO1 VI Fou GO CIPELL oI N
Bree mealor a desier Zhcy "yt

message from kids like herself kids livins an the stre.

=

N\
Use a scroller when information is too
long (or wide) to appear all at once.

G B 4o Nt 10u53 8 40U, B3t ana-iny, 870 Ibnocent aithe
&ame ime. Tois womsr's ging 10 90w, and G aowr ma roa s 1oy
1696t 06 acion moving n 8 4ash, new drecton
Soman Wit
pvipg

A scroller works like a slider—you move a knob up and down or back
and forth in a bar. You can also click a scro// button. Press the button to

scroll continuously.

Scroll buttons

Scrol‘ knob

e Scroller

Ways to Scroll—A Summary

Action

Effect

Click a scroll button

Scrolls an increment

Press a scroll button

Scrolls continuously by increments

Alternate-click a scroll button

Ill

Scrolls a “windowfu

Click in the scroll bar

Scrolls directly to any location

‘Drag the scroll knob

. Scrolls gradually to any location

‘Alternate-drag the scroll knob

Scrolls more gradually to ahy location




You can hold down the Alternate key while clicking a scroll button to scroll by -
just less than the height or width of the current view, showing some of the
previous view for context. Other ways to scroll are shown below.

San Francisco

her voice—full of energy and o

~ Emily Brightrtfd — g ~ Emily Brightrtd — /g W Emily Brightrird — /g

[ % Emily Bright The title cutis a tribute to old-t
i = p aboutto become alegend inhe
J == Blue Planet Giton around cutside the backdoors ¢
/ She got her message from kids
'k ; , message is not what youmight
- Zmﬂy Bright's ﬁ‘;:‘ fdb“mﬁif abl free meal or adealer. They're

FOR IMMEDIATE RELEASE cghteer-year-oldsinger fom.1 butfor the planet. And Bright s

May 1, 1934 N¢™] wallowin despair. Itmakes yo - Emily Bright may have herro
on the future. Her sound Is so
The title cutis a tribute to old-d same time. This woman’s goi
n about to become alegendin he 1o getan old tradition moving
Emily Bright around outside the backdoors ¢ I
Giton She gother message from kids j
message is not what you might T
free meal or a dealer, They're .X-
|Af Emily Bright's first albumis ab N but forthe planct. And Brights A
hd _eighteen-year-old singer from{ Y ] Y
I rl

Press and hold down a
mouse button in the bar

Click in the scroll bar. The
scroll knob jumps to where

Drag the scroll knob to scan
contents as they go by.

Hold down the Alternate the cursor is and contents and keep dragging.
key while dragging to scroll accordingly.
scroll more gradually.

The scroll #n0b’s size and position show how much and what part of the total
contents you're viewing: The scroller represents the length or width of the
contents, and the knob represents the portion and location of the current view.

v

“Emily Brightrtid — /Ha
Emily Bright
Giton

Ernily Bright's first albumis ab
eighteen-year-cld singer from t
sound of cld-time blues with a ¢
her voice—full of energy and o;
wallow in despair, Itmakes yo

The tide cutis a tribute to old-d
aboutto become alegendin he
around outside the backdoors ¢
She gother message from kids
message is not what you might
free meal or a dealer. They're
but for the planet. And Brights

3

)|
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ey Brghtetfa — Mg

sound of old-time blues with a ¢
her voice—full of energy and o
wallow in despair. Itmakesyo

The tite cutis a tribute to old-ti
aboutto become alegendinhe
around outside the backdoors ¢
She got her message from kids
message is not what you might
freemeal or a dealer. They’re
but for the planet. And Brights

Emily Bright may have her ro
onthe future. Her sound is so
same time. This woman’s goi
to get an old tradition moving

When you type more,
the knob gets shorter.

This window shows the
middle third of a document.

The size of the scroll knob also changes when you resize the window.
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Miniaturizing a window

» To miniaturize a window,

click the miniaturize
button at the left of its
title bar.

» To get the window

back, double-click its
miniwindow.

You can also miniaturize

a window by choosing
Miniaturize Window

from the Windows menu.
See “Standard Commands”
in the Reference at the end
of this book.
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If you want to put a window aside without actually closing it, you can
miniaturize it. When you do this, the window shrinks into a miniwindow—
an icon that appears at the bottom of the screen.

Click the miniaturize
button to shrink the
window into a
miniwindow.

"/ CD Coverrtfd — /Neticreativelgrey. X

The miniwindow
shows at least part
of the windowss title.

)

You can move the miniwindow by dragging it, or click it to bring it to the front.
You can’t however, drag it into the dock (as you can an application icon) or into
the File Viewer (as you might a file or folder icon).

When you double-click the miniwindow to get the window back, the
miniwindow goes away and the window returns as you left it—in its same size
and location as though it had never been miniaturized. Unsaved work is still
there, too.



Closing a window

» Click the close button at When you’re finished with a window, you can c/ose it to get rid of it completely.

the l’Lght of the window’s  Unlike miniaturizing, closing a window makes it disappear from the screen.
title bar.

WX

sound of old-time blues with a searing message from her generaton, But
her voice—full of energy and open-throated passion—doesn’tletyou Click the close button to

wallow in despair. Itmakes you want to make a difference. .
close the window.
The tile cutis a tribute to old-time blues legend, Skip James, but Bright is
about to become alegend in her own right. Brightleamned her craft hanging
around outside the backdoors of bars and clubs on Chicago’s South Side.
She got her message from kids like herself, kids living on the swreets, The
I~4  message is not whatyoumight expect. These kids are not justlocking for a
free meal or a dealer. They're locking for a future, not only for themselves
but for the planet. And Bright sings the message loud and clear.

Enmily Bright may have her roots In a blues past, but she’s gother eyes

on the future. Her sound is soulful, down-and-dirty, and innocent atthe
same time. This woman’s going to soar, and G on down #he road is going
to get an old tradition moving in a fresh, new direction.

Sammi Wright
Global Voice

<[>T

A partially drawn close button usually means that the window contains
unsaved work. When you save, the button returns to normal. If you click the
button while it’s partially drawn, a panel asks if you want to save your work.
After you respond to the panel, the window closes.

" Emily Brightrtfd — /NethublicityiPress Releasesis May B
sound of old-time blues with a searing message from her generation, But
her voice—full of energy and cpen-throated passion—doesn’t let you i
wallow in despair. It makes you want to make a difference, ﬁuﬁf :;;arg)éggg th;;)ecxiisslow

The tde cutis atribute to old-ume blues legend, Skip James, but Brightis i
‘ aboutto become alegend in her cwnright. Brightleamed her craft hanging contains unsaved Changes'
around outside the backdoors of bars and clubs on Chicago’s South Side,
She got her message from kids like herself, kids living on the streets. The
»-J message is not what you might expect. These kids are not justlooking for a
free meal or a dealer. They're looking for a future, not only for themnselves
but for the planet. And Bright sings the message loud and clear,

Emily Bright may have her roots in a blues past, but she’s got her eyes
onthe future. Her sound is soutful, down-and-dirty, and innocent atthe
same time. This woman’s going to soar, and G on down the road is going
to get an old tradition moving In a fresh, new direction.

For information on saving If you close a window without saving changes, the changes won’t be there the

work before closing the
window it’s in, see Chapter 5,
“Creating and Saving Files.”

next time you open the window.

You can also close a window
by choosing Close Window
from the Windows menu.
See “Standard Commands”
in the Reference at the end
of this book.
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You keep your work in files and folders. You use the File Viewer to find and open
them. The File Viewer shows you files and folders on your own computer as well

as those avatlable to you on a network.

\'.’urksp_qEL

i Browser

lcon

Edit | Listng L
Disk  r|Sotlcons
View t= | Clean Up lcuns VVVVV
Tools | NewvViewer  N|
Windows [ Update vViewers u| £
Serwcgs ,- Ll Next.ﬂ.pps
Hide s h Ez_?maa :a}lable an rémute dlisk
Lag Out q




Opening a folder
Opening a file

Browsing files
and folders

Listing files and folders
Stocking the shelf

Opening folders and
files by typing

Selecting several files
and folders

Opening a folder in its
own window

Finding files and folders

Personalizing your
File Viewer

Using the
File Viewer

You’re wandering through a maze of towering filing
cabinets. Gargantuan drawers contain folders
stuffed inside folders inside other folders.

Of the thousands of documents stored here, you're
looking for two. One is a newsletter. Another is an
illustration for the front page. You point to the folder
of newsletters on an electronic map, and—pfffff—

you’re whisked through the complex. Seconds later,

you’re scanning a list of the folder’s contents.

You open the file with your newsletter. It comes with
all the tools you need to edit it. You open the file
with the illustration and get tools for working with it.
You marvel at how easy it is to find things here.

Now if this whole filing system could just fit on
your desk.
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The Workspace Chapter 3: Using the File Viewer

" The File System...‘x

Your computer keeps information in files and folders.  applications that come with your computer is named
A file might be a magazine article you write, an NextApps. A file might be called My diary.rtf.
illustration you create with a graphics application,
or the application itself. A folder can contain other
folders, which can contain yet more folders, down
to as many levels as you want.

A file or folder also has a pathname that identifies
its location. Its pathname lists the folders along its
branch of the file system. Each name is separated by
aslash (/). A slash at the beginning of a pathname
The files and folders in your computer make up its represents the root folder.

file system. You can think of the computer’s file
system as an upside-down tree with a root folder
at the top and branches that grow downward.

In the tree below, the pathname /Net represents the
Net folder. /Net/repertoire/Charts/Billboard.rtf
represents the file named Billboard.rtf.

Each file and folder has a name that identifies its

contents. For example, a folder containing You often identify a file or folder by its pathname. You

might type a pathname or read it in a panel.

A folder contains files The root folder contains all the A branch of the file
or other folders. / files in your file system. It has system traces a path
your computer's host name, but to a file or folder.
e in pathnames, it's represented
rpﬂm byaslash(/ ).

Preview.app PrintManager.app

Billboard.rtf Gavin.rtf

This file’s pathname is /
/Net/repertoire/Charts/Billboard.rtf.
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...As Seen in the File Viewer

To get to the files and folders in your computer, you
use the File Viewer. The File Viewer is part of the
Workspace Manager application. It appears when
you enter the workspace and can stay open the
whole time you're working.

Files and folders appear as icons. Different areas of
the File Viewer have these uses:

* Icons on the shelf can provide a shortcut to files
and folders you access frequently. The shelf always
contains your home folder, which is where you
keep your own work. You can add or remove other
files and folders.

« The icon path shows where you are in the file
system. This row of icons shows the selected file or
folder and the folders above it in its branch of the
file system.

* The bottom area displays the contents of the
current folder—the one you're currently working
in. When you use your computer for the first time,
files and folders here are shown as icons.

When you enter the workspace, you see the contents
of your home folder. Your home folder has the icon of
a house. Its name is your user name.

File Vle\ugr ]

Shelf
NextApps
22T B available on rerate disk
| - % T i s The highlighted
Icon path mes= s  BAET icon is the
pm Net repertoire 1starr | selected file
5 T ; 7 or folder.

The current s
view shows
the contents
of the current
folder.

The icon path
shows the folders

in the selection’s

starr pathname.

repertoire  /
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The Workspace Chapter 3: Using the File Viewer

| Opehing a folder

» Click a folder on the shelf  You open a folder to see its contents. Its contents appear in the bottom area

or in the icon path. of the File Viewer. When you first use your computer, files and folders here
Or appear as large icons. To see them as large icons if you don’t currently, open the
» Double-click a folder in View menu and choose Icon.

the current view.

File Viewer

Click a folder on

o the shelf.
. 'starr"“ © 7 NextApps
227MB availble on remote disk )
== A . e Click a folder in the
repertoire icon path.

Or double-click a
folder that's in the
current view.

Reaction Reports signature fift

You may have to scroll
10 see all folders in the
icon path.

Fo st Nexhpps

27 MB avallabls on remote disk

e The folder you open
is highlighted as the
= | selection.

= == c g [y B B .

. Bayside Tavemtf Great Americanif. " Jds MountainView.ntf . . JJs San Jose

= The contents of the
folder appear below,
replacing the contents
of the previous folder,

With the icon view, you can select a folder without opening it by clicking it in
the current view instead of double-clicking it.
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NextApps Net
1 . Lo--
e o

Editepp  Mail.app repertoire

starr
. \ -
T T
Letters Reaction Reports

Your computer contains UNIX®
files that don’tappear in the File
Viewer unless you make them.
See “Displaying UNIX Files”
in Chapter 20.

R _'_L___.

The way you move through the file system when you open a folder depends

on what part of the File Viewer you open it from.

File Viewer

starr 7 NextARps

Opening a folder from the shelf goes
directly to that folder.

g

pm Net repenulre

J’

' 7/
Opening a folder from the icon path

moves up the branch of the file system.

T B P

Apps Blue Planet

© />

Letters

Prelim Bios

]

et (jll: -
Al ReacﬂonRepor:\ signaturem Venues

N
Opening a folder that’s in the current
view moves down the branch.
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Opening a file

» Double-click the file on
the shelf, in the icon path,
or in the current view.

If a file doesn’t open, you may
not have read permission for it.
See “Permissions Granted” in
Chapter 6 and “Changing
Permissions for a File or Folder”
in Chapter 7.
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You open a file to see its contents. The application associated with the file
starts up, if it’s not already running. It then shows the contents of the file in
a window.

] Fll_é :wéwer

Click a file to select it.

starr .. NextApps
227 MB available on temote disk

Double-click to open it.

Reaction Reﬁt‘&s

== The file is highlighted in
the icon path.

{ Bayside Tavern.f | -

-

E [

N

| {Bayside Tavemutr | * - Great Americanif

Kimbals Eastrlf -

Kimbals.ff OT Prices.rif

JJs MountainView.stf

—w=m= The rightmost folder in
the icon path is the
current folder.

JJs San Jose

o

Outof Town

i

If you open a file that is an application,

Which Application Opens a
You can tell which application opens

a file by the file icon. Usually, it
resembles the application icon. You
can also tell by the file name
extension—the last period in the
name and the characters that follow.

The extension describes the type of
information in the file. For example,

the application simply starts up.

File

a file in Rich Text Format (RTF)

has the extension .rtf. A file with
Encapsulated PostScript has an
.eps extension. A plain text file has
no extension.

For more information, see
“Changing the Application that
Opens a File” in Chapter 7.

File Extension  File Icon Application Icon Application
EI;?{’ Previ
.eps f review
o Edit



When an application that isn’t in the dock starts up, its icon appears at the
bottom of the screen.

Info...

Printers

FaxModems

Edit

‘Windows

Hide

o =)=~

Quit

Fite Viewer

[

Mon

B

R

Sly_Personal_Printer  Apple LaserWriter [ NTX /axe

\ = ]
o NextApps ¥ Printvanager.app -
i
- v A ) = l- 8
z & R ;
S| G| N\ | iehapp Uiaranapp
Quoue Creato Movity Test f& lr,e. 1
T a E ‘ H
/ g, g I
Al ed lncsoyy Preview.app { PrintManager.app *
Local_prnter Naxné?up\ Printar rpm g
Repertoire_Color_Print NeXT Color Printer rfion

7
If an application is not in the dock, you can
drag it to an empty area of the dock.
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Icons in the File Sysfem
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Different kinds of files and folders have different
icons. There are also icons for disks, disk drives, or
any other devices that might appear in your file
system. Below are some common icons.

A general-purpose folder that you can
create.

A folder that's on another computer on the

-1 network whose contents you can access by

opening this folder.

Your root folder.

Your home folder.

Someone else’s home folder, which you
might see if you're working on a network or

o sharing your computer with other people.

The Net folder, which contains folders on
other computers, if your computer is on a
network.

A file in Rich Text Format® (often called an
RTF file), which contains text with font and
formatting properties, such as bold or italic.

An RTF file that contains one or more
graphic images.

Afile that contains only plain text—text with
no font or formatting properties.

A file that contains a graphic image in

- Encapsulated PostScript® format, often

called an EPS file.

For information on other icons, see “NEXTSTEP
Applications” in Chapter 4 and “What Disks Look
Like” in Chapter 8. You also may see icons for
applications you buy or create yourself.

A file with a graphic image in Tag Image File
Format, often called a TIFF file.

An application that doesn’t have its own
icon.

An address book that you can create with
the Workspace Manager. See “Looking Up
an On-Line Address” in Chapter 12.

A file or folder that's been compressed.
See “Compressing and Decompressmg a
File or Folder” in Chapter 6.

An Installer package—a set of files and

folders that you install with the Installer
application. See Chapter 19, “Installing

New Software.”

A folder is dimmed when you don’t have
permission to open it. If you try to open it,
no contents appear even if it has some.

Abroken link to a file or folder (see Chapter 6
for information on links).

An application that can’t be run—for
example, because it isn't configured to run
on your type of computer. In the dock, it
might be an application that was moved,
renamed, or that no longer exists.




Browsing files and folders

» To see the contents of
several folders at once,
choose View from the
Workspace menu and
then choose Browser
from the View menu.

» To open a folder, click its
name in the browser.

» To open afile, double-
click its name in the
browser.

Browsing is a way to move quickly through the files and

folders in your

computer. When you choose Browser, the current view becomes a drowser,
which lists the contents of each folder in the icon path. The contents are listed

by name in the column below the icon.

Al marks a folder.

Other names are files.

 File Viewer
H»’if B
p 9
F: ;
R
starr NextApps
227 MB avilible on remate ik i
& 15 ) i
0 @ 7
r " " 4 !
A [ P ||
Net repertoire iﬁeﬂa}t_ﬁgjjﬁ_gpﬁ@_ i
<> ] r |
barcelona [ Artists g Apps r Bayside Tavern.f -1
berlin ™ Chats [ Blue Planet "~ Great American.nf
crealive " Contracts [ bright fax fax JJs MountainVie...
-|london [ dazzel "~ Follow This UpL.t JJs San Jose
marketing ~ | |osorio [ Letters ~ Kimbals East.nf
milan sty 1 Library ~| - IKimbals.rf :
paris 3 smoot, I Mad |, 7|OT Prices.itf
production [ starr b > P Biosg | {Outof Town "~
promotion ™ Reaction Reports B 11 | Sweetwaternf
publicty o L signaturetif =
{repettoire P Venues "
sales ™~
stockholm ~
tokyo [
L . -l

Name of the current
folder

Contents of the current
= folder (here, of
Reaction Reports).

When you click a folder in a browser, the contents of the folder appear in the
column to the right.

AN TN S
statr NextApps
227 MB availzbie on remate disk

- |Accounts.aif s
- |Events g 5

7 gass
Sogil
Magazines

ess Releases I~ |47
Radio™ (e

Click a folder to open it.

Schedule.rif. o
Tv \r 22
wescot N

ockholm
Jtokyo

1

Double-click a file to
open it.

You can also open files and folders from the shelf and icon path, just as you can

when you’re working with other views.
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Listing files and folders

» To change to the listing
view, choose View from
the Workspace menu and
then choose Listing from
the View menu.

» To open afile or folder,
double-click the icon next
to its name.

To find out the size of a folder,
you have to use the Inspector
command. See “Getting
Information about a File or
Folder” in Chapter 7.
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You can list the contents of the current folder to show the size, history, and
permissions for files and folders. When you choose Listing, the view changes
to show this information.

File Viewer
Ne)&Apps
227 MB availakie on remata disk
- & - :M - | a.> ‘ .
L o Drag this knob left or
Net publicity {'Press Releases | right to adjust the width
i === of the Name column.
Name +‘/ Size I Last Changed 1 Permissions ] Owner l Group
: Accounts.tf 6026 JunB10957  -nw-rwer winn staff
(¥ Events Jun 011010 AKX winn wheel
o B gass - Jun02 1801 drvixrex gass staff Click a file or folder to
CEI giit — un 02 15:4Q . drusr.x. il staff, select it.
. § (¥ Magazines / May 28 1063 dnursr-x winn wheel
(E|Press Releases # - Jun02 16:59  dIrwar-xr-x winn wheel Double-click the icon (not
Vg - May 29 15:24__ dIWRIKr-X winn wheel .
.| E] Schedule.rtf 57 May 27 17:14 IOt winn wheel ' the name), to open it.
Al 210y : B2 08 1664 dnuneey wdnp - \UhaAl o . B
viapl i r i et Scroll if all columns aren't
- - =

visible at once.

In the listing view, the icon next to a name indicates whether it’s a file, folder,
or application:

marks a folder.
B marks an application.

marks any other file.

You can also open a file or folder from the shelf or icon path, just as you can
when working with other views.



What You Find Out in Listing View

When you display the contents of a folder in the
listing view, columns next to each file and folder
name provide the following information:

Size The size, in bytes, for files. In a plain text file, for
instance, each character occupies one byte.

Last Changed The date and time (based on a 24-
hour clock) that the file or folder was created, or that
changes were last made to it. Older files list the year
instead of the time.

Permissions The read (r), write (w), and execute (x)
permissions, successively, for the person who owns

" File iy

starr NextApps

ZE7ME avaindilz ob rernate disk

the file or folder, a group of people who may have
special access to it, and anyone else who has access
to the file system. A listing of r — x for the group, for
example, means the group has read and execute
permissions but not write permission.

Owner The user name of the person who owns the
file or folder.

Group The group of users who have the group
permissions.

For more information on permissions, see “Changing
Permissions for a File or Folder” in Chapter 7.

sz (GrOUP PEIrMISSions

- - -
N ~ . .
. | ; .
Yo === Permissions for
| publicity | VTR LY R e everyone else
b T3 f=a )
i . HERBSLIN SEERRBE A : B = whohasaccessto
Name {‘ Size Last Changed ] Permissiony” I O}yp_e;r;x}wm the file system
Accounts.tf 5026 JUn 010957  -rarnwee- 2o inn staff ;
(ﬂ Events JUn 01 10:10  drwsr-xex winn wiheel, g . Admarks a folder
o (P gass Jun 02 18:01  diwr-kr-x gass i ‘gl"l.l,fxl’-}{r-}( (the d stands for a
(& gil Junoz 1649 diwrxrx gill " stal : . UNIX directory).
aﬂ Magazines May 28 10:53  dnwsr-xe-x /nﬁn’_/im% |
[ﬂ Press Releases  --- Jun oz 16:59 drwr-xrs <= inn wheel ..o © Anlmarks a link
| 8 Radia May 29 15:24  drwmr-xrx == hael PASKIAL  to a file or folder.
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Stocking the shelf

To add a folder or file to
the shelf, select the folder
or file. Then drag it from
the icon path to an empty
space on the shelf.

To remove a folder or
file from the shelf, drag
it out of the File Viewer
into the workspace.

You can adjust the number

of rows on your shelf. See
“Personalizing Your File

Viewer” in this chapter.
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You can stock your shelf with folders or files you use frequently. Just drag them
from the icon path.

starr NextApps -

227MB avallale on remote disk

- Drag a file or folder to

Accounts it Events

Schedule.ntf

P

2

1 Press Releases |

git

the shelf.

Release the mouse
button when a ghost
image of the icon
appears.

In the icon view, you can
also drag a file or folder
from the current view.

Release the mouse
button when the file or
folder disappears
from the shelf.

==temem YOU CaN't remove your

home folder from the
shelf,

Caution: When you drag a file or folder to add it to the shelf or remove it, don‘t
release the mouse button while the icon you're dragging is over another folder. If
you do, you might accidently copy or move the file or folder you're dragging.

You can make more room on your shelf by resizing the File Viewer so it’s wider.



Opening folders and files by typing

To move along the
current branch of the file
system, press the left or
right arrow key.

To move through the

contents of a folder in
the browser or listing
view, press the up or

down arrow key.

To select a specific file
or folder in the current
folder, type the first few
characters of its name.

To open the selected file
or folder, press Return.

You can locate any file or
folder by typing its pathname.
As soon as you type a/ or ~ to
begin the pathname, the
Finder opens. See “Options
for Searching” in this chapter.

You can put your mouse aside and select and open folders and files from

the keyboard.

File Viewer

The left arrow key
opens this folder.

NextApps
227ME availshle on remote disk
E
C== ; \]
rem } pubticity |
ST e S s e When a folder is
selected, the right
[F;E: % arrow key selects
- Accounts f Events ;;ss i the first name in
4 the current folder.
g g ¢
! Magazines Press Releases Radio Schedule.rf } \ Typing g'_ selects
- 12 % % this folder.
s -l el
A - T

If you make a mistake or change your mind while typing a file or folder name,

pause for a moment to start over.

With the browser or listing view, you can use the up and down arrow keys to
move through the contents of a folder.

- Fite \ile‘\'ll’;r o

92

NextApps

227 MB weailsble on remate disk

4

3 ¥
|Press Releasas [ S
.. '|Radio "

“{Schedule.rf

Twmm T TivlT

- e The up arrow key

selects this file.

The down arrow key
selects (and opens)
this folder.
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Selecting several files and folders

Drag around (or over) the
files and folders you want
to select.

Or

Hold down the Shift key
and click each file or
folder you want to add to
the selection or remove
from it.

Or

In the browser or listing
view, hold down the
Alternate key and click to
select a range between
the current selection and
where you click.

"To find out which is your
keyboard’s Alternate key, see
“Keyboard Basics” in Chapter 9.
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You can select several files and folders in the current folder and then do
something with all of them. For example, you can open several files at the
same time by selecting them and double-clicking the selection icon.

o
e '
starr
227 MB avellabie o remote disk

Nextapps

File Viewer

.

Net

Press Releases

[

Berhard Sprecht.rifd

Emilio Caccitore.nid

Emily Brightrifd

Big Daddy Jo?u\q\@

Festival Release.ffd

Dido Estevan.rifd

Franceis PafiSiaMd
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i
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NextApps

i on rernate disk

Press Releases

Fioll

In the icon view,
start dragging
outside an icon.

As you drag, an
outline surrounds
the icons.

Double-click this

T

<1

i
Big memimu

~ DIdGEStevanid -

|

Festival Release.nfd

|

Francors Patisse.nfd

1

You can also hold down the Shift key while dragging around several icons to

add all of them to your selection.

selection icon to
open all the files
in the selection.

Shift-click a file or
folder to add it to
the selection.



You can drag and use the Shift key to make multiple selections in the browser
or listing view, too.

) [~ B i :
1% " ! ] i i } i
E={8 » | Y
5 May 13items ! 5 May 14 items |
3 i ‘ f
{Berhard Sprecht X, Berhard Sprecht....
|Betty James.rifd Betty James.Hd
Big Daddy Jorda.. {Big Daddy Jorda...
Dido Estévaniid N Dido Estevanifd

Emilio Caccitore...
Emily Brightrifd

Festival Release...
Francois Patisse...

Emilig Caccitore....
Emily Brightrtfd g
Factival Releass A%

Francois Patisse.

I =)

Shift-click a name to add it to the selection.

Drag to make a continuous selection.

Or you can use the Alternate key to select a range of files and folders.

E

Dido Estevanifd
Emilio Caceitore...
< |Emily Bright.rtfd
~.|Festival Release...
- |Francols Patisse...

i

f{: 1 " i H
s | h i ‘
5 May 1 3items 7 s May Tsitems !
¢ - |
{Berhard Sprecht.... Berhard Sprecht...
Betty James.rtfd Betty James.rtfd
Big Daddy Jorda... Big Daddy Jorda...

Dido Estevan.nfd
Emilio Caccitore..

Festival Release.
Francois Patisse. )]

5

Emiiy Brightrifd ™ i

i

..to here. —J

Alternate-click to extend a selection...

In either the browser or listing view, you can hold down the Shift key while
you click a selected file or folder, or while you drag over several, to remove files
or folders from the selection.
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Opening a folder in its own window

1 Select the folder you
want to open.

2 Choose File from the
Workspace menu.

3 Choose Open as Folder
from the File menu.
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You can open a folder in its own window, for example, to keep an eye on the
folder’s contents while opening other folders in the File Viewer.

" ¥ile Viewer

Select the folder

27ME availatile on remote disk

NextApps -

you want to open
in its own window

: /——- and choose
A Open as Folder.

The window's title

bar shows the

X folder name.

ostarr /
227148 avzilakle on remolgflisk

The folder appears on
the window’s shelf

and in the icon path.

You can display
contents in icon,
= browser, or
listing view.

"This window is just like the File Viewer except it can show only the contents
of the folder you selected. Within this folder, you can open files and folders,
drag them to the shelf, and do anything else you do with the File Viewer.

Part of the file system
s /0Ll €3N ACCESS iN @
folder’s own window.




i
|
1
L

A file package is a special kind of folder whose
contents aren’t normally shown in the File Viewer
or any other folder window. Instead, file packages
look and behave like regular files. Double-clicking a
file package, for example, starts up an application
or shows the contents of a file in a window.

File packages keep together information that
shouldn’t be separated. When you add a graphic
image to an Edit document, for example, Edit puts
the graphic in its own file and stores it in a file
package along with a file containing the document’s
text. Most applications are also file packages. They
consist of a file containing the actual application and
other files that the application uses, such as the
clicking sound for the camera in Grab.

Emily Bright.rifd

File Packages—Files That Are Really Folders

ightrtfd — /HeUpublicity/Press Releasesis May

You rarely need to see the contents of a file package,
and you shouldn’t normally change its contents. But
to look inside one—for example, to copy something
from it—select it in the File Viewer and choose Open
as Folder from the File menu.

You can tell that a file is really a file package if:

» The Open as Folder command isn‘t dimmed when
the file is selected. When you select a regular file,
this command is dimmed.

* When you inspect the file with the Inspector
command, the file is treated as a folder. See
“Getting Information about a File or Folder” in
Chapter 7.

* The file is an RTF file with an .rtfd extension.

« The file is an application with an .app extension.

The contents of the
file package appearin
a separate window.

2E7MB availdile on remote disk

The file package has its
usual file icon.

Emily Bright it

TKT.Hf

BP Logoift

This file package
= contains a text file
and a TIFF graphic file.
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Finding files and folders

Choose Tools from fhe
Workspace menu.

Choose Finder from the
Tools menu.

Select a target from the
Finder’s shelf.

Use the pop-up list to
choose to search for files
and folders by name or
for files by content.

Type text that's in the
name or contents of what
you're looking for.

Click Find or press
Return.

You can select a file or folder
in the Finder and use the
Inspector command to inspect
it. See Chapter 7.

You can also search for an
address book by content. For
information on address books,
see “Looking Up an On-Line
Address” in Chapter 12.
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You can search for files and folders based on any part of their name. You can
also search for files based on a string of text that’s in the file. You tell the Finder
where to search by selecting a target. You can drag any folder from the File

Viewer to the Finder’s shelf and use it as a target.

-

.

Click a target on the Finder’s shelf.

Type text to search for here.

Creative ¢
3 fourd /
: J |Jestival # )

“Find items with names that match /z

N T R X A TR A AT R T A S A R AT S T

Find_&

i |/Netcreative/grey/Festival
.- |Netcreativesbasil/projectsifestival
|/Net/creative/kim/Personal/Autumn Moon Festival.nf

1

e

Press here to choose to search
by name or by file content.

=== Click Find to begin the search.

Files and folders are listed here.

You can search for a single file or folder by name—regardless of the target—
by typing its entire pathname in the Finder, such as /Net/repertoire/starr or
~starr/Apps. The file or folder is selected in the File Viewer.

During a search, the Find button changes to a stop sign that you can click to

interrupt the search.

Shortcuts to Typing Pathnames

Here are a few shortcuts you can use
to enter a pathname in the Finder.

* You can specify your home folder
with a tilde (~), for example, by
typing ~ or ~/Apps. To specify
someone else’s home folder,
type ~ followed by the name of
that person’s home folder, as
in ~starr..

* You can type a few characters of a

namein a pathname and pressthe
Escape key to fill in the name. To
enter /NextApps/Grab, type
/NextAp and press Escape, then

type /G and press Escape. If more

than one name matches what
you've typed so far, the Finder lists
all possible matches each time
you press Escape.



You can select more than one
file or folder in the Finder the
same as with browser or listing
view in the File Viewer. See
“Selecting Several Files and
Folders” in this chapter.

You can use the Preferences
command to search for one

or more keywords in files.

See “Workspace Manager
Commands” in the Reference
at the end of this book.

"To narrow down your search, you can select from the files and folders you find

and then search on the selection.

9
3 found

creative zitem A

Select one or more
files, for example, by
dragging over them.

! I'program‘
N i

Find = | ] Find items with contents that match ]«

e A The SelECtiON appears here.

{/Net/credtive/grey/F estival

/Net/creative/basil/projects/festival

fMet/creative/kim/Personal/Autumn Moon Festipal.itf

You can drag the
selection to the shelf to

I make it the new target.

When you search by name, you can double-click a file or folder listed in the
Finder to select it in the File Viewer—even while the search is still going on.
When you search by content, double-clicking a file listed in the Finder opens
the file and selects the text you're searching for. In either mode, you can also
select a file in the Finder and then double-click its icon to open it.

Options for Searching

You can find any file or folder while
working in the File Viewer by typing
its full pathname. As soon as you
type a / or ~, the Finder opens and
shows your typing. Complete the
pathname and press Return. The file
or folder is selected in the File
Viewer and the Finder goes away.

You can also press Escape in the File
Viewer to enter the pathname of the
current selection in the Finder.

If you want the Finder to list a file or
folder without selecting it in the File
Viewer—for example, so you can

drag it to the Finder’s shelf to use as

a target—enter the pathname and
press Escape instead of Return.

You can Shift-click an item on the
shelf to add it to your target. If you
forget what's in a target that consists
of a multiple selection, press Escape
to list the selection’s contents.

When searching by name, you can
use an asterisk (¥) as a wildcard. For
example, to find all TIFF files within
a target, type *.tiff.

To search for names that containa~
or *, enclose your text in quotation = =
marks, as in “~oldfile”. ' B
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Personalizing your File Viewer

Choose Info from the
Workspace menu.

Choose Preferences
from the Info menu.

Choose the Icon View,
Browser, or Shelf
option from the pop-up
list at the top of the
Workspace Manager
Preferences panel.

Make settings in the
panel to adjust spacing
between icons or the
width of browser
columns.
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You can adjust spacing in the File Viewer. With the Icon View option, you can
adjust the spacing between icons shown in the icon view.

Choose the Icon View option.

Drag an arrow to adjust spacing

' / - between icons.

The white field shows the space
available for text beneath an icon.

With the Browser option, you can adjust the width of columns in the
browser view.

Choose the Browser option.

Drag the arrow inward or outward
to adjust column width.




With the Shelf option, you can adjust spacing between icons on the shelf.

Shelf i

Title Width

Choose the Shelf option.

Drag an arrow to adjust

Pt
)
»| Reaction Rep. "

spacing between icons.

The white field shows the

Resizable Shelf ¢

Use Default Seting

space available for text.

Check this box to make the shelf

in folder windows resizable.

You can also add rows to the shelf. When you check the Resizable Shelf box,
a resize knob appears at the bottom center of the shelf.

227ME avadidly on remets disk

Nextépps  Press Releases  Contracts

EE

Anists
Drag the knob
downward to add

rows to the shelf.

7 repertoire

[FAX
L

bright faxfax

EEC

You can click the Use Default Setting button in the Preferences panel to
return to the settings that came with the computer.
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: Life on a Network

When your computer is part of a network, you can
exchange electronic mail with other people and
share their files—all within seconds and without ever
leaving your desk.

A network can consist of two computers or two
thousand. Some of the computers have people like
you working at them. Other computers—called

servers—contain files and folders that everyone on

the network can share.

You access the servers and the files they contain
‘through /Net—the Net folder in your root folder. Your
home folder is probably on a server along with other
peoples’” home folders, so you'll be somewhere in
/Net when you log in.

[ baan)

starr’s root folder

Files and folders that aren't accessed through /Net,
such as /NextApps or /NextLibrary, are usually on
the hard disk in your computer.

You work the same in files and folders whether
they’re in your computer or in another one. But while
only you can access the other folders in your root
folder, everyone can access the folders in /Net.

When your home folder is on a server and therefore
accessible from any computer, you can log into any
computer on the network. As long as you log in
with your user name and password, you enter your
own workspace and have access to the files in your
home folder.

Only starr can access his
computer's root folder.

Only grey can access hers.

But they both can access
everything in Net.

Billboard.rtf

Gavin.rtf



NetWare Networks

If any NetWare® servers are connected to your
network, you can access file systems on those
servers in your File Viewer. Just open the NetWare
folder in /Net. When you click a server in this folder,
a panel asks you to enter a name and password. You
obtain these from the NetWare system administrator.
When you enter the right information and click OK,
the contents of the server appear.

You can work with files in the NetWare file system, or
you can copy them to your NEXTSTEP file system—
for example, to your home folder. When you copy a
file to the NEXTSTEP file system, make sure it has an
appropriate extension before you try to open it. In
some cases you might have to change the extension
to have the file open in the application you want.

Also, file and folder names on some NetWare
networks are limited to eight characters plus a
three-character extension. Before you copy a file or
folder to such a network, make sure its name isn't
any longer. For information on changing names or
extensions, see “Renaming a File or Folder” in
Chapter 6.

To make the NetWare folder appear, start up the
NetWareManager application, located in
/NextAdmin, and then click the Enable button. For

more information, see your system administrator.

For more information on differences between files in
your NEXTSTEP file system and in other file systems,
see “DOS and Macintosh Files” in the Reference at
the end of this book.

BRIEFS

CONTRACTS

N
Names on older NetWare networks don't distinguish
between upper- and lowercase letters. )
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Applications are the tools you use to work in the NEXTSTE P workspace. You use
them 1o create documents, send and receive messages, look up information, and
manageyour compulter system. Some applications are available in the application

dock. All are available in the File Viewer:

File Vievwser

e
Iy F

1
]

BY NextApps
allable on remote disk.

ences.app

“1PrintManagér’.app b




Starting up an
application from
the dock

Running several
applications

Switching to another
application

Hiding an application

Customizing the
application dock

Starting up an
application
automatically

Requesting the service
of another application

Quitting an application

Working with
Applications

You remember remodeling your kitchen last
summer. 'Tools scattered everywhere. You could
never find the one you needed. It was inevitably in
the other room. Or on a shelf. Or maybe you were
sitting on it.

You sigh. It ought to be easier. Power tools, lathes,
levels, squares, gadgets for every nook and cranny—
all at your fingertips within seconds and neatly put
away—out of your way—when you’re done.

You sigh again. Good thing the remodel is over.

-Good thing your next project is right here on

the computer.
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Starting up an application from the dock

» Double-click the
application icon in
the dock.

You start up an application that
isn’tin the dock by opening

a file from the Workspace
Manager. See “Opening a
File” in Chapter 3.

The recycler is described
in “Deleting a File or Folder”
in Chapter 6.
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Your computer comes with several applications, and you may add others that
you buy or create yourself. You can keep icons representing applications in the
application dock—the column of icons lining the right side of the screen.

When you double-click an application icon in the dock, the icon is highlighted
for a moment. Then the application’s main menu appears, often along with
another window.

Print..
Services i
Hide hioe

o File Viewer

& P

oul_ a)

arey NextApps
it

:

~ UNTITLED.AS — ¥
ate

alogs.

F.

. CD Covertid

A PR

m Mom fax = o Library

]

The NeXT icon remains at the You can double-click an You use the recycler to
top of the dock. You can drag application to start it up. delete files and folders
it downward to remove most from the file system.

of the dock from view.

Before you start up an application, its icon has an ellipsis 55 . When the
application is running, the ellipsis'goes away.

N,
Not running ~ Running



Running several applications

» Start up each application
you want to run.

You can run several applications at once, for instance, to view a Mail message
while typing in an Edit document. Although several applications can be
running, you work in only one at a time—the active application.

When you start up an application, it becomes the active application. Its main
menu replaces any other menus on the screen.

Info !
Mallbox - N,
Message
Compose I
Edit ~
Format
Windows
Print..  p
Services - : =] Flle Viewer o
Hide n i
Gui__ g ﬁ E_E’ T Activembox N\ )
BYL " S
4 g NNy
ey Nexapps ) o B =
22T vt e it b —_— 5
! E] 8’ Deiste Compnse Madhoxes faic)
g " 32 May 28 Anne Winn Tunch Spots
— ®4 33 Junot Pleme Poupon Materfals for festiva
dat {4 34 JunBt  AnneWinn Big Concert Frday
o UNTITLED.A! — - “Jea 35 Junot MaxBasit Volceovers for TV | fomo
[AfeA 36 Jun02 UriKohn Program materials
[¥fe 37 suno3 UdKohn Sprecht inferview of| BBC
s
T
—" f@
The active application is the It also contains the key window.

one with a menu showing.
You might also do something that causes an application to start up automatically.

For example, choosing a command from the Services menu can start up
Digital Librarian™. '
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Switching to another application

» Click in one of the
application windows.

Or
» Double-click its icon.
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When you want to work in another application, just click in one of its windows.
If no windows are showing, double-click the application icon.

Info ol
Flle
[Eat
Format v
Windaws
Prnt. pi -
Services -}
Hide  h|< " . »
Suat 3 File Viewser t
e
2 &“ﬁ [=] Pctive.mbox
|2t | O M| Q[T
227ME avaliabile on remnte disk S
P T Celels Maiones Frd L&E
% 32 Mayes Anne Win TUACH Tpats
- isrre Poupon Malerlals for festival program 4
agiNNE Winn Big Concert Friday! /
[xF1ax Basit Voiceovers for TV proma ”
piri Kohn Program malerials
L3 int Kahn. Sprecht Interview on BBC
\ <
Click in a window to bring the window Or double-click its application icon.

forward and activate its application.

When you leave one application to work in another, the standard windows that
belong to the application you leave stay on your screen. If an attention panel
is open, it stays, too. The application’s menus and all other panels go away.
When you switch back to the application, its menus and panels reappear, just
as you left them.



Hiding an application

» To hide an application,
choose Hide from its
main menu.

» Tounhide the application,
double-click its icon.

When you hide an application,
no unsaved work is lost. Nor is it
saved. Forinformation on saving
your work, see Chapter 5,
“Creating and Saving Files.”

If you’re through working with an application for now but plan to use it later
in the same work session, you can hide it to get its windows out of the way. All
its windows disappear from view, but the application continues to run.

By hiding applications, you can have several running and easily accessible
while your workspace remains free of windows you’re not currently using.

Edit +
Format b
Windows T
Frot.  p
Services 1
Hide h
Qut_ q
Y

]

Unhide the Workspace Manager RS
application by double-clicking When a docked application is hidden—as opposed

the NeXT icon. to not running—there’s no ellipsistr =1 in its icon.

When you unhide an application, all its windows reappear, and the application
is activated, just as though it had never been hidden.

Tip: You can hold down the Command key and double-click an application
icon to hide all applications except the one you double-click.
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Customizing the application dock

To add an application to
the dock, select the
application in the File
Viewer and dragitinto an
empty space in the dock.

To remove an application
from the dock, drag itinto
the workspace while it
isn‘t running.

To reorder applications in
the dock, drag one from

its current location to an
empty space in the dock.

"To find out which is your
keyboard’s Alternate key, see
“Keyboard Basics” in Chapter 9.
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You can fill your dock with applications you use frequently. Then tolstart upa
docked application, you just double-click it.

Applications that come with NEXTSTEP are in the /NextApps,
/NextDeveloper/Demos, and /[NextAdmin folders.

info r
[ Flle .
LEit r
LDisk r
[Visw [
i Toots r
s
r
h
9

L Windaws
Services
[ Hide

Log Qut

File Viewer

ey - Nedépps

7ME svalsbls on rerints i

Grab.app - o Librarian.app .

Preferences app {Provieweapp |~ PrioManager app -~

Drag an application from You can also drag a Release the mouse button
the File Viewer to an freestanding application when a ghost image of the
empty space in the dock. icon into the dock. icon appears.

Normally, no windows or menus can cover the dock. However, if you hold
down the Alternate key and click the NeXT icon in the dock, the dock can
be covered. To bring the dock back to the front, Alternate-click the NeXT'
icon again.

Tip: Alternate-clicking the NeX'T icon to send the dock to the back increases
the area of the screen that you can work in.



If your dock fills up, you must remove an icon from it to add any others.

" Librarian.app

T
R PrintManager.app

wb}abaﬁﬁ e

= I S

1
Preview.ap

You can drag an
application out of
the dock when it’s
not running.

Release the
application when

it disappears
from the dock.

The NeXT icon always remains at the top of the dock. The recycler appears
in the dock, or if there’s no room there, at the lower left of the screen.

Tip: You can remove a running application from the dock by holding down the
Command key and dragging it out of the dock. You can also do this to remove

the recycler.

When You Want to Locate a Docked Application

If you forget where a docked

application is in the file system,
you can see its pathname in the
Workspace Manager Preferences

panel. Choose the Preferences

command from the Info menu. Then

choose Dock from the pop-up list at
- the top of the panel.

__Workspace Manager Preferences

Press here to choose the

“Dock “"‘I

ﬁ Draw

Path: /Nex‘(Developer/{?emos/Draw.app

Dock option.

Startup atlogin [

¥ Workspace b

Click an application’s name.

¥ Preferences
 Mail
Webster
- Librarian

Its pathname appears here,
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Starting up an application automatically

Put the application in
the dock.

Choose Info from the
Workspace menu.

Choose Preferences from
the Info menu.

Choose Dock from the
pop-up list at the top of
the Preferences panel.

Click the application in
the list.

Check the “Start up at
login” box.
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You can set any application that’s in the dock to start up automatically when
you enter the workspace. If you regularly exchange electronic mail with other
people on a network, for instance, you can set the Mail application to start up
when you log in.

= Choose Dock.

A check next to an application
means the application is set to
start up automatically.

T

Start up at login

Path: /Nex}?ﬁ%:ipp

: {/’(‘furkspaca Manager
¥ Preferepdes’ T ;
¥ Mail # [
Webster
Librarian "~ - Then click this box to add or
Edit’ ) . ‘ : remove the check.

Draw
. Preview :

Click the application you want
to check or uncheck.

Bnce

The Preferences application is set to start up automatically when you first use
NEXTSTEP. You can change this by selecting the application and
unchecking the “Start up at login” box.

Tip: If you don’t usually use the File Viewer when you log in, you can have it
hidden at login. The login process is quicker that way, too. Just uncheck the
Workspace Manager in the Dock preferences. The next time you log in, all
you see is the dock. To see the File Viewer, you must double-click the NeX'T
icon in the dock.



Requesting the service of another application

Select the text or file you
want serviced.

Choose Services from the
application’s main menu.

Choose a command from
the Services menu.

Services menu commands

for NEXTSTEP applications
are described in “Standard
Commands” in the Reference
at the end of this book.

You can use the Preferences
application to remove
commands you don’t need
from the Services menu.

See “Customizing the Services
Menu” in Chapter 20.

You can request the service of one application while you’re working in another.
A service provides a shortcut to starting up or switching to an application and
requesting a specific action from it. Available services are listed in the Services
menu. Here’s one example:

Info I~ | Chartsmith 1
Mailbox | Defingin Webster =
Message I~ | Edit I~
Compose I~ | Grah ~
Edit | Librarian I~
Format I~ | Openin Workspace A4
Windows | Tracker i~
Print... p

Services ™

Hide h

Quit q

Select a file
pathname you
receive in a
Mail message.

Choose Open
in Workspace
from the
Services menu.

ol Active.mbox
p am—
! o v
| Qs 2l I
| o | R | H] L
Q; J D Py i % i i LG
tlete Compose Mailhoxes Find P st (il
31 May 28 Jason Starr CD Cover Budget
32 May 23 Anne Winn Lunch Spats
337 Jun01  Pierre Poupon Materials for festival program.
34ff Juno1  Anne Winn Big Concert Friday! -
asf] Junot  MaxBasil Yolceovers for TV prom

-{ Date: Tl
1{ From: b,
To: grey
Subject:

Kaya,

] 'm going

If you wg

il (Max Basil)

-
, 28 May 84 05:35:46 GMT-0800
Festival program cover

A welll ﬂnﬁlly finished the festival program cover. | stayed up most of the night doing it, so
ihome now for a shooze.

tto checkit out, it’s in:

e

| misverativenas O iscR AR vaLProgram

1 See you later this afternoon.

The file opens without
your having to locate it
first in the File Viewer.

The exact commands in the Services menu depend on which applications you
have. Several NEXTSTEP applications provide services. If you have other
applications, you might see other services in the menu, too.
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Quitting an application

» Choose Quit from the
application’s main menu.

For information on saving your

work before quitting an

application, see Chapter 5,
“Creating and Saving Files.”
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When you’re completely finished with your work in an application, you can
quit the application to put away all its windows and any work they contain.

Info r

[File r
|Eait r
Disk "
[ View "
| Tools ~
™
v
h
g

[ Windows
| Services
Hide

Lng Out

i |
e
arey NextApps

227M8 aviinhle on remote disk

File Viewer

dat Net

creative

T Apps BP fogofr -

i - Fall Catalog.nif Festival .

m

2
Catalogs
IFA

Fram Mom fax

€D Coverrifd
£

©Library

When you quit an application that's in the
dock, the ellipsis[* r=]] reappears in its icon.

If any window in the application contains unsaved work, a panel asks if you
want to save before quitting the application (and closing the window).

Tip: If you think you may use the application later in your work session and
just want its windows out of the way, it’s better to hide the application rather
than quit it—it takes less time to unhide an application than it does to start it

up again.



When the Quit Command Doesn’t Work

On rare occasions, your actions in an application
may have no effect due to a software problem.
You can usually solve the problem simply by
quitting the application and starting it up again.

If choosing the Quit comimand has no effect, you
may be able to quit the application by using the
Workspace Manager Processes command.

Switch to the Workspace Manager—for instance,
by clicking in the File Viewer. Open the Tools menu
and choose the Processes command. Then choose
Applications from the pop-up list at the top of the
Processes panel. Select the application you want to
quit and click the Kill button.

The application quits running, but any unsaved
waork in the application is lost. You should use the
Processes command to quit an application only as
a last resort.

Press here to choose

Applications &=~ Applications.

[T mailapp

Preferences.app

Select the application

| you're having

po
‘Al WhosWho.app #
Yi Workspace Manager

_..,, WhosWho.app

Path: /LocalApps/WhosWho.app

Status: running

problems with.

Click to quit the
application without
saving any work.

¥

Kill
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NEXTSTEP Applications
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Your computer comes with several applications in
the /NextApps folder. These applications are briefly
described below along with their icons.

Edit is a Rich Text editor you can use
to create formatted documents with
graphics. See Chapter 9, “Typing and
Editing,” and Chapter 11, “Working

with Graphics.”

Mail {also called NeXTmail) is a
multimedia electronic mail application
for communicating with others on a
network. You can send text, graphics,

sound, and even files and folders.
See Chapters 13 and 14.

, Preferences is an application you can use
Tweo), | toset personal preferences for using the
i 3 computer, such as key repeat speed or an

I application language. When it’s running,
its icon in the dock shows the date and
time. See Chapters 20 through 22.

Preview displays the contents of
PostScript, EPS, and TIFF files as images.
See Chapter 11, “Working with Graphics.”

Grab is an application you can use
to create a TIFF image from a window,
a selection on the screen, or the entire
screen. See Chapter 11, “Working

with Graphics.”

Digital Librarian is for setting up an on-
line library of reference material and
looking up information in it. See

You’ll also find demonstration applications in
/NextDeveloper/Demos, system administration
applications in /NextAdmin, and if you're using the
NEXTSTEP Developer software, applications for
developers in /NextDeveloper/Apps.

‘ —] Digital Webster™, which you may need to
P :?l install from the NEXTSTEPCD-ROM, is for
% | looking up words in Webster's Ninth New
Collegiate Dictionary® and in Webster’s

Collegiate® Thesaurus. See Chapter 12,
“Using On-line References.”

PrintManager is for monitoring and
managing printing and faxing, for
example, by checking the print queue or
adding a fax modem. See Chapters 15

through 18.

FaxReader is for reading faxes you
receive, printing them, and working
with them in other ways. See Chapter 17,

| “Getting Faxes.”

Installer is for adding new software to
your computer. It's a system
administration application that’s located
in /NextAdmin. See Chapter 19.

Terminal is for working on the computer
directly with UNIX by entering UNIX
commands and running UNIX programs.
Terminal can also run programs that

Chapter 12, “Using On-Line References.” ’

require VT100™ terminal support. It's
documented in NEXTSTEP Development
Tools and Techniques.
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Whenever you create a document—a text report, an tllustration, or a spreadsheet,

Jor example—you start by creating a file. All the work you do is kept in that file

when you save it. You can change it and save the changes, or you can save different

versions of the file.

BP logotif .

Catalogs

CD Covertfd

From Morm.fax

- Library

Mailboxes
my signature tiff

Legends of the Blues
Where i all began...

Bessie 3mith
The Empress of the Blues, she was born in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Memphis Slim
Over the course of half a century, this Arkansas
pianist took the Blues from the barrelhouses and
dives of Beale street, to the big-name blues world

of Chicagoe, and across the ocean to the world,

Name: | Fall Catalog

Home

grey

ME available on remate disk




Creating a file

Opening an existing file
Saving a new file
Saving-changes

Saving another version
of afile

Creating and

Saving Files

You sit down to create a masterpiece. Before you,
a new empty canvas. With brush in hand, you
make the first mark. It’s brilliant, so you give it a
name. Self Portrait. 'Then as you try to capture the
eyes, disaster strikes. You miss a stroke, and the
work 1s ruined.

If only you could retrace your steps. Turn back

the clock and avoid that fateful blunder. Try the
eyes again. Ity them several times. Pure and
innocent the first time and then maybe with a glint
of aged wisdom.

You emerge from this reverie and tuck the portrait
away. It’s time to move on to something else. You
turn to a blank page and begin to write. Prose. The
first paragraph is riveting, so you give it a name....

69



Files, Folders, and Disks

Chapter 5: Creating and Saving Files

Creating a file

1 Start up the application
you want to use.

2 Choose the command
that opens the document
menu.

3 Choose New.

You name a new file when
you first save it. See “Saving
a New File” in this chapter.

70

When you want to create something new, you start up the application you want
to use, open a new window, and begin to work in it.

You open the window with the New command in the document menu. This
menu might be called Document, Image, Project, or whatever describes what
you create with the application.

The command directly below Info opens
— the document menu, named File here.

[¢]
File A New Q!
Edit i | save s .
Formal 1 Saveno. S N\ Choose New to open a new window.

Windows | SaveTo..
Print... p | Save All

- . A new window'’s You can begin working in
Services ' | Ravertto Saved title bar contains the window right away,

Hide _ h]Close a temporary title. for example, by typing.
Quit q __ _ ’

Legends of the Blues
Where it all began...

Bessié Smith
The Empress of the Blues, she was bom in poverty only to become one of
the most renowned|

You store the work you do in a file. You name the new file and put itin a folder
when you first save the contents of the new window.

If you close the window without saving, no file is created and work you’ve
done in the window is lost.

Some applications give you a new window automatically when you start them
up from the dock or when you open their file from the File Viewer.



Opening an existing file

Choose the command
that opens the document
menu.

Choose Open.

In the Open panel, select
the file or files you want
to open.

Click OK.

You can use the same shortcuts to
typing pathnames in the Open
panel as you can in the Finder.
See “Shortcuts to Typing
Pathnames” in Chapter 3.

For more information on using a
browser, see “Browsing Files and
Folders” in Chapter 3.

You can use the disk buttons in
an Open panel to open and eject
floppy disks. See “Opening and
Saving Files on a Floppy Disk”
in Chapter 8.

You can open a file while you’re working in an application. You use the Open
panel, which contains a small browser that lists the files the application can
open. You locate a file in this browser just as you locate a file with the browser
view in the File Viewer.

Scroll along a branch

of the file system.
[TAudio ~ [ TApps r
i |basil I BP logo tiff . .
! gey AT [Cadlogs ) Open a folder by clicking it.
it -|hohner " CD Coverrtfd !
1 kim ™~ From Mom.fax \
it |Print o fyLibrary “-mm Select the file you want to open.
1| Video I [=diMailboxes
e | Y llmy signature tiff
KT : ! e 1 /C/ick to open the file.

Name:|CD Cover.fd

ﬁkﬂ_‘wﬁj‘l vCancel I’

Click as a shortcut to

oK &
= opening your home folder.

.

Instead of selecting the file you want to open, you can type its pathname. If
the file is further down the branch of the file system from the folder that’s
currently open in the panel, you only need to type the part of the pathname
that begins with a name in that folder.

- You can type this to open
e e Summer Catalog.rifd from
e the Catalogs folder.

Narme:| Catalogs/Summer Catalog.rfef

Tip: You can double-click a file in the browser to open the file without having
to click OK. You can also open more than one file by selecting the files you
want to open—for example, by dragging over them—and clicking OK.

When you open a file, the panel goes away and the contents of the file appear
in a window.
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Saving a new file

Choose the command
that opens the document
menu.

Choose Save.

In the Save panel, name
the file and open the
folder you want to put
itin.

Click OK.

For more information on using
a browser, see “Browsing Files
and Folders” in Chapter 3.

You can use the disk buttons in
a Save panel to open and eject
floppy disks. See “Opening and
Saving Files on a Floppy Disk”
in Chapter 8.
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"To name a new file and put it in a folder, you must save it. When you’re
working in a new window and you choose Save, a panel opens that contains
a browser. You locate and open a folder in this browser just as you do with

the browser view in the File Viewer.

i I Apps Sy
BP logoif -

Catalogs ;
| | CD Cover.nfd

| JIFrom Mom.fax
- | [brary

Al _M_allboxes

ELTTENT A—

Scroll along a branch of the
file system.

Open the folder you want to put
the file in by clicking the folder.

Type a name for the file here.

”: / Click to save the file.

Click as a shortcut to opening

=== yOUr home folder.

Tip: You can scroll directly to any folder in the Save panel by dragging the
folder’s icon from the File Viewer into the panel.

You can choose nearly any name
you want for a file or folder. Just
keep the following in mind:

* You can’t use the same name
more than once in the same
folder. However, you can use the
same name in different folders.

 Lowercase letters are
distinguished from uppercase

letters, so Fall Catalog is different

from fall catalog.

Guidelines to Naming Files and Folders

« You can use any characters except
aslash (/), which separates names
in a pathname. If you work with
files directly in UNIX, also avoid
spaces andthe’ “ &I -and A
characters, which have special
meanings in UNIX. '

* Remember that the extension
at the end of most file names
associates the file with an
application. If you don'tinclude
the extension when you name
the file, the application adds -
it automatically. :




When you save a file, the Save panel goes away and the file is placed in
its folder.

The name of the file and

) Fall Catalog.rtf — ~ ]
the pathname of the folder

Legends of the Blues it’s in appear in the new
S Where it oll began windows’s title bar.
Bessie Smith

The Empress of the Blues, she was bom in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Memphis Slim
Over the course of half a century, this Arkansas
pianist took the Blues from the barrelhouses and
dives of Beale street, to the big-name blues world

A
A of Chicago, and across the ocean to the world,

A

Tricks in the Name Fleld o

Instead of selecting a folder to save

" afile in, you can type a pathname
for the file in the Save panel. Use
the same shortcuts described in
Chapter 3 in “Shortcuts to Typing
Pathnames.”

To save the file further down the
branch of the file system from the
folder that’s currently open in the
panel, type just the part of the
pathname that begins with a name
in that folder. In the panel on the
previous page, for example, type
Catalogs/Fall Catalog to save Fall

~ Catalog.rtfd in the Catalogs folder.

You can also create a folderto save a
file in. Type a pathname for the file
that includes the folder’'s name as
though the folder already exists.
Type Festival/Program, for example,
to create a Festival folder and save
Program.rtfd in it. In the panel that
asks if you want to create the folder,
click Create.

To replace a file with the one you're
saving, select the file you want to
replace and click OK, or just double-
click the file. In the panel that asks if
you want to replace the file, click
Replace. '
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Saving changes

To save changes in a file,
open the document menu
from the main menu and
then choose Save from
the document menu.

To save changes in

all the files open in an
application, choose
Save All from the
document menu.

You can get rid of changes

you don’t want to keep with

the Revert to Saved command

in the document menu. See
“Standard Commands” in

the Reference at the end of

this book.
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You save changes you make to a file so they’re there when you next open the
file. Just choose Save while working in the window that contains the file. The
contents of the window replace the previous version of the file on disk. The
window stays around so you can keep working in the file.

[me] 0

Reverend Gary Davis
He rose from playing hard-time gospel on the streets
of Harlem to becoming one of the great folk legends
of the sixties. And guitarists all over the world are
still trying to cop his style.

x o)
, \

Memphis Minnie
She sang the Blues with amessage for her
times—and had one of the hippest guitar styles
around.

Blind Lemon Jefferson

= One of the earliest blues professionals, he wandered
A the streets and made aliving singing in bars. His life
¥ is shrouded in mystery, but rare recordings survive

Reverend Gary Davis .
He rose from playing hard-time gospel on the streets
of Harlem to becoming one of the great folk legends
cf the sixdes. And guitarists all over the world are
still trying to cop his style.

Memphis Minnie
She sang the Blues with amessage for her
times—and had one of the hippest guitar styles
around,

Blind Lemon Jefferson
One of the earliest blues professionals, he wandered
the streets and made a living singing in bars. His life
is shrouded in mystery, but rare recordings survive

T

A partially drawn close
button means the window
contains unsaved changes.

After you save, the close
button returns to normal.



Tip: You should save changes periodically as you work in a file, not just when
you’re about to close it. By saving frequently, you avoid losing a lot of work if
the file closes unexpectedly—for example, if there’s a power failure.

If you choose Save All when any new window is open whose contents you

haven’t yet saved, a Save panel opens. You can then name the file and putitin

a folder.

When You Save an Edit Document

When you save an Edit document,
Edit creates a temporary backup file,
which contains the version of the file
without the changes you're saving.
Edit deletes this backup file as soon
as the new version is successfuily
saved on disk. »

If something happens that prevents
Edit from saving the file—a power
failure, for example—the backup
copy remains, and you can recover

its contents. You can tell which is
the backup copy because it has
the same name as the original file
but with a tilde (~) appended to it.
For example, the backup copy for
Memo.rtf would be Memo.rtf~.

If you do end up with only the
backup file, you can remove the ~

from the name and use it in place

of the original. See “Renaminga

File or Folder” in Chapter 6.
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Saving another version of a file

Open the document You can save the contents of a file under a different name and in a different
menu from the main folder while keeping the original file, too. You typically do this to save one
menu. version of a file before making any more changes to it.

Choose Save As or Both the Save As and Save To commands save the contents of the window
Save To from the you’re working in as another file. Each command opens the Save panel, where
document menu. you name the new version of the file and put it in a folder, just as you do fora

In the Save panel new file. The original file stays the same as when you last saved it.

name the new version
and open the folder
you want to put it in.

Save As 5 Fall Catalog.rtf — ~ [
Reverend Gary Davis
He rose from playing hard-time gospel on the streets
of Harlem to becoming one of the great folk legends
l'ﬂ of the sixties, And guitarists all over the world are
st Gary Devia
Ferove umploing - grpe e s
el becarmbg e b rem ik s
0 s A g v et e

: still trying to cop his style.

W Memphis Minnie

‘ She sang the Blues with amessage for her
times—and had one of the hippest guitar styles
around.

Click OK.

One of the earliest blues professionals, he wandered
af the streets and made a living singing in bars. His life

-
"J Blind Lemon Jefferson
v is shrouded in mystery, but rare recordings survive

—

Save As puts away the You keep working in the new version,
previous version, which which includes changes.
doesn't include changes.

Save To = Fall Catalog.tf — ~ J—
Reverend Gary Davis
He rose from playing hard-time gospel on the streets
of Harler to becoming one of the great folk legends
of the sixties. And guitarists all over the world are
I.-ll
Revard Gy Divia
e ot o paying e ospl o the et
o e beceming e o he gre ok egends
e . A bt o v e ek e

stll wying to cop his style.

Memphis Minnie

She sang the Blues with amessage for her
times—and had one of the hippest guitar styles
£ around.

i ykng o cop i syl Blind Lemon Jefferson

One of the earliest blues professionals, he wandered
the streets and made aliving singing in bars. His life

e i e st b windred ] is shrouded in mystery, but rare recordings survive
wnd made a Iving singing fo bars. His e e S — —

he srcets
b shrouced i myrtery, bk rare recordings evive

Marnphis karria
‘She samg the Blues whth  mesnage fo her
ne—andnd ne ot ey e sves
ar

ETE

<

Save To puts away the You keep working in the old version, where
new version, which your changes aren't yet saved.
includes changes.

Tip: You can think of these commands as taking a snapshot of one version of
the file and putting the snapshot away, while you continue to work in the
other version of the file. Save As takes a snapshot of the original version, and
Save To takes a snapshot of the revised version.
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Why Save?

When you work in a file—for example, by typing

in an Edit document—the computer displays your

work in a window. But it doesn’t retain your work
permanently on disk until you save the file.

When you open a file:

When you revise the
file, for example, by
typing in it:

When you save the file:

Legends of the Blues
Where ur ol began...

s
‘The Empeeas of the Blues,she was bom npovery
enly  become ane o the mortrenawned—and
bighes puid—blues performers o her day.

Before closing a window that contains a file you've
been working in, you need to save changes you've
made if you want them to be there the next time you
open the file. If you close the file without saving, the
changes aren't copied onto the disk and they won't
be there when you next open the file.

= " Fall Catalog.ntf — ~ ]
Legends of the Blues
- Where it all began...

Bessie Smith
The Empress of the Blues, she was born in poverty
only to become one of the mostrenowned—and
highest paid—blues performers of her day.

i
A4

1

The computer leaves
the file on disk.

Lugends of the Blues
Were i il begen...

Besse Sritn
‘T Ermpress of the B, she sras born n paverty
anlyto become ane of the mos rensvmed—n
highes paid—bhues pestomaens ot her oy,

It copies the file into a window.

Fall Catalog.rtf — ~

Legends of the Blues
- Where it all began..

Bessie Smith
The Empress of the Blues, she was born in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Memphis Slim
Over the course of half a century, this Arkansas
planist took the Blues from the barrethouses and

A dives of Beale streeg, to the big-name blues world
v of Chicago, and across the ocean to the world.

The file on disk remains
unchanged.

Legends of the Blues
e it il began...

‘The Empress ofthe Hues, she was bornin paverty
enly m became ame of the men renswned—wnd
Bighertpaid—bhies pertormers of ez day.

of Chicago, nd across the sceanto the worid

You see your revisions in the window.

~ Fall Catalogrtf — ~

Legends of the Blues
[ Where it all began...

Bessie Smith
The Empress of the Blues, she was bom in poverty
only to become one of the most renowned—and
highestpaid—blues performers of her day.

Memphis Slim
Qver the course of half a century, this Arkansas
pianist took the Blues from the barrelhouses and
dives of Beale street, to the big-name blues world
of Chicago, and across the ocean to the world,

£l
Y

The copy you'‘ve revised
replaces the file on disk.

i
i
i
1
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o keep your files organized, you put them in folders. Then you put the folders in
other folders to keep related work together: You can move files and folders, copy

them, or throw them away—all by dragging icons.

Processes “

‘Background =4

LE]H_{l‘\k‘!‘gy’my!j{citWF‘ress Releasas/a April

File Viewer .

B s e

;rhk

creative

Catalogs |

e meMo'm.fa:{




O

Creating a folder

Renaming a file or
folder

Copying a file or folder
Moving a file or folder
Replacing afile or folder
Merging two folders
Creating a link

Setting options for
copying links

Compressing and
decompressing a file
or folder

Deleting a file or folder

Retrieving a file or
folder from the recycler

Handling several files
and folders at once

Managing several file
operations

Solving file and folder
- problems

Organizing

Your Work

You'd lose your own head if it weren’t stuck on your
shoulders. That’s what your mother used to say. Your
room always looked like a cyclone had hit it, and

later, so did your house. When you started your own

business, all your friends got together and threw a
wake for it. Real funny.

Of course, you got the last laugh when you became
the largest distributor in the state. And as your bank
account grew, so did your inventory. You were always
reorganizing it—creating new categories, merging
old ones, relabeling things, finding ways to save
space—all in your spare time. You told your friends
it was magic. It was actually just your computer.

As for your house, it’s being featured on the covers
of two interior design rags. Computer magic? No,
you just hired a maid.
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 Permissions Granted

To make changes to the file system, for instance, by
moving files around or renaming them, you must
have certain permissions for the files and folders
you're working with. To rename a file, for example,
you need permission to change the contents of the
folder it's in.

There are two basic types of permissions for a file or
folder: read permission—that is, permission to look
at its contents—and write permission, or permission
to change its contents.

All of the tasks described in this chapter require that
you have the correct permissions. When you try to do
something you don't have permission for—such as
move a file out of someone else’s folder—a panel
typically informs you that you can't do it.

When you have read permission
for a folder or file, you can see
its contents:

Read | |
write | X |

renmren

o

You read a folder when you
open it and look at its contents.

Words.rtf

When you also have write
permission for a folder or file,
you can change its contents:

oas [ ]
Write | V!

You write in a folder, for
example, when you rename
afile in it or add a file to it.

Lyricsl .rtf

You can set permissions for your own files and
folders to prevent anyone else from changing

them. For example, you might give other people
permission to read a folder, and therefore browse its
contents. But if you don't give them write permission
for the folder, they can‘t change the folder's contents,
for example, by moving a file out of it.

You can even use permissions to protect your work
from yourself. If you remove write permission from
an important file, for example, you can't accidently
alter the file by saving changes to it.

For information on how to set permissions for
yourself and for others who have access to your files,
see “Changing Permissions for a File or Folder” in
Chapter 7.

You read a file when you open
it in an application.

info. ] Open... o

File > New o0

Edit o~ Savel g

Format - | Sa .
Windows - | Sa{™

Print.. p|Saj.| Legendsofthe Blues

Services | Rey” Where it all began...

Hide . DO | possinsmin

Qut g The Empress ofthe Blues, the wes bora n poverty

anly to become one of the most renowned—and
bighest paid—blues performers of her day.

You write in a file when you save
changes to it.

EEN

Info -] Open. 3

File B Hew Ty

Edit -7 r{ Save S

Format” 1| Sayed

| Windows -] Say”

prnt.. - g{sa{i] Legends of the Blues

Services | Reyr|  Pereiralbegan.

Hide = h{ Clo|:

Qi g ” The Empress of the Blues, she was bon in poverty
- only to become one of the most renowm—and highest
Y paid—blues performers of her day.
1 Momphis Stm

Ovwer the course of half a century, this Arkansas
‘planist took the Blues from the barrelhouses and
dives of Beale streey, to the the big-name blues world
rid,
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Creating a folder

Open the folder you want
to put the new folder in.

Choose File from the
Workspace menu.

Choose New Folder
from the File menu.

Type aname for the folder
and press Return.

Pick a name for your folder as
described in “Guidelines to
Naming Files and Folders” in
Chapter 5.

As you accumulate files, you can create folders to put them in so they’re easy
to find. Choosing New Folder creates a folder in the current folder.

NextApps

S27ME avalible on remots sk

File Viewer

creative

Fall Catatog.nf

i

my signature tiff

<>i

BP logoiff
V.

From Mom.fax

. {NewFolder |

]

(Atﬁrst, the folder is
named NewFolder.

|

1 Festival [

You type the
name you want
and press Return.

Your new folder is empty at first. But you can put files and other folders in it by
copying or moving them into it, by saving fil€s in it, or by creating other new

folders in it.
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Renaming a file or folder

Select the file or folder.

Edit the name in the
icon path.

Press Return.

Pick a new name for the file

or folder as described in
“Guidelines to Naming Files

and Folders” in Chapter 5.

You can use Edit menu

commands to edit a file or

folder name. You can also

choose Sort Icons from the

View menu to alphabetize

the contents of a folder

after renaming in it. See
“Workspace Manager

Commands” in the Reference

at the end of this book.
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You can rename a file or folder simply by editing its name in the File Viewer
or any other folder window.

E File Viewer

@W

NextApps
227ME wa:hblc on rerote disk © -

— When you click in a
: J“ . name in the icon path, an
d b

i insertion point appears.

- creative " Festival - - | Program Cove -

Inthe icon or listing view,
you can also edit a name
in the current view.

{ Program ifd

What You Shouldn’t Rename

The name of a file or folder can't or may prevent you from opening
. shouldnt change in these cases: files you've already created wuth

~ the application.
i+ You can't rename your home PP

b folder. ; - Don't change a file's extension if Sl
Lo ‘ . : that will prevent the file from .

: » Don't rename an application.
. B : opening in the n ht a Ilcatlon
Changing an application’s name P g ' g pp




Copying a file or folder

1 Select the file or folder
and drag it to the shelf.

2 Select the folder you
want to put the copy in.

3 Hold down the Alternate
key and drag what
you're copying from
the shelf to the folder
in the icon path.

To find out which is your
keyboard’s Alternate key, see
“Keyboard Basics” in Chapter 9.

If the Processes panel asks for

additional instructions, see
“Solving File and Folder

Problems” in this chapter.

For information on copying a

selection of files or folders, see
“Handling Several Files and

Folders at Once” in this chapter.

You can also use the Duplicate

command in the File menu

to copy a file or folder. See
“Workspace Manager

Commands” in the Reference

at the end of this book.

You can make a copy of a file or folder in another folder. When you copy a
folder, you copy all the files and folders in it, too.

& £

NextApps
227MB mxuu» on remats dish,

[ File Viewer

The folder opens to
accept the selection.

-

Net

Festival Rel&\
=/

creative grey

I S] i

il fﬁ‘@‘
X CD Cover.rfd
JFK'X a@

From Mom.fax Library

Fall Catalog.rtf

i

The copy cursor[]
shows that you’re
copying instead

of moving.

In the icon view, you
can also drag to or
from the current view.

The standard way to copy a file or folder is to drag it from the shelf to a folder
in the icon path. But you can also drag from the icon path to a folder on the

shelf, or from one folder window to another.

You might not need to hold down the Alternate key while you drag. It depends
on where you're dragging the selection to. When you drag it to a folder that’s
ona different disk, for example, the cursor automatically becomes al['jand the

selection is copied even if you don’t use the Alternate key.

If a folder doesn’t open when you drag a selection to it, you don’t have

permission to put anything in that folder.
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Moving a file or folder

1 Select the file or folder and  You move a file or folder into another folder much as you copy it—by dragging
it to the other folder. When you move a folder, you move all the files and

drag it to the shelf.

2 Select the folder you want
to put itin.

3 Hold down the Command
key and drag what you're
moving from the shelf to
the folder in the icon path.

"To find out which is your
keyboard’s Command key, see
“Keyboard Basics” in Chapter 9.

If the Processes panel asks for

additional instructions, see
“Solving File and Folder

Problems” in this chapter.

For information on moving a

selection of files or folders, see
“Handling Several Files and

Folders at Once” in this chapter.
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folders in it, too.

grey

-~ NextApps

227MB avadlabls o remote disk

CD Cover.ifd -

N\

Library
N
\~ .

The folder opens to
accept the selection.

{ Catalogs

The cursor changes
color[} to show that
you’re moving instead
of copying.

In the icon view, you
L 2N also drag to or
from the current view.

The standard way to move a file or folder is to drag it from the shelf to a folder
in the icon path. But you can also drag from the icon path to a folder on the
shelf, or from one folder window to another.



You might not need to hold down the Command key while you drag, It
depends on where you’re dragging the selection to. When you drag it to
a folder on the same part of a disk, for example, the cursor automatically
becomes a [ and the selection is moved even if you don’t use the
Command key.

If a folder doesn’t open when you drag a selection to it, you don’t have
permission to put anything in that folder.

When It's a Copy or a Move

When you drag a file or folder to
another folder, the Workspace
Manager either copies it or movesiit,
depending on where the destination
folder is. You can tell which by the
shape of the cursor:

A [['] copies the selection. This
cursor appears when the selection
and folder you're dragging it to are
on a different disk (or part of a disk,
if your system administrator has
divided the disk up to act as separate
disks). Forexample, it appears when

you drag a file from your computer’s
hard disk to a floppy disk or to a disk
in another computer on a network.

ATy moves the selection. This cursor
appears when the selection and
folder are on the same disk or part of
a disk.

To make the copy cursor appear in
any case, you can hold down the
Alternate key as you drag. To get the
move cursor, hold down the
Command key.
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Replacing a file or folder

Select the file or folder You can replace a file or folder with another one of the same name. If the
you want to use as the replacement and original don’t have the same name, rename one of them
replacement. so they do. Then copy or move the replacement into the folder that contains
Drag the selection to the original. The Processes panel asks if you want to replace the existing file
the folder that contains or folder.
the file or folder you want _
to replace. - - processes ; , Pathname—or part of

SRR e SR the pathname—of the
Click Replace in the file you're copying.

[ /Net/publicity/Press Releases/s 7 Alernt

Processes panel.

File you’re about to replace.

Festlval Releasénfd already exists

You can stop the oﬁéraﬂon or replace tha éxiéﬁng file. e R Click if you don't want
Lo « ' : to replace anything.

= Click to replace the file.

Replacing a folder removes the entire contents of the existing folder and
leaves only the contents of the folder you copied or moved.

] Contents: 1 Contents: ™} Contents:
| Dog.tiff & | -Cattifi— | Dog.tiff
=1 Frog.tiff 1 -Dog-tiff— - Frog.tiff

At
Copy this Art folder... ...over this Art folder. The Click Replace to get
entire folder is replaced. these contents.

Any file or folder you replace is
moved into the recycler. To get
it back, see “Retrieving a File or
Folder from the Recycler” in
this chapter.

For information on replacing a

selection of files and folders, see
“Handling Several Files and

Folders at Once” in this chapter.

If the Processes panel asks for

additional instructions, see
“Solving File and Folder

Problems” in this chapter.
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Merging two folders

1 Select the folder you
want to merge.

2 Hold down the Alternate
key and drag the
selection to the folder
that contains the folder
you want to merge with.

3 Click Merge in the
Processes panel.

"To find out which is your
keyboard’s Alternate key, see
“Keyboard Basics” in Chapter 9.

For information on merging
more than one folder at a time,
see “Handling Several Files and
Folders at Once” in this chapter.

Any file or folder that’s replaced
is moved into the recycler. To
get it back, see “Retrieving a
File or Folder from the
Recycler” in this chapter.

If the Processes panel asks for
more instructions, see “Solving
File and Folder Problems” in
this chapter.

You can incorporate changes made to one folder into another folder that has
the same name. When you copy a folder over another with the same name, the
Processes panel provides these options.

Pracesses

“Backgiound =

(] /Backup Files/s May #

Alert

/

5 M'a{y already exists

You can merge with the existing fold
replace the existing version.

7, stop the operation, or

verge | Siop

When you merge two folders, the new folder contains the entire contents
of the folder you copy, plus any files or folders unique to the existing folder.

Folder you're copying

Folder it's merging with

Click to merge the two folders.

Click to stop the operation
without merging anything.

Contents: Contents: Contents:
Dog.tiff % 1 Cat.tiff Cat.tiff
.. Frog.tiff * | -Dog:tiff— Dog.tiﬁ
art Frog.tiff
Copy this Art folder... ...over this Art folder. Only Click Merge to get

one file is replaced.

How Merging Saves Time

Before the Workspace Manager
replaces a file during merging, it
checks for any differences between
it and the replacement. It compares
their size and the date they were
last changed. If it finds no difference,
it doesn't replace the file.

When you're working on a large
project at your office, you might

these contents.

copy part of the project onto a disk
to work on it at home. Maybe you
change 5 files out of 20 that you
copied. When you merge them
back with the rest of the files, the
Workspace Manager detects that
you changed only 5 files. Instead of
taking the time to copy all 20 files, it
copies only those 5.
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Creating a link

Select the file or folder
you want to create a link
to and drag it to the shelf.

Select the folder you
want to put the link in.

Hold down the Control
key and drag the
selection from the
shelf to the folder in
the icon path.

For information on creating

several links at a time, see
“Handling Several Files and

Folders at Once” in this chapter.

You can identify a link and tell
what file or folder it points to
with the Inspector command.
See “Getting Information about
a File or Folder” in Chapter 7.
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You can keep a file or folder in one location and work with it in another by
creating a /n# to it. The link looks just like the file or folder it points to. It has
the same icon, and when you open it, you see the same contents.

[w] File Viewer The folder opens to
: : D : : accept the selection.

NG
grey “ NexlApps - £ - N " Press Releases "™\
227 ME avallable on remote disk k s PREERE NN
|
o] - N
=3

creafive

L Alink cursorRy
o shows that you're
. ﬁ ‘ & creating a link instead
P logouit Catalogs A of copying or moving.
FAX i

~l

From Momfax .

With the icon view,
youcanalsodragto or
from the current view.

"To create a link, you can also drag from the icon path to a folder on the shelf,
or from one folder window to another.

If a folder doesn’t open when you drag a selection over it, you don’t have
permission to put a link in that folder.



What Is a Link?

Alink is a pointer to a file or folder that's somewhere
else in the file system. A link looks and acts like the
file or folder it points to. It has the same icon, and
when you open it, you see the same contents.

On a network, links make it easy for several people to
open the same file. For example, if you're working
with a group of people on the same project, you can
create a link to your group’s Schedule file and keep it
in your home folder. To see the current schedule—
including any changes made to it—you can open
your link.

Links also save time. Instead of following a lengthy
path to a folder you workin frequently, you can create
a link to the folder and put it somewhere convenient,
such as in your home folder. Then to get to the actual
contents of the folder, you just open your link.

Finally, links save disk space. Instead of copying a
sound or application into your home folder, just make
alink to it. Since a link is just a pointer to the file, it
takes up practically no space on the disk.

Alink remains tied to the name and location of the file
or folder it points to. You can move the link or rename
it, and it still points to the file or folder. If the actual file
or folder is moved, renamed, or deleted, however,
the link breaks. You should therefore make links only
to files or folders that you're relatively sure aren’t
going to be moved or renamed.

When a link does break, its icon changes to a question
mark. You can reestablish the link by returning the
actual file or folder to its original location and name.
Otherwise, you should delete the link. '

Publicity Relt:sk\iignature.tiﬁ
[}

Opening the link Publicity Releases

actually accesses the contents of the

Press Releases folder.
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Setting options for copying links

Choose Info from the
Workspace menu.

Choose Preferences from
the Info menu.

Choose File Copy Options
from the pop-up list at
the top of the Workspace
Manager Preferences
panel.

Select an option.
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When you copy a file that’s actually a link, the Processes panel asks whether
you want to make another link, or make a copy of the actual file or folder the
link points to. If you don’t want to be asked, you can select an option that
applies for every link you copy. You select this option in the Workspace
Manager Preferences panel.

Workspace Manager Preferences

Press here to choose File
Copy Options.

= When alink is encountered... - -

Crask eommne — e Select an option for how you
) Cimake anewlink - ’ want all links to be copied.
* {skip the link

(‘ copythaongmat 1

Optlons for COpymg Lmks

Select one of these options from the File Copy Optrons in the Workspace
Manager Preferences panel. The optlon you select applres for aIl Imks that

you copy.

Skip the link Select this option and
the Workspace Manager skips all
links without copying them. .~

Ask When this option is selected,
the Processes panel asks what
you want to do for each link you

tryto copy. Copy the orrgmal Select thls optlon L

Make a new link Select this option
“-and the Workspace Manager creates:
- another link for each link it copies.

andthe Workspace Manager creates’

: acopyofthe actual file orfolderthat =
- a I|nk pomtsto s ~




Compressing and decompressing a file or folder

» To compress a file or You can free space on your disk by compressing a file or folder. Then when you
ft;llder. S::allec: it an(li‘ want to open the file or folder, you decompress it.
choose File from the
Workspace menu. Then
choose Compress from . g’
the File menu. o

227HMB avaishle on W@[’:fopps

» Todecompress thefile or P _ S
folder so you can openit, " =S [ﬁ " ( “ é A compressed
select it and choose File - Net publicty Press Releases %’n{w.cemp_r?ié?i; Z)"; I:’S’ I,;I?édtiri .
from the Workspace Sl a :
menu. Then choose Hgt g Iﬁ w : i’:,misased
Decompress from the o il » , extension.
File menu. . lwu”ary.cumpressedi 2 February 3 March 4 April

ﬂﬁ "’:.1

5 May 6 June

api]

B |

When you compress a file or folder, the amount its size is reduced depends on
the kind of information in it. Compression works best on text files, reducing
the size by up to 75 percent. It’s also a good idea for folders that you don’t look
in very often, such as a folder containing an old project you’re not currently
working on.

You can decompress a file or folder with the Decompress command or you can
double-click a compressed file or folder. In the latter case, the Inspector panel
opens, and you can click the Decompress button to decompress the file or
folder. The file or folder then has its original icon and takes up its original
amount of disk space.

You can use the Inspector
command to find out the size
of a file or folder before and
after compressing it. See
“Getting Information about a
File or Folder” in Chapter 7.
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Deleting a file or folder

Select the file or folder.

Drag the selection
from the icon path to
the recycler.

When you're sure

you want to destroy
everything in the
recycler, choose File
from the Workspace
menu and then choose
Empty Recycler from
the File menu.

You can destroy a file or folder
without moving it to the
recycler with the Destroy
command in the File menu.
See “Workspace Manager
Commands” in the Reference
at the end of this book.

On many networks, the system
administrator makes backup
copies of files. If you accidently
destroy something, see your
system administrator about
retrieving a copy of it.

For information on deleting a

selection of files and folders, see
“Handling Several Files and

Folders at Once” in this chapter.
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You can remove a file or folder from the file system without immediately
destroying it by moving it into the 7ecyc/er—the icon at the bottom of

the screen. When you decide you really want to destroy it, you can empty
the recycler.

| viorkspace
Info

(Flig =~ -
Edit

Disk

View
Taols

| Windows

[ Services

| Hide

Log Out

grey Nexapps
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 craative 1 BP logoift

| [T

Nt .
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Festival From Mom fax R . Maliboxes . -

A sphere in the center of the recycler M The recycler starts spinning
means there’s something in it. i to accept your selection.

You can also drag a file or folder from the shelf to the recycler. Or with the icon
view, you can drag it from the current view.

Caution: The Empty Recycler command permanently destroys the contents of the
recycler. You should leave files and folders in the recycler until you're sure you don't
need them. But to free disk space, make sure to empty the recycler periodically.




Retrieving a file or folder from the recycler

1 Double-click the recycler. When you move a file or folder into the recycler, it isn’t gone forever. You can

retrieve it by opening the recycler and dragging the file or folder back to the

2 Drag the file or folder File Viewer or any other folder window.

from the Recycler
window to a folder in

) ) Double-click the recycler to see its Drag the file or folder you want to retrieve
the File Viewer. _ contents in the Recycler window. back to the folder you want to put it in.
] _
3 Click the close button it : -
in the Recycler window. TR
Disk. r
View ™
Taols -
Windows I 2
Services ~ 4
-LH:;_EOQ(-‘_: Jui} Fild Viewer
& P
T |
2 ® ¢ g9
o Net creative Ve I '
: y el
()”‘\ vl ¥ 'i,‘"»
s lﬁ? Cm;lags CD Cover.nfd ///Févbal
Vi %2 & /[
o Fn;m Mom fax l%fy Mallnuxes//’/ my s\gna!re.nﬂ
)
2 ? 7/
Y I r—
A
@ From Pierre fax ‘8P 16go 1
L r_____
1

Recycler [— Click to clo.?‘e the
Recycler window.

You can only retrieve files or folders that you recycled since you last chose the
Empty Recycler command. ‘
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Handling several files and folders at once

Select the files or folders
you want to copy, move,
link, or delete.

Drag the selection icon to
a folder or the recycler.

Select more than one file or
folder as described in “Selecting
Several Files and Folders” in
Chapter 3.

If the Processes panel asks for

additional instructions, see
“Solving File and Folder

Problems” in this chapter.
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You can work with several files and folders at once—to move them all to

another folder, for example, or to put them all in the recycler. When you select
several files or folders, a selection icon appears in the icon path. You can drag
this icon to copy, move, link, or delete the selection of files and folders just as

you drag a single file or folder.

[w] File Viewer

grey - NextApps. .
227MB available on remote disk .

Drag the selection icon
to maneuver a selection
of files and folders.

R . FAT
| i
“ T Festival

!

BP logotit
: i}vf_gsﬁval g

an Mom fax

Catélﬁgs

S Library

. CD Coverdfd

s Mai)bo%és

The folder opens to
accept the selection.

If the folder doesn’t open, you don’t have permission to complete

the operation,



Managing several file operations

Choose Tools from the
Workspace menu.

Choose Processes from
the Tools menu.

Choose Background from
the pop-up list at the top
of the Processes panel.

Click the operation you
want to check.

if you want to halt the
operation, click Pause
or Stop.

Your computer can do several file operations at the same time. You can copy a
selection, compress a folder, and delete another folder, without waiting for any
previous operation to be completed. In the meantime, you can do something
else in the Workspace Manager or with any other application.

Your computer carries out most of the file operations described in this chapter
in the background—that is, behind the scenes where you don’t have to worry
about them. You can track the progress of an operation, or stop, or pause it with
the Processes panel.

Pro o X
Press here to choose Background.

'Background - ;'I

| {03 /Net/publicity/Press Rel /4 April |
o |[P) Neticreative/grey/F estival T
|3 /Nevereative/grey/ NeXT/.NextTrash/Copy

Click an operation in this list.

Shading in the circle shows
the percentage of the

@\— operation that's complete.

Click to stop the operation
— cOMpletely.

Copying 4 April

From: /Net/publicity/Press Releases
To: /Net/creative/grey/Festival
B Click to halt the operation and

swp | Pause Ll then click again to resume it.

Caution: Sometimes you need to make sure that a particular operation is complete
before you begin another. For example, if you're moving some files out of a folder
that you then want to delete, make sure the move is complete before you delete
the folder.

If you stop an operation that’s partially completed, such as a copy or move, any
file or folder already named in the panel is copied or moved. If you stop while
a folder is named, parts of the folder may be copied or moved.

95



Files, Folders, and Disks Chapter 6: Organizing Your Work

Solving file and folder problems

Sometimes when you’re working with files, the Processes panel may describe
a problem and wait for additional instructions before proceeding.

Processes

m This is the problem.

it

This is what you can do.

The options change for
/ each problem.
If you're working with

/ several files or folders, you
/ can check here to repeat

You can create a new link, skip this lihk, stap the entire /
operation, or copy the original. /
R ,.Bep,eatz(

L

instructions for all of them.

You can press this button to

g
- LA s stop the operation completely.

" New Link | skp T Stép«_]f

Here are some common messages and ways to respond to them.

One or several Click Merge to merge all folders in the selection with the existing folder of the same name.
folders already
exist at destination Click Replace to have all folders in the selection replace the existing folder of the
same name.
Click Proceed to decide for each folder. When you click proceed, you’re asked
whether you want to replace, merge, or skip each folder, one at a time (see
the message below).
File or folder Click Replace to replace the existing file or folder named in the panel. See “Replacing
already exists a File or Folder” in this chapter for more information.

Click Merge to merge the folder named in the panel with the existing folder. See
“Merging Two Folders” in this chapter.

Click Skip if you don’t want to replace the file or folder. When you’re copying or
moving a selection of files or folders, this button skips the one currently named
in the panel, but keeps copying or moving the rest of the selection.
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File or folder is a link

No room on disk

No room in recycler

Click Copy to create a copy of the actual file or folder the link points to. This copy is

not a link.

Click New Link to create another link to the file or folder.

Click Skip if you don’t want to copy the link. When you’re copying or moving a
selection of files and folders, this button skips the link currently named, but

continues with the rest of the selection.

Tip: You can choose one of these options for all links you copy with the
Preferences command. See “Setting Options for Copying Links” in

this chapter.

Remove files and folders from the disk you’re copying or moving to and click Proceed.
You can use the Inspector command in the Tools menu to see how much space
is left on the disk and the size of your selection. Then free the necessary
amount of space, return to the Processes panel, and click Proceed to complete

the operation.

Forideas on ways to free disk space, see “When You Run Out of Room on Your

Hard Disk” in Chapter 8.

Click Empty to empty the recycler. Any files or folders in the recycler are
permanently removed and then the operation continues.

The Repeat Box

When the Processes panel asks
how to handle one of several files
or folders in a selection, you can
check the Repeat box. Then click a
button to apply your response to
the entire selection.

For example, if the panel says a

file already exists, you can check
Repeat and click Replace to replace
all files with the same name as any
in the selection without being asked
about each one.

If the panel says that a file or folder
you're copying is a link, you can
check Repeat and click New Link
to copy all links as links. Or check
Repeat and click Skip if you don’t
want to copy any links in the
selection.

The Repeat option can carry out or
skip any of these actions: replacing
files, copying links, or merging or
replacing folders. It applies only

to the exact situation named in.
the panel.
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In the Workspace Manager, the Inspector panel gives you quick information about

Siles and folders—and some options for managing them. You open the Inspector

panel with the Inspector command in the Tools menu.

Image Inspector

e Viewer

? World. tlff§

e —

|BPlogo.draw
CDCover.draw
FmalCDCovertm’

|Keyhoard.mfd

. World tiff

Width: 610

" Height: 534




Getting information
about a file or folder

Previewing the
contents of a file

Sbrting files and folders

Changing the
application that
opens a file

Assigning a file or
folder to a new group

Changing permissions
for a file or folder

Inspecting Files
and Folders

A little information about a document. 'That’s all the
dame said she needed. How big was it? Who owned
it? And when was it last tampered with? The usual.
So here you are creeping around the corporate
archives. Past the Ps and Qs. Darn. It’s in a locked
glass case.

Back at the office you make a couple of phone calls,
call in a few debts. Finally you track down the owner
of the document. "Turns out it’s old Vinny Johnson.
Lucky for you, he owes you for breaking open that
spreadsheet caper last spring, so he sends a man
down to unlock the case.

Later you toss the document in front of her. She flips
through it, then looks up, smiling. Very good, she says.
[ must show this to my vice presidents. Uh-oh, that’ll be
extra. You’ll have to go back to Vinny for extra
permission. And Vinny has a thing against VPs—
ever since one pink-slipped his old man.
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Getting information about a file or folder

Choose Tools from the
Workspace menu.

Choose Inspector from
the Tools menu.

Select a file or folder in
the File Viewer.

Choose Attributes from
the pop-up list at the top
of the Inspector panel.

You can also get this information
in the File Viewer. See “Listing
Files and Folders” in Chapter 3.
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You can use the Inspector to get information about a file or folder—its size,
owner, and group, as well as its permissions and the last time it was changed.

Link To:
Size:
Qwner: starr e
: 7 Compute
* Group: repertoire Size
- -~ Permissions%,, - Changed -
Read | |
“Write 113
L Owner Group Other || 0~ gy

Do |16 e

Choose Attributes to get information
about the selected file or folder.

e [jle name

Path: /Net/publicity/Press Releases/s May===jmmm= Pathname

Click here to compute the
size of a folder.

Permissions show who can
open and change a file or folder.

Date and time the file or
e | folder was last changed

The size of a file appears automatically each time you inspect it. But you have
to compute the size of a folder if you’ve changed any of its files since the last

time you inspected it.

When a File Isn’t a File

In the File Viewer, you may see
things that look like files or folders
but really aren’t. These are either
links or file packages.

Links A link looks and acts like an
ordinary file or folder but is actually
a pointer to a file or folder
somewhere else in the system.
When you inspect a link, the
Inspector panel shows both the
pathname for the link and the
pathname for the file or folder it's
linked to. See “What Is a Link?” in

" Chapter 6.

File packages A file package is a

folder that looks and acts like afile. It
contains information that shouldn't
be separated, such as the text and
graphics files that make up a
document or the files that make up
an application. When you inspect a
file package, it looks like a folder—
you need to press the Compute :
button to compute its size. See “File
Packages—Files That Are Really
Folders” in Chapter3.



Previewing the contents of a file

Choose Tools from the
Workspace menu.

Choose Inspector from
the Tools menu.

Select afile in the File
Viewer.

Choose Contents from
the pop-up list at the top
of the Inspector panel.

You can get a quick look at the contents of a file without taking the time to
open the file and start up its application—to make sure it’s the one you want,

for example.

You use the File Inspector panel, which changes when you open different
types of files. For example, these Inspector panels show the contents of an
RTF file and a TIFF file:

Contents « a-\l

Emily Bright.rtfd

Path: /Net/publicity/Press Releases/s May

| around outside the backdoors of bars an
| She got her message from kids ike herst
{message is not what you might expect. |
| free meal or a dealer. They're lookingfr.;
- | butfor the planet. And Bright sings ther.{

|

__Emily Bright may have her roots in a bii
on the future. Her sound is soulful, dow
same time. This woman’s going to soar’

.l togetan old traditionmoving in a fresh.
e /’“ |
1 |

Reud [ o

oo

-

-«

L4
You can select text in the preview
of an RTF file to copy and paste it
in another document.

Click here to display the full

Choose Contents to get a quick
preview of a file.

‘Cantents d'

CD Cover.tiff

TIFF

Path: /Met/creative/grey/CD Cover.rtfid

R oy

CIT Zh 07w T4E 300

§ FAILY ERIGHT

Height: 344

Yidth: 344

TIFF image in the window.

Revert ‘if 'Diysplay\wﬁl

The Workspace Manager provides Inspector panels for inspecting several
types of files, including RTF (.rtf and .rtfd), EPS, TIFF, and sound (.snd)
files. If the application you’re using produces a different kind of file, it may
provide its own Inspector panel. If not, you can’t preview its files.
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Sorting files and folders

Choose Tools from the
Workspace menu.

Choose Inspector from
the Tools menu.

Open the folder you want
to sort in the File Viewer.

Choose Contents from
the pop-up list at the top
of the Inspector panel.

Click one of the sorting
options and click OK.

In the icon view, you can also use
the Clean Up Icons command
and the Sort Icons command
in the View menu to organize
your files and folders. See
“Workspace Manager
Commands” in the Reference
at the end of this book.
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The files and folders in the File Viewer and other folder windows are normally
listed alphabetically by name. You can change the order in any folder to list its
contents by kind, date, size, or owner.

Folder Inspector

S Choose Contents to see how
— e the contents of a folder are

e L LT currently organized.
fi« Press Releases =~ yorg
Fath: /Net/publicity
Sorthy —— -
: (. Name ;
b (CKind o f Then click one of these
1 Coae | options to change the way
oCsize 00 the contents are organized.
S Ciowner © o o :

e Click here to confirm the
sorting option.

i Revert '

Any change you make in the Folder Inspector panel applies only to the folder
that’s currently open in the File Viewer.
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Changing the application that opens a file

Choose Tools from the
Workspace menu.

Choose Inspector from
the Tools menu.

Select a file in the File
Viewer.

Choose Tools from the
pop-up list at the top of
the Inspector panel.

Click the application you
want to open the file.

Click Set Default.

For more information about
what makes a file and
application compatible, see

“Which Application Opens a
File” in Chapter 3.

When you open a file in the Workspace Manager, an application automatically
starts up at the same time. The application that starts up depends on the type
of file—that is, on its file extension. For example, when you open an RTF file,

Edit normally starts up.

You can use the Inspector to se

e which applications can open a file, to change

the application that starts up whenever you open specific types of files, or to
open a file temporarily in another application.

Tools

Choose Tools here.

TIEF| cD Cover. tiff

Path: /NeVcreative/grey/CD Cover.rfd

The highlighted application
isthe onethat currently starts

Doublu}c!ic%en selected documenks)

up when you open the file.
Click another to make it the
_ startup application.

Default: Preview
Path: /NextApps/Preview.app

Click ’Set Default’ to set default application
for all documents with this extension.

Set Default

= Double-click an application

to open the file temporarily
in that application.

e Click here to start up the
highlighted application
whenever you open the file.

Tip: You can also open a file temporarily in an application by holding down the
Command key and dragging the file icon from the icon path to the application

icon in the dock.
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Assigning a file or folder to a new group

Choose Tools from the
Workspace menu.

Choose Inspector from
the Tools menu.

Select a file or folder in
the File Viewer.

Choose Attributes from
the pop-up list at the top
of the Inspector panel.

Choose the new group
from the Group pop-up
list and click OK.

Forinformation about setting up
groups to share files and folders,
see your system administrator.
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The Workspace Manager helps groups of people work more efficiently by
sharing access to a set of files and folders. Every file and folder you create is
assigned to a group. If you belong to more than one group, you can reassign
files and folders from one group to another.

~ Attributes Inspector
. athributes
,k Choose Attributes here.

E,;Reactidn Reports

Path: /Net/repertoire/starr

) g : When you belong to more than one
LinkTo: * S LR group, you get a pop-up list here.

= Size:

staff
, (wheel "
_Group:| repertoire

“Owner:

You choose the group you want to
assign the file or folder to.

Click OK to confirm.

You can reassign only files and folders that you created.



Changing permissions for a file or folder

Choose Tools from the You can control access to individual files and folders that you create—and
Workspace menu. protect them from accidental changes—by setting permissions for them.

Choose Inspector from
the Tools menu.

Select a file or folder in G fracess
the File Viewer.

Check Read for
Choose Access Control permission to look at

- the contents of a file—
from the pop-up list or the list of files and ==

at the top of the folders in a folder.
Inspector panel.

===z The person who
A created the file.

Check the permissions <V Read| v [ | , Anyone in the group
P permission to ===write| v ]/x ]/x associated with the file.
%

VO:; v‘ll'aat(;l:(the grid change the contents Exeeute v /| v 7 ,
and clic . f a file or folder. / Owner Grolp Oth
ofafile orfolder. vner Brole | S Everyone else who has

/,,/A|so apply to files inside selection _[\ access to your file system.
Check Execute for sl \—— Click here first if you want

pern?iss{on to use : the new permissions to
applications or other apply to all the files and
program files. e folders in a folder.

Check Write for

Permission is granted when a checkmark appears in the appropriate square.
An X indicates that permission is denied. You can change permissions only if
you are the owner of the file or folder.

You can also set read and write permissions in the Attributes Inspector panel.
These permissions apply only to the current file or folder—not the files and
folders it contains.

Caution: Don’t change execute permissions unless you're an expert user. If you

uncheck execute permissions for an application, you may not be able to open any of

the files that use the application. If you uncheck execute permissions for a folder, you
Permissions affect many file or others may not be able to open any of the files in the folder.

operations. For an overview,
see “Permissions Granted” in
Chapter 6.

You can preset permissions for
any file or folder you create with
the Preferences application.
See “Setting Permissions for
New Files and Folders” in
Chapter 22.
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You usually store your files and folders on a hard disk in your computer or in
another computer on a network. But you can use floppy disks to make backup

copies of files and folders, for example, or to share them with people who aren’t on

Your network. You can also get new information and software from either a floppy
disk or a CD-ROM.

Workspace

Info

—
Edit

Disk
Wiew
Tools
‘Windows
‘Services
Hide
‘Log Out

‘Eject
Initialize...
'Check for Disks

Il Bl B! Bl

e|zl=zl=l7|7

5 ngk N‘am‘é: : , : : .

| File System:

Initializing the floppy disk will erast

Erase




©)
©

Inserting a floppy disk

Preparing a new
floppy disk

Creating a folder
window for a disk

Copying files to or
from a disk

Reusing a disk
Ejecting a disk

Opening and saving
files on a floppy disk

Working
with Disks

Someone once explained to you how computers

work. Little electrical signals you turn off and on to
create letters, numbers, pictures, even 3-D images.
All stored as infinitesimally small blips on something

" called a disk.

That’s great, but you just want to get a document
out of this computer and into that one or put it on a
separate disk. Or maybe you’re worried about
getting too many blips. And then you’ve got all
these choices—foppy disks, hard disks, disks called
CD-ROMs. Where to start?

You wander over to your stereo, pick out a CD, pop
a cassette in the tape deck to record on, and put

away a stray album. Then you sit back down at your
computer. Maybe this isn’t so complicated after all.
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Inserting a floppy disk

Slide the disk into the You can use a 3.5-inch floppy disk to store backup files or to move files from
drive, r.netal end first, one computer to another. The disk can be in Macintosh® format, DOS format,
label side up. or NEXTSTEP format.

Gently push the disk

until it clicks into place. (If
the disk appears in your
File Viewer, go to step 5.)

Choose Disk from the
Workspace menu.

Choose Check for Disks
from the Disk menu.

Click the disk on the File
Viewer's shelf or double-
click it in the current view
to open it.

On some computers, you have to choose the Check for Disks command
after inserting a disk to make the disk appear in your File Viewer. On other
computers, the disk appears in your File Viewer automatically.

If your Disk menu has the

Check for Disks command,
choose it to make the disk
appear in your File Viewer.

If a panel says that the disk

is unreadable, you have to

initialize the disk. See
“Preparing a New Floppy Disk”

in this chapter.

If your Disk menu doesn't
have Check for Disks, the
disk appears in your File
Viewer on its own.

Initialize..

For information on inserting a
disk while working in an Open
or Save panel, see “Openingand
Saving Files on a Floppy Disk”
in this chapter.

For more information about
how to insert a CD-ROM,

see the owner’s guide for your
CD-ROM drive.
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You can rename a floppy disk
that’s in NEXTSTEP format
just as you do a file or folder.
See “Renaming a File or
Folder” in Chapter 6.

When you insert a floppy disk and choose Check for Disks, the disk appears
in your File Viewer. On most computers, you have to choose Check for Disks

for the disk to appear.

File Viewer

" The files and folders on the disk become part of your file system. You can open
the disk to see its contents just like you open a folder.

The disk shows up
on your shelf, if
there’s room. Click

a

° BP Festival LocalApps LocalLibrary

NextAdmin NextApps NextDeveloper NextLibrary

p Nexthpps itto open it.
418 avallable on bard disk
| E e The disk is put in
T your root folder and
et y. has a name, just like
: i a file or folder.
g

RIS

You are the owner for all files and folders on any floppy disk that you insert.
You can work in all its files and folders and change their permissions.

What Disks Look Like

You can tell the type of disk by
its icon.

| A floppy disk

A CD-ROM

. A hard disk connected to

your computer
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Preparing a new floppy disk

Insert the disk in the Before you can use a brand-new floppy disk, you have to zzitialize it.
disk drive and choose Initializing a disk prepares it to store files and folders. When you insert a
Check for Disks from the new disk, a panel usually asks if you want to initialize the disk.

Disk menu.
Click Initialize.

Type a name for the disk
in the Initialize panel.

) Click to eject the disk without
Press the File System — initializing it.
button to choose a file

format.

= Click to continue.

If necessary, press the When you click Initialize, this panel opens:
Capacity button to

indicate the size capacity
of your floppy disk.

Click Erase.

Type a name for the disk here.

Press here if you want to choose
Macintosh or DOS format.

When dimmed, this value
indicates the disk’s size capacity.

Initializing the floppy disk vl erase It

1 cancel. | [ Erase ol Click to initialize the disk.

If you don’t name the disk, it has a temporary title, such as UntitledDis.

You should initialize a disk in Macintosh or DOS format if you want to use
the disk to copy files from your computer to a Macintosh or DOS computer.

On some computers, you must indicate the disk’s size capacity—for example,
whether it can hold 720 kilobytes, 1440 kilobytes, or 2880 kilobytes.

e If the value on this button isn't

720k v dimmed, you must press the

1a40k(HD) button and choose the capacity
2880k (ED) that matches your disk.
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Creating a folder window for a disk

Choose Info from the
Workspace menu.

Choose Preferences from
the Info menu.

Choose Disk Options
from the pop-up list in
the Workspace Manager
Preferences panel.

Click the “open new
folder window"” option
for removable disks.

Click an option for
fixed disks.

When you insert a floppy disk or CD-ROM in your computer, the disk
normally shows up on the File Viewer’s shelf, if there’s room. You can have
the disk open in its own window, instead.

A fixed disk you add to your computer, such as a hard disk attached to the
computer’s SCSI port, doesn’t normally show up on the shelf. You can select
to have it appear on the shelf, or to open in its window, too.

0 . er Preference R
_D'.s_kg_;m_m_._.; Press here to choose
Disk Options.
— When a removable disk is inserted... — -
(" place icon on shelfifthere is room
((: gglz:trli:;?ierw'”dt’w — Select an option here for
€ do nothing floppy disks or CD-ROMs.
— When afixed disk is encountered... — : -
" place icon on shelfifthere is room | Select an option here for a
C open newfqlderwindaw e o s i disk, such as an extra
(" selectthe disk ‘ hard disk you attach.
(" do nothing
Other Disk Options
You can select one of four options Open new folder window Select
for how removable disks show up this option to display the contents of
in your file system and for how the disk in its own folder window.

fixed disks show up. No matter
which option you select, you can
always find the disk to open itin
your root folder.

Select the disk This option selects
and opens the disk in the File Viewer
so its contents appear.

Do nothing This option simply puts
the disk in your root folder without
opening it or putting it on the shelf.

Place icon on shelf When this
option is selected, the disk appears
on the shelf, if there's room.
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Copying files to or from a disk

Select the files you want You copy files or folders to or from a disk just like you copy them between
to copy anddragthemto  folders. Select them and drag them where you want to put them. To move
the shelf. a selection instead of copying it, hold down the Command key as you drag,

Select the disk you want When you drag to a

to copy them to. Or if G — disk, it sparkles to
you're copying from a o B R accept the selection.
disk, select the folder you gy Newaps . KayasOik i\:\ i o I

Want to copy ‘them to_ ZJMETK My;»laonumcte(ﬁsk - — g - : - 8 N . } ..‘M,.N.' : o X

Drag the files from the e et E L l,gs E

shelf to the disk or folder.

T e T e

— — = he copy cursorF]
i ;ﬁi}“ ' ‘ i ;aﬁ : shows that you're
L Apps. BP logoif 1 catalogs | é C‘;PV’”Q instead
e e St : of moving.

S5 Llerary -

Mailboxes . i

Tip: The best way to work with a file on a floppy disk is to copy the file
somewhere else in your file system first and work in the copy. If you
want to change a file on a CD-ROM, you must copy it somewhere else in

your file system and then change the copy. You can’t change the contents
of a CD-ROM.

After copying files to a floppy
disk, you can eject the disk
and insert it into another
computer to transfer files to
that computer. See “Ejecting
a Disk” in this chapter.

For more information on
CD-ROMs, see the owner’s
guide for your CD-ROM
drive.
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DOS and Macintosh Disks

You can use a floppy disk to transfer files between a
Macintosh or DOS computer and your NEXTSTEP
computer. You can also connect any Macintosh SCSI
device—such as an external hard disk, CD-ROM, or
removable cartridge disk—to your computer and
access files on that device.

When you insert a DOS or Macintosh floppy disk into
your computer, or if you've attached a Macintosh
SCSI device, the disk appears in your root folder like
any NEXTSTEP disk. You can then copy files from the
disk to your file system.

If you want to transfer a file from your computer to
a DOS or Macintosh computer, you can initialize a
disk in DOS or Macintosh format (see “Reusing a
Disk” in this chapter). Then copy the files you want to
transfer onto the disk, eject the disk, and insert it into
the other computer. ’

Once a DOS or Macintosh disk is in your file system,
you can work with its files just as you do anywhere
else in the file system, with these exceptions:

* You don't set permissions for files or folders on a
DOS or Macintosh disk, but you can when you
copy them to your computer’s disk.

* You can't rename a DOS or Macintosh disk by
editing its name in the icon path. You have to name
it when you initialize it.

« You may need to rename a file before you copy it

from a DOS or Macintosh disk. Forinformation, see

“DOS and Macintosh Files” in the Reference at the
end of this book.

_File Viewer
Global An
A Macintosh
or DOS disk
appears in the
File Viewer
just like a disk
in NEXTSTEP
format.
‘Q‘
s
Ne}xpps NextDeAveIoper Neliibrary
Macintosh Macintosh Macintosh DOS
CD-ROM floppy disk floppy disk

SCSl disk

113



Files, Folders, and Disks

Chapter 8: Working with Disks

When a File ’or Folder Doésn’t Fitoh One Floppy Disk

114

If a file or folder is too large to fit on one floppy disk,
you can copy it onto several. To make a backup copy
of a 2-megabyte file, for example, you can copy it
onto two 1.4-megabyte disks.

Copy a single file or folder to a floppy disk as you
normally would. If what you’re copying is too big to
fit on the disk, a panel asks if you want to create a
multivolume file. When you click Yes, the Workspace
Manager copies a “chunk” of the file or folder onto
the disk. When the disk is full, a panel asks you to
remove the disk from its drive and insert another one.
After doing this, click Proceed in the panel. The
Workspace Manager copies the second chunk.
Repeat this for as many disks as needed.

To copy the file or folder from the disk back into
your computer, insert the disk containing the first
chunk—a file with a .chunk extension. Drag the

.

B P_mcesses
‘Background - %il s

|IF] /Net/creative/grey/Festivall

Alert [

There is no room on disk for Festival

Do you wantto create a compressed, multi-volume file?

10.368h

To copy the file or folder back to the computer, ——/

chunk to the folder you want to put itin. When a panel
asks for the next chunk, remove the disk, insert the
next one, and click Proceed. Repeat this until you've
copied all the chunks. Make sure to copy chunks in
the order they were originally copied. If you insert a
disk in the wrong order, just remove it and insert the
correct one before clicking Proceed. After you copy all
the chunks, you can open the file or folder as usual.

You can copy only one file or folder in this fashion at
atime. To copy more than one, put them all in a folder
and copy that folder.

The Workspace Manager compresses a file or folder
before it copies a chunk onto the floppy disk.
Sometimes this makes the file or folder fit on one
disk, in which case the Workspace Manager doesn't
request an additional disk after all.

When a file or folder is too large to fit on the
floppy disk, the Processes panel asks if you
want to copy it onto several floppy disks.

Click Yes. The Workspace Manager divides
e the file or folder into chunks.

insert the disk that contains the first chunk
(numbered zero), and drag the chunk to the
folder you want to put it in.

A chunk has a .chunk extension and looks like
this in the File Viewer. .




Reusing a disk

Insert the disk in the
disk drive and choose
Check for Disks from
the Disk menu.

Select the disk in the
File Viewer.

Choose Initialize from
the Disk menu.

Choose a file format in
the Initialize panel and,
if necessary, indicate

the disk’s size capacity.

Type a new name for
the disk.

Click Erase.

You can erase a disk and change its format by reinitializing it. Just select the
disk (or any file or folder on it), and choose Initialize. You can initialize any disk
whose contents you can change, such as a floppy disk, an external hard disk,

or a removable cartridge disk.

Caution: Initializing a disk destroys all files and folders on it. They cannot

be retrieved.

When you choose Initialize, this panel opens:

-

@ Initialize Floppy

You can type a new name

= for the disk here.

DiskName: {Creativean @

|
File System: - NeXT K

L
Capacity:  2850k(ED) n__ |

Press here if you want to
m— chOOSe another format.

When dimmed, this value

Initializing the floppy disk will erase it.

Cancel l Erase C"“i‘

indicates the disk’s size capacity.

r——— C|ick to erase the current

contents of the disk.

You can give the disk a new name when you initialize it. If the disk is in

NEXTSTEP format, you can

also rename it later by editing its name in the

icon path (just like you rename a file or folder).

On some computers, you must indicate the disk’s size capacity—for example,
whether it can hold 720 kilobytes, 1440 kilobytes, or 2880 kilobytes.

720k l

If the value on this button isn't
dimmed, you must press the

1440k (HD) b
2880k (ED) kAl

button and choose the capacity
that matches your disk.
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When You Run Out of Room on Your Hard Disk

You should normally have plenty of roomonthe hard <
disk in your computer for all your work plus the
software you're using. But if you do run short of

space, here are some ways to free some up.

* Delete personal files that you don't need anymore.
You can use the Inspector command to find out
which are particularly large. See “Getting
Information about a File or Folder” in Chapter 7.

» Empty your recycler. Remember that dragging files
to the recycler doesn’t remove them from the disk.
You have to open the Workspace Manager File
menu and choose Empty Recycler to do that.

» If you receive electronic mail, compact all your
mailboxes. See “Compacting a Mailbox to Free
Disk Space” in Chapter 14.

Quit any running applications that you don't
immediately need to use.

If you haven't restarted your computer in a few
days, try doing so. This frees space that, over time,
can get filled with files the computer uses only
temporarily. ’

Use the Compress command in the File menu to
compress files or folders you aren’t using.

If you installed software in your computer from the
NEXTSTEP CD-ROM, you might not need all the
software. If so, you can compress or delete some of
it to free disk space. See Chapter 19, “Installing
New Software.”

- If your needs for disk space have grown, you can

also add space by connecting an external hard disk
to your computer or by getting a larger hard disk.

The File Viewer shows the amount

& 3ME availahle on hard disk of space available on the disk that

contains the current selection.

If a panel warns that your
available disk space is low, you
‘must quit applications or restart
the computer. If you don't, you
may soon have problems such
as not being able to save work

or send Mail messages.

: ou're” r'unn:ing low on disk space. You may want to
quit-a few applications or restart your computer to.




Ejecting a disk

Select the disk you
want to eject.

Choose Disk from
the Workspace menu.

Choose Eject from
the Disk menu.

When a message asks
you to eject the disk,
remove the disk from the
computer’s disk drive.

A floppy disk is automatically
removed from your file system
when you log out, turn off the-
computer, or restart it.

See “Ending Your Work
Session” in Chapter 1.

You can also eject a disk while
working in an Open or Save
panel. See “Opening and
Saving Files on a Floppy Disk”
in this chapter.

When you’re done using a removable disk, such as a floppy disk or a
CD-ROM, you choose Eject to remove the disk’s contents from the file
system. Only after you choose Eject and see the message asking you to
eject should you actually remove the disk from the drive.

Select the disk (or any file or folder on it). Choose Eject.
Info r{ Eject e
File v [ Initialize..."
1

Edit - | Check for Disks

Creative Art

Disk ~
View I
Tools ’
Windows ~
Services I
h
L]

1 Hide

- - Log Out
" @

- { Creative Art ¢ LocalApps Localtibrary Net

;"",\ (}q tf e

. 155 .

[ﬁ%?ﬁi Lﬁ?p QE ;
NextAdmi NextApp: NextDeveloper NextLibrary

2
v i

Caution: Don’t remove a floppy disk from the disk drive before a message says to,
or else you might lose information from that disk or from the next one you insert.

On some computers, a disk ejects from its drive automatically after you
choose Eject.
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Chapter 8: Working with Disks

Opening and saving files on a floppy disk

When an Open or Save
panel is open, insert the
disk you want to open
from or save on.

Click the disk button in
the panel.

Select thefile you want to
open, or type a name for
the one you're saving.

Click OK in the panel.

For information on opening
and saving files in general,
see Chapter 5, “Creating and
Saving Files.”

The disk and eject buttons in
an Open or Save panel do the
same thing as the Check for
Disks and Eject commands
in the Workspace Manager’s
Disk menu. See “Workspace
Manager Commands” in

the Reference at the end of
this book.
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"To make it easy to open and save files-on a floppy disk, you can insert and eject
disks while working in an Open or Save panel.

|| EEESTRE restival B |

M‘%ﬂ val [ Blaue Reiter.tiff
. llLocalAdmin [ BP Logo tiff . .
e [ICocalapps ~ CD Covertiff Insert a disk and click here to open
Net ~ Eva Distze tiff the disk in the browser. Click the
¢ JINextAdmin " Sprechttift i button after browsing to locate and
| Nextapps r e e SEECL the disk again.
A NexiDeveloper - I i : 9

NexdLibrary,

Click here to remove a disk from the
file system so you can safely eject it
and insert another one.

Caution: Don’t remove a floppy disk from the disk drive before a message says to,
or else you might lose information from that disk or from the next one you insert.

You can use the disk and eject buttons to open and eject a floppy disk, a
CD-ROM, or any other removable disk.

When you have more than one removable disk in your file system, clicking the
disk button repeatedly selects the next disk. To eject a particular disk when
more than one is there, you have to select the disk or a file or folder on it, and
then click the eject button.

Tip: You can browse several disks, one after the other, in an Open or Save
panel. Just insert a disk and click the disk button. Then after browsing, click
the eject button, remove the disk, insert another one, and click the disk
button again.
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For most applications you use, you need to know how to type and edit text. In
addition, your NEXTSTEP workspace comes with an application that’s
specially designed for creating rext documents. It’s called Edlit, and you'll find it in

the [NextApps folder.
Bl FontPanel
Tines Roman 14.0 pt. |
 |[Courier e
Helvetica Festival Release.rtfd — /MNet/publicity/Press
| isymbol I
- |[Times , i
' In 1990, jazz and blues legends at the Blue Flanet F
claimed the "90s as the decade of the Earth,
In 1991, record crowds swarmed the Berlin Wall in
music gathering in recorded history.

Nowz, in 1994, over 3 million people are expected tc
afive-day extravaganza in Washington, D.C. when

Biue Planet Productions presents:

THE THIRD ANNUAL BLUE PLA

“We are the Eari

JAZZ & BLUES HERITAGE FEST

On the Mall in Washington, D.C' + September 17-2

Featuring: Queen of the torch light, Betty James +
Francois de |a Patisse + Big Daddy Jordan and his
Caccitore et il suo Jazz Italiano + Saxophone virtuos
As well as new Blue Planet artist Emily Bright, Dido E
of our planet’s best jazz and blues superstars.




Starting up the Edit
application

Typing text

Selecting text
Deleting and replacing
Moving and copying
Finding text

Replacing text that
you find

Typing special
characters

Previewing special
characters

Setting a new font
Previewing a font

Setting margins,
indentation, and tabs

Checking your spelling

Typing and Editing

You think back on typing class in school and laugh.
You used to get in trouble for typing off the bottom
of the page. And for staring out the window.

You remember daydreaming of a better way to get
your thoughts down. A giant page where words

- would appear as you thought them. Your thoughts

could move the words around, too, and make them
go away or put them back. You could even make
them bigger, smaller, or just plain different.

The teacher tapped you on the shoulder and
pointed to your page. The dropped W’s weren’t
your fault. Oh, you misspelled a word. You fumbled
with Liquid Paper®and typed the correction.
Looking back out the window, you wished someone

 would invent a machine that could transcribe

your thoughts—or at least keep up with them.
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Starting up the Edit application

» Double-clickthe Edit = = 'The Editapplication is a tool for creating formatted documents. You can start
icon in the dock. up Edit with its icon in the dock or by opening an RTF file (one with an .rtf
Or or .rtfd extension) from the File Viewer.

» Double-click an RTF file.
Or

» Open the /NextApps
folder in the File Viewer

and then double-click
Edit.app.

Edit application icon .rtf file icon .rtfd file icon

You create an Edit document in a document window. When you start up Edit
from the application dock, a new, empty document window appears. You can
also open a new window by choosing New from the File menu.

UNTITLED.AT — ~ [X] A new Edit document
is untitled. You name
the document when
you first save it.

For information on naming an
Edit document, see Chapter 5,
“Creating and Saving Files.”

You can add color or graphic
images to a document. See
Chapter 10, “Working with
Color,” and Chapter 11,
“Working with Graphics.”
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Typing text

Click in the window

where you want to type.

Type without pressing
Return at the end of
each line.

Press Return to end
each paragraph.

Click elsewhere to
continue typing there.

You enter text in a document or text field by typing on the keyboard. As you
type each character, it appears in the key window at the insertion point.

i@ Festival Release.rtfd — /Het/publicity/Press Releases/s May > The cursor

- usually becomes
PO Box 334578 an I-beam when
San Frongo LAZAIE you can enter text.

Eﬁ Blue Plunet Productions

In 1990, jazz and blues legends at the Blue Planet Festival’s Paris debut
claimed the "90s as the decade of the Earth,

In 1991, record crowds swarmed the Berlin Wallin the largest peace and
music gathering in recorded history.

Now, in 1994, over 3 million people are expected to gather once again for
afive-day extravaganza in Washington, D.C. when..,

The insertion point
Blue Planet Productions presents] moves forward as

you type.

= —— - T

"To move the insertion point and select a new place to type, click where you
want the text to appear.

The insertion point
appears where

crowds swarmed the Berlin Wall in the larges]

gathering in recorded history. " youclick
crowds swarmed the Berlin Wall in the largest peace Textyoutypeis
. o . inserted, and lines in
and music|gathering in recorded history. the paragraph adjust
N to make room for it.

You can also move the insertion point with an arrow key on the keyboard.

The up or down
arrow key moves
it up or down.

Press the left or right arrow
key to move the insertion
point to the left or right.

You don’t have to press Return to end a line as you do on a typewriter.
Applications automatically break lines between words (a process known
as word wrap). You only press Return to cut a line short, as when ending
a paragraph.
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. 'Keybo‘ard, Ba‘s'ics‘ i
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Most keys on your keyboard are labeled with letters,
numbers, punctuation, or other symbols that the
keys generate when you press them. You hold down
the Shift key to get uppercase letters or the upper
characters on keys labeled with two characters. The
space bar inserts an invisible space character.

When you hold down a key, the character repeats
itself. You can use the Preferences application to
adjust the repetition speed. See “Setting the Rate
for Repeating Characters” in Chapter 21.

You press Return to end a paragraph. In some panels,
pressing Return operates a button.

On most keyboards, you can press Caps Lock to then
type uppercase letters without holding down the
Shift key. To turn Caps Lock off, press the key again.

You can press Tab to move to the next tab stop in a
document or the next text field in a panel. Sometimes
holding down Shift while pressing Tab moves in the
reverse direction—for example, to the previous field
in a panel.

USA keyboard arrangement

To delete text, you can press the Backspace key,
which backs up over text one character at a time.

Two keys to the left and right of the space bar—
usually labeled “Alt”"—work as your Command key
and Alternate key, respectively. Several uses for
these keys are given throughout this book.

The numeric keypad provides a convenient way to
enter numbers and do calculations. There's no
difference between typing the same character here
and on the main part of the keyboard.

Finally, if you type when there’s no key window or
if the key window doesn’t accept typing, the
computer beeps so you know that your keystrokes
aren't doing anything.

If you're using the NeXTUSA keyboard arrangement,
your Control, Alternate, Command, and Escape keys
are in a different place. You also get keys for adjusting
screen brightness and speaker volume, and for
turning off the computer. See “The NeXTUSA
Keyboard Arrangement” in Chapter 21.

Tab moves to Shift types uppercase
the next tab stop Turns Caps letters or the upper Backspace Provides a convenient
Lock on or off character on a key. deletes text.

Escape or text field.

way to type numbers

o0

4t
N
h

[J

[J

ao

EEEEl

B —

0 o o

[ o o o o o ) O

i (T () _ 0 [ E |

gl ~i;»‘f‘,",' s e l el ’ e

Control, often ~ This is ybur Inserts a space This is your Return ends Repositions the
Alternate key.. a pa(agraph. insertion point’

labeled “Ctrl” © Command key.  character:




Selecting text

Drag across the text you
want to select.

Or

Hold down the Alternate
key while clicking to
select a range between
the insertion point and
where you click.

Or

Double-click a word to
select it.

Or

Triple-click anywhere in
a paragraph to select the
whole paragraph.

To edit text, you usually select it first. Your next action, such as choosing the
Delete command, acts on the selection.

One way to select text is to drag across it. Drag horizontally to select text on
the same line or vertically to select several lines of text. You can even drag past
the edge of your view—for instance, past the bottom of an Edit window—to
scroll the window’s contents and keep selecting,.

Selected text is
highlighted in gray
so it stands out.

over 3 million people are expected to gather once
again for a five-day | blowout In Washington, D.C.

The Alternate key is useful for selecting large amounts of text. You can even
scroll beforehand to select more than is currently displayed.

B s 33678 PO Bax 324578 /
Lan hurxisco, (A $4105 Son Froncasco, LA 94105
,( ;-m

[ N._.‘\L._ Blue Planst Productions [. _a""v.....\ Blue Plunet Productions

Festival Release.ntfd — felpwbicity/Press Releasests May

# Now,in 1994, over 3 milion people. are eXpected to gather ance again for
1 8 five-day exravaganza in Washington, D.C, when..

Now, in 1994, over 3 milion pecple are expectedto gather once sgainfer |
2 Bve-day extaveganzain Weshingron, D.C, when... J

Blue Planet Froductions peesents N

Blue Plaet Froductions presents:

THE THIRO ANNUAL BLUE PLANET

“We are the Earth”

JAZZ & BLUES HERITAGE FESTIVAL

— -

On the Mall i Washington, DL - September 17-2]] | Onthe MaltinWashington, D + Scptember 17:21

|
THE THIRD ANNUAL DAE PLANET i
w
’ ‘We are the " ’
JAZ2 & BLUES HERITAGE FES DA
i
i
i
| foaturm: Guaanate hlch \ight, Belty James » Masar o he 2
| Francols dela Patis ‘Jordan snd hia Trumpeteers + Emilio
H mcmn etil suo J:n i\al»ane saapmm- ViriG$0 Bornardt Sechy, 1,..d
and scores more

Featuring: Gueen of the torch liht, Betty James ~ llaster ofhe 88's
Francois de la Patisse + Big Daddy Jordan and his Jumpeteers + Emilio
Caccitore stil suo Jazz faliano « Saxophone virtuos fBerhardt Sprecht «
As wel as new Blua Planet artst Emity Bright, Dido Esfvan, and scores more
of our planet’s bestjaz2 and biues superstars.

4]
<

avvawmn bestjazz and bluss iupenlall

TN

What is Dlue Planet all about? Whatis Blue Planet all abou(?

e decades g e st e e s nd s s

Lo wound the world, BP foindes sought to showease this gres fuusical
Lertage to the wodd. They tiso shared 2 drear thot many cfthe fists
express i their music-the desice for b Ceaner, safer, heckhier jfnet. K

You can Alternate-click again to
extend the selection (or shorten it).

pter desedes tproticing e of e grecen | nd st wes
decs b Py

sh
express I theirm desefor o cemmer. 3 |, neskhier oner

\

Click here and
then scroll.

Alternate-click to
select to here.

If you select text by double-clicking or triple-clicking, you can drag before
releasing the mouse button the final time to extend the selection by a word
or paragraph at a time. If you then Alternate-click, the selection is extended
to the next word or paragraph boundary.

Tip: In an Edit document, you can select text and any surrounding delimiters,
() {}, [1, or «». Just double-click one of the delimiters.
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Deleting and replacing

To delete text as
you type, press the
Backspace key.

To delete a block of
text, select it. Then
choose Delete from
the Edit menu or press
the Backspace key.

To replace text, select
it. Then type the
replacement text.
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Pressing the Backspace key as you type backs up and deletes characters one
at a time. When text (or a graphic image) is selected, the Delete command in
the Edit menu and the Backspace key on the keyboard do the same thing—
they delete the selection.

over 3 million people are expected to gather once Press Backspace to
: T ; delete the selection.
again for a five-day blowoutin Washington, D.C.

over 3 million people are expected to gather once Or enter text to
. e y replace the selection.
again for a five-day extravaganza|in Washington, D.C.

When you delete a word that you selected by double-clicking, spacing is
automatically adjusted around the remaining words. For instance, if you -
double-click the word automatically in the first sentence of this paragraph
and then delete it, one space remains between Zs and adjusted instead of two.



Moving and copying

Select what you want to
move or copy.

Choose Edit from the
application’s main menu.

Choose Cut to move the
selection or choose Copy
to copy it.

Put the insertion point
where you want the
selection to appear.

Choose Paste.

You can move and copy text with the Cut, Copy, and Paste commands in the
Edit menu. In applications where you work with graphic images, you can
typically copy and move them, too.

Choosing Cut removes the current selection and places it on the pasteboard—
the computer’s holding place for information you’re transferring from one
place to another. Choosing Copy puts a copy of the selection on the
pasteboard. The Paste command inserts the contents of the pasteboard at
the insertion point, or if you selected text, in place of the selection.

After decades of producing from around the world g;‘;gt"gspy the
some of the greatest blues and jazz artists, o
After decades of producing some of the greatest Move the

blues and jazz ;3_rtistslJ insertion point.

After decades of producing some of the sreatest

: . Paste the selection.
blues and jazz artists ffom around the world)

You can paste text anywhere you can type—somewhere else in a document, in
a text field, even in another application. Just click where you want the text
to go.

A selection stays on the pasteboard until you replace it by choosing Cut or
Copy again. You can therefore keep choosing Paste to paste the same selection
over and over.

When you paste a word that you cut or copied after double-clicking it, spacing
is adjusted around the pasted word.
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Finding text

Choose Edit from the
application’s main menu.

Choose Find from the
Edit menu.

Choose Find Panel from
the Find menu.

Click in the document
you want to search.

In the Find panel, enter
the text you want to find.

Click the Next or
Previous button.

Commands in the Find menu
provide other ways to search
for text. See “Standard
Commands” in the Reference
at the end of this book.
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You can search for a string of text in a document, such as an Edit document or
a Mail message you’re composing. You do this with the Find panel.

Enter what you

want to find here. s

N
¥

. Find:[planet

Erestival .R%Ie%eﬁﬁ

Replace With:[ i
[ Replace All Scope 4| ——
(C\Entire File
(" Selection

En Find OpﬁOI’lS S
yfignore Case
<1 JRegular Expression

Blue Planet Productions] i oo Srtre P
'Replace All I .Replace I‘jReplace &|Find I‘:Prexiaus i Next C’l
THE THIRD ANNUAL BLUE PLANET \\
T ” Click to search
We are the Earth forward or backward
JAZZ & BLUES HERITAGE FESTIVAL from the insertion
point or selection.
On the Mallin Washingron, DC - September 17-21 N\ The Find panel

Featuring: Queen ofthe torch light, Betty James + Master ofthe 88’s
Francois de la Patisse + Big Daddy Jordan and his Trumpeteers « Emilio
Caccitore et il suo Jazz Italiano + Saxophone virtuoso Berhardt Sprecht «
As well as new Blue Planet artist Emily Bright, Dido Estevan, and scores more

of our planet’s best jazz and blues superstars.

‘What is Blue E@g{qa]l about?

remains the key
window so you can
keep searching for
text by clicking a
button in the panel.

When text is found,

After decades of producing some of the greatest blues and jazz artists
from around the world, BP founders sought to showcase this great musical

it's highlighted in
the main window.

SR

You can search for any sequence of characters in the standard text character set,
including spaces. In some applications, you can also search for characters such
as tabs and returns. '

Find Options in Edit and Mail

The Find panel in Edit and Mail has
these options for searching for text:

Ignore Case Uncheck the Ignore

‘Case box to distinguish between

upper- and lowercase letters during
the search—for example, to locate

“Planet” but not “planet.”

Regular Expression Checkthis boxif
you want the Find panel to recognize
UNIX regular expressions, which are
described in the UNIX manual page
for ed. Manual pages are available
on-line in the extended configuration
of the software.



Replacing text that you find

Choose Edit from the
application’s main menu.

Choose Find from the
Edit menu.

Choose Find Panel from
the Find menu.

Clickinthe document you
want to search.

In the Find panel, enter
the text you want to find

and the replacement text.

Click the Next or Previous
button.

Click a replace button.

Replace with:| superstars

Replace All Scope ~ Find Options
" Entire File Zlignore Case
__|Regutar Expression

Find

Type the text you want to

Find:Jstars ¢

replace here.

(" Selection

you find text to replace it.

Replaﬁ:/e All l 'Repface | Replacg& Find | ‘Previous I Next <""|

Tip: You can delete one or more occurrences of text you’re searching for by
leaving the “Replace with” field empty and clicking a replace button.

Replace Options in Edit and Mail

The Find panel in Edit and Mail
has several options for replacing
text you find. In Mail, these options
apply only for a message you're
composing.

Replace Click this button after

finding an occurrence of text to

replace it with the text in the
“Replace with” field.

Replace & Find Click this button to
replace the current occurrence and

find the next one, all in one motion.

Replace All You can use the
Replace All button to replace all

occurrences of the text you're
‘searching for. Replace All can apply
to the entire document or to a
selection only, depending on the
setting under Replace All Scope.

Entire File If you set the Entire File
option under Replace All Scope,
Replace All replaces all occurrences
in the document.

Selection You can select a portion
of a document and set Selection
under Replace All Scope. Clicking
Replace All then replaces only the
occurrences.in the selection.

In some applications, including Edit and Mail, the Find panel provides easy
ways to replace each occurrence of text you find with another string of text.
You can replace occurrences one by one, or you can replace them all at once.

Type the replacement text here.

Click one of these buttons after

129



Text and Graphics

Chapter 9: Typing and Editing

Typing special characters

To type a special
character, hold down
the Alternate key—
and the Shift key, if
necessary—and type
the character.

To type an accented
character, type the
accent. Then type
the character.

To find out which is your
keyboard’s Alternate key,
see “Keyboard Basics” in
this chapter.
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You can type an entirely different set of characters than those labeled on
your keyboard. You get one set of characters by holding down the Alternate
key as you type. You can get another set by holding down the Alternate
and Shift keys as you type. For example, type Alternate-2 to get T, or type
Alternate-Shift-2 to get .

You can hold down the
Alternate key with or
without the Shift key to
typecharactersthataren’t
:i: labeled on the keyboard.

Some special characters are accents that are meant to appear above or below
another character. When you type an accent character, you don’t see it. But the
next character you type appears with the accent.

Type this accented character by
typing Alternate-u followed by o.

If you want the accent by itself, type the accent and then press the space bar.

If Caps Lock is on, typing a character with the Alternate key is the same as
holding down Alternate and Shift when Caps Lock isn’t on.



-
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Previewing special characters

Start up the Preferences
application.

Click the button for
Keyboard Preferences.

Click the Keyboard
Panel button.

Press and hold down the
Alternate key, with and
without the Shift key, to
see which characters you

can type.

To find out which is your
keyboard’s Alternate key,

see “Keyboard Basics” in this
chapter or “The NeXTUSA
Keyboard Arrangement” in
Chapter 21.

Some characters that you type
with the Alternate key belong
to the Symbol font family. See

“What Is a Font?” in this chapter

and “Special Characters” in
the Reference at the end of
this book. “Special Characters”
also shows which characters
are accents.

See also “Starting Up the
Preferences Application” in
Chapter 20.

To find out what each key produces when you hold down the Alternate key, or
the Alternate and Shift keys, you can use the Preferences application.

S S— Keyboard Preferences

T button

Initial Key Repeat -
-l ] .a I .a I a |

Key Repeat Rate

awa | awa | aa | aa |

| Type here to test setting I

‘**Kgysag;a’;;n;.f.}‘ﬁ% Click to open the
Keyboard panel.

Press the Alternate key Labels in the panel
on your keyboard. Then change to show which
hold down Shift, too.

characters you can type.

I Keybnard )

e yPE here to preview
| _setFont | a character.

You can also click the Alternate or Shift key in the Keyboard panel itself to
display the alternate characters. Click the key again to deselect it.
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Setting a new font

Select the text whose
font you want to change,
or click where you want

to type text in a new font.

Choose Format from the
application’s main menu.

Choose Font from the
Format menu.

Choose Font Panel from
the Font menu.

In the Font Panel, select
the font family, typeface,
and size you want.

Click Set.

You can also set font properties
by choosing commands such
as Bold or Italic from the

FFont menu. See “Standard
Commands” in the Reference
at the end of this book.

In some applications, the
Font command is in the main
menu. See the user’s guide
for the application.

See also “What Is a Font?” in
this chapter.
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You can give text in a document a different look by setting its fon#—changing
its font family, making it bold, making it three points larger, or making
all these changes at once. You use the Font Panel. The new font applies to text
you’re about to type at the insertion point or text you select.

Select a font family by clicking it in this column.

In this column, select a typeface in the
selected family.

Type a size for the text in the text field —
decimals are okay—or click a size in the column.

Click this button to apply your selections
to your document.

siipd
Or click this button to undo selections
- — : = ; you‘ve made in the panel.

Type + or - before a size value
to increase or decrease each
character in the selection by
a certain number of points.

You can double-click a font property to set it without clicking Set. For
example, double-click 12 in the Size column to make your selection 12 points.

The top of the Font Panel usually displays the current font—the one you’re
about to type at the insertion point or the font of text you select.

' 1 The current font appears against
Times Bold 18.0 pt. | awhite background.

If you select text that contains more

S e sredie : : > than one font, the top of the panel
- <<Multiple Font Selection>> 1 Jooks like this.




You can apply one font property to a selection without affecting other
properties. For example, you might select:

Third Annual Blue Planet
We are the Earth

"This selection uses more than one size and typeface. If you set its size
to 11 points, the whole selection appears in 11-point but the typefaces
stay the same:

Third Annual Blue Planet
We are the Earth

If you set a family but not a typeface, for example, by double-clicking the
family in the Font Panel, a matching typeface in the new family is set

automatically. Changing the above example to Helvetica®, for example, makes
it look like this:

Third Annual Blue Planet
We are the Earth

If a matching typeface isn’t available, setting the family but not a typeface has
no effect.

Fonts and Special Characters

When you work with symbols and
graphic characters that aren't
standard text characters, you can
change the font family of standard
characters in a selection without
affecting the other characters. Just
don't set a typeface.

For example, if you select

“© Blue Planet,” which is in the
Helvetica font family, and then
double-click Times® in the Font
Panel, the standard characters
change to Times and the © remains,

as in “© Blue Planet.” If you similarly
change “The value 2" from
Helvetica to Times, the standard
characters assume the new font -
but the © remains. If you instead
set a typeface in either of these
examples, the © or t changes to

its equivalent standard character—
here,acorap.

Some special characters, including
7, are actually members of another
font family. See “What Is a Font?”
in this chapter.

133



Text and Graphics

Chapter 9: Typing and Editing

WhatlsaFont?

134

A font is a set of properties—font family, typeface,
and size—that determine what text looks like.

A font family is a collection of characters with a
consistent design. Families that come with your
computer are shown below. As you can see in the
table, most families contain standard text characters.
Some families, however, have symbols or graphic
characters. The Symbol family, for example, has
letters from the Greek alphabet and mathematical
symbols.

Unlike other families, the characters in the Courier
and Ohlfs families all have the same width. Ohlfs is
used to display text on the screen—when small, itcan
be easier to read than Courier. When you print Ohlfs
text, however, it appears on paper in Courier.

A typefaceis a variation of a font family, such as Bold, '
Italic, or Bold Italic. Each family has its own set of
typefaces. . :

The size of text is measured in points: A point is 1/72
of aninch. Point size is relative within a font family, so

11-point Times is larger than 10-point Times but looks o

smaller than 11-point Helvetica.

All characters—even spaces—have a font. If you put
the insertion point after the space between two
words and start to type, the text appears in the same -
font as the space character (which may not be the
font of any neighboring text character).

The fonts shown below come with your computer.
You can purchase others to add to this collection.

Font Family Example

Times This family is popular for memos, letters, or other documents.
Helvetica This family is often used for headlines or headings.
Symbol N2+200™Q

Courier This is a standard typewriter family.
Ohlfs This family appears only on the screen.




Previewing a font

Choose Format from the
application’s main menu.

Choose Font from the
Format menu.

Choose Font Panel
from the Font menu.

In the Font Panel,
select the fontyou
want to preview and
click Preview.

Replace text at the top
of the panel with text
you want to preview.

Delete text you entered
to display font names at

the top of the panel again.

You can see what a font looks like before you actually apply it to your
document.

et .
Times Bold 18.0 pt. The previewed font appears here.
"I typetace | size
- |Courier “{Roman T RE IB]“C Planet
|Helvetica “ltalic T Pt I I_ -
H PR sl M 9 - I R
-Ts—iyn;me%ﬂ-——-———-’ - olaitalic el 10 You can type to preview your own text.
merr et B i "o Delete it when you're through.
) 12 -
H ] 14
| el 18
o 1Al 18 | i i
. P Click to preview the font you selected.
o [ S . .
© Revert \J i Preview l ©oSet ¢F | Click to undo your selections and return

- - : settings to the current font.

If you hold down the Shift key while clicking the Preview button, the
button remains highlighted until you Shift-click it again. While the button
is highlighted, each selection you make in the Font Panel is previewed at
the top of the panel. '
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Setting margins, indentation, and tabs

Choose Format from the
application’s main menu.

Choose Text from the
Format menu.

Choose Show Ruler
from the Text menu.

Drag the left and right
margin markers to set
the margins for the
entire document.

Adjust tab and
indentation markers
to format individual
paragraphs.

You can use commands in the
Text menu to align text in a
paragraph and to copy and paste
ruler settings. See “Standard
Commands” in the Reference
at the end of this book.

The location of the Text
command may vary for some
applications. See the user’s
guide for the application. -

136

In many applications, you can use a ru/er to alter margins, indentation, and tab
stops. The ruler is initially hidden, but you can make it appear in a document
window with the Show Ruler command.

T SRR S S S GEE S N i 1 ]—Ruler
LR D AN AR AR LR RS DR R RN T
What is Blue Planet all about?

After decades of producing some of the greatest blues and jazz artists
from around the world, BP founders sought to showcase this great musical
heritage to the world. They also shared a dream that many of the artists
express in their music—the desire for a cleaner, safer, healthier planet.

Indented paragraph
+ Proceeds from the 1990 festival funded plans for desalinizaton plants
on the California coast, education programs for inner-city youths in five
cities, and a Tokyo-based research center for altermative power sources.
: Text placed at a
hs » Proceeds from the 1991 festival protect endangered species in Alaska tab stop

and Canada, fund a project to regenerate the South Americanrain
forests, and provide environmental scholarships to sixty major
universities around the world.

Festival Release.rtfd — n'letmuhlicit.g;!—Press Releases.*s-May

¥ |
T |4 T = ',/ls LA
1 N 7 LB
Left margin  Body indentation Indentation marker Tab Right margin
marker marker for the first line only marker marker

The margin markers ['{ set the left and right margins of all text in the
document.

When you finish
dragging, tab

and indentation
markers move

with the left margin.

Drag a margin

N Féstival Release.|
marker. :

While you drag,
a gray line
shows the
margin position.

In 1990, jazz and blues
aimed the "90s as the

In 1990, jazz and blue
claimed the "90s as tt



"To change the tab stops in a paragraph, click or select text anywhere in the
paragraph. Then adjust tab markers. When you press the Tab key anywhere
in the paragraph, the insertion point advances to the next position you set with

these markers.

Indentation markers also apply to the paragraph where you click or make

Drag a tab marker to

3 I S BN NN S r\}kr_q reposition it.

lownches! " T T¢ T T T T PTG ;

>, Drag it off either end of
ka s F S S A el A S the ruler to remove it.

lowchest [0 TP T RTTTTT TN

- g Click just below the ruler’s

¥ > > > b / 1 scale to create a tab marker.

Y% B PR B PARL 'k;/[a !

a selection. Drag the T marker to indent the first line of the paragraph.
Drag the w marker to indent the rest of the lines of the paragraph.

When you press Return to start a new paragraph, the new paragraph has the

same indentation and tab stops as the one preceding it. You can also select

several paragraphs to format all at once.

Tip: You can drag the w marker to the right of the T marker to create a
hanging indent. If you then align the w marker with a tab marker, you can
type a bulleted paragraph.

Drag thew

J— m1arker to

indent all but

1 Proceeds from the 1991 festival protect endangered species | in Alaska
‘and Canada, fund a project to regenerate the South Amcncanr o

forests, and provide environmental scholarships to sizty major
muversmes around the world. :

-

the first line.

Press Tab after
the bullet to
type this

paragraph.
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Checking your spelling

Clickinthedocumentyou  In some applications, including Edit and Mail, you can quickly locate
want to check. misspelled words and choose from possible corrections.

Choose Edit from the

application’s main menu. | Spelling

Choose Spelling from the
Edit menu.

Click Find Next in the
Spelling panel.

Click to find the next misspelled word.

extravaganza
extravasate
extravisceral Select from this list of possible corrections.

When a misspelled word
is found, correct it or
select another option
from the panel.

et Or type your own correction here.

Repeat steps 4 and 5 until 5 »
you've checked the entire i I'lgnore |:g Click to replace the misspelled
document. e } G = word with your correction.
| Find Next | [ Correct ‘< o
i ; : ity/Press Releases’s May HE
PO Box 33457
i Son Francisco, CA 94105
The misspelled 5 -
wordishighlighted | E‘; Blue Planet Productions
in the document. !

In 1990, jazz and blues legends at the Blue Planet Festival's Paris debut
aimed the "90s as the decade of the Earth.

Now, in 1992 gver 3 million people are expected to gather once again for
a five-day Extraviganzg in Washington, D.C. when..

Blue Planet Productions presents:

T T = SR TR

If a misspelled word is correct for the document you’re checking, click Ignore.
For this document only, the panel skips all other occurrences of the word.

You can double-click a word listed in the panel to correct the misspelled word

Y h Check Spelli . .
ou e Co0se TAeCh Shemng in your document. Then you don’t have to click Correct.

from the Edit menu to check
spelling without opening the
Spelling panel. See “Standard
Commands” in the Reference at
the end of this book.
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You can even check the spelling of a word that isn’t in a document you’re
checking—for example, to determine the correct spelling before you type it.

~ Spelling X}

— Dictionary
“English(NeXT) -]

" Leam | Forget |

Type a word you want to

o find out how to spell.
[ mispell [
e e e S Click Guess to see a list
o Ignore I I Guess o I of possible corrections.

FindNext | Corect ¢ |

Dictionary Options

The Spelling panel checks spelling
against a 100,000-word English
spelling dictionary. It also provides
options for selecting from other
dictionaries you've installed or for
modifying a dictionary.

Dictionary If you've installed
additional dictionaries, you can
press this button to choose the one
you want to use. The panel checks
spelling against words listed in the
dictionary you choose.

Learn If the panel identifies a
correctly spelled word as
misspelled, you can click Learn
to add the word to the current

dictionary. The panel then treats this
word as correct when you use any
dictionary of the same language.

Forget Youcanselectawordyou've
added to the current dictionary and
click Forget to remove the word
from the dictionary.

Ignore Click this button to treat all
occurrences of a word as correct for
this document only, without adding
the word to the dictionary.

For information on installing
additional dictionaries, such as a
French or German dictionary, see
the instructions that come with
the dictionary.
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When you want to add color to documents or even change the background color of
your screen, you select the colors you want from the Colors panel. The Colors
command—uwhichyou’ll find in different menus in different applications—opens

the Colors panel.

PANTONE
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Using colorina
document

Creating color
swatches

Selecting a color
from the color wheel

Selecting colors
from the screen

Mixing your own
colors

Using an image as
a palette

Adding an image to
the list of palettes

Simulating PANTONE®
Colors

Creating your own
color list

Working
with Color

You sense what it must have been like to color the
world. Mixing that deep azure blue for the Santa Fe
sky and the same color for the Aegean sea.

You could choose from a rainbow of colors or mix
your own. Some colors would mix like paint, others
like light. You could see through some colors—the
ones you chose for water in a lake or the crystals of a
semiprecious stone. You might name some of the
colors and collect others in swatches or images. Your
colors would never fade, and there would never be

4 MmesSs.

Yeah, whoever created the world did a pretty good
job. But you wonder how they managed without
your computer.

141



Text and Graphics

Chapter 10: Working with Color

Using color in a document

Open the Colors panel.

Select the color you
want.

Drag the color from
the color well

to selected text in
the document.

For more information about
the color wheel, see “Selecting
a Color from the Color Wheel”
in this chapter.

For other ways to select colors,
see the instructions throughout
this chapter.
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When you send Mail messages, you can send them in color. When you write a
memo in Edit, you can highlight the text with color. In any application that has
a Colors panel, you can create documents in color, black and white, or shades
of gray.

E _Festival Release.rtfd — /Het/publicity/Press Releases/s May [

FQ Bux 334573
San Froncisco, £A 24105

Blue Plunet Productions

In 1990, jazz and blues legends ot the Blue Planet Festival’s Paris debut
¢ cloimed the '?0s as the decade of the Earth,

In 1991, record crowds swarmed the Beclin Wallin the largest peace and
music gathering in recorded histery.

Now, in 1994, over 3 million people are expected to gather once again for
afive-day extravaganza in Washington, D.C. when...

Blue Planet Productions presents!

THE THIRD ANNUAL BLUE PLANET

Drag the color in
“We are the Earth” this color well to
UAZZ & BLUES HERITAGE FESTIVAL your document.
— Cal X
— olors _l
On the Mall in Washington, D.C + September 17-21 : B

Francois de la Patisse + Big Daddy Jordan and his Trumpeteers + Emi £t
Caccitore et il suo Jazz Italiano + Saxophone viuoso Berhardt Sprech)

As well as new Blue Planet artist Emily Bright, Dido Estevan, and scores //Mﬂ
of our planet’s best jazz and blues superstars.

Featuring: Queen of the torch light, Betty James + Master ofthe 88’ | - | e | P | parron
g 9 y NS I , _lm]mmm]

1y

1

Click to select a color from the color wheel.

You can also drag one of these color
swatches to your document.

Some applications have color tools—for drawing in color, for example. These
tools typically use colors from wells in the application’s Inspector panel. To
put color in one of these wells, you select a color in the Colors panel and drag
it to the color well in the Inspector panel.



Creating color swatches

Open the Colors panel.
Select a color.
Drag the color from

the color well to the
swatch bar.

When you need to use the same colors over and over, you can save them as
swatches in the swatch bar at the bottom of the Colors panel.

O = [pume|

/\‘/’/
[N r

T

Drag the color from the color well

. e t0 the swatch bar.

Make the panel larger and then drag

‘ ! T T— here to show lots of rows of swatches.
Elillllllllli

Each swatch has its own cell in the swatch bar. When you drag a new color to
a cell, it replaces the existing color. You can make room for more swatches—
hundreds of them—by making the Colors panel bigger.

All Colors panels have the same swatches. When you put a color swatch in the
swatch bar in one application, it instantly appears in the Colors panels in other
applications. The swatch remains there until you replace it with a new swatch.

Where to Find the Colors Panel

You use the Colors command to
open the Colors panel.

In text applications like Edit and
Mail, the Colors command is in the
Font menu. (Choose Format from
the main menu and then choose
Font from the Format menu.) In
applications that have color tools,

If you want to have the Colors panel
at your fingertips, you can create a
keyboard aiternative for the Colors
command and use it in any
application that has a Colors
command. See “Creating
Command-Key Equivalents” in
Chapter 20.

the Colors command is typically . in

the Tools menu.
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Selecting a color from the color wheel

Open the Colors panel.

Click the color wheel
button.

Click or drag in the color
wheel to select the color
you want.

Drag the brightness slider

to make the color lighter
or darker.
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The color wheel is a quick, visual method for selecting colors.

e COlOr wheel button

i

PANTEMNE ]

et g
/ Brightness slider
#

Click to select a color.

Ordrag to scana
range of colors in
the color well.

Shift-drag to change
the saturation without
changing the hue.

As you move around the wheel, the hues change. Hue is what distinguishes
between red and yellow or yellow and green, for example. The colors on
the rim of the wheel are the most saturated. You can think of sazuration as
the intensity of the color—or how much of a particular hue is in the color. As
you move toward the center of the wheel, the colors become less saturated
and more neutral or washed out. At the very center of the wheel, they
appear white.

What Happens When You Print Colors

The colors you see on the screen can
never precisely match printed colors
because screen colors are created
with light, while printed colors are
created with pigments. Also, colors
printed by different printing
methods never look exactly alike.

However, your NEXTSTEP
computer has some features that
help you get the color you want.

The exceptions are the CMYK and
PANTONE® Colors described later
in this chapter. If you're an expert
color graphics user and are using
a traditional printing process, you
can use these color models to
specify colors numerically—for
exact results.

If you're not an expert, you shouid
use one of the other models and a

Most colors you select in the Colors
panel are calibrated so thatthey look
the same when you print them on
different brands of Level Il printers.

Level Il printer to produce your
printed images. Check the owner’s
guide that comes with your printer
to find out if it's a Level Il printer.



Selecting colors from the screen

Open the Colors panel.

Click the magnifying
glass.

Click a color on the
screen.

You can capture any color that’s on the screen and use it in a document or save
it as a color swatch.

Services
Hide
Quit

J
[
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i
I
Pint.  p
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q
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Colars X NextApps
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g
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When you click here, the cursor Use the magnifying glass
changes to a magnifying glass. to find the color you want.

When you move the magnifying glass around the screen, it shows a magnified
picture of every pixel you drag it over. (A pixe/ is one of the dots that makes up
the image on the screen.)

You center the color you want between

the crosshairs and click.

Vi

L
/
4
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Mixing your own colors

Open the Colors panel.

Click the color models
button.

Click the color model
you want.

Drag the sliders to mix
the color you want.
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You can mix your own colors—or shades of gray—using one of four models
built into the Colors panel. Each of these models creates colors differently.

For example, the RGB color mode! mixes colors by blending red, green, and
blue light. This is a standard model for representing color on computer
screens. The slider values indicate brightness, which can range from 0 for
minimum brightness to 255 for maximum brightness.

Color models button

- RGB button

]— Each of these buttons represents

a different color model.

Adjusting these sliders is like
mixing colored lights.

The CMYK color model simulates the four-color printing process, which creates
colors by combining cyan, magenta, yellow, and black inks. The slider values
indicate saturation, which can range from 0 for no saturation to 100 for

maximum saturation.

‘_} I M-Im lm;\"mns'
- i 4 P W

Peomeng

053 (B2 Ga | |
o iyl
[Magenta = ] [wo
[velow T~ Ja
[Black] T s

color here and in the swatch bar.

—n — A triangle always marks a CMYK

CMYK button

Adjusting these sliders is like
mixing inks on a printing press.



The HSB color model mixes colors by adjusting hue, saturation, and brightness.
You can think of hue as the color name—red, green, or yellow, for example.
Saturation is the intensity, or how much of a particular hue is in the color.
Brightness is how dark or light the color is.

| [ ] | m‘ ‘PANTGIJE

4

o

HSB button
- . R
7 | B | = | =
[Hud] I £ Adjusting hue, saturation, and brightness
[Saturation ] Jes. is like using the color wheel—but you get
| Br5HTES R E; to set precise values.

-
CTW I T -1

In addition to these three color models, you can use the grayscale model to
work with shades of gray. The values on the grayscale slider show the percent
of white in the gray.

Tt

v 1 I rm 1?»:1‘@:-15‘
- . Grayscale button

e Drag to select unlimited shades of gray.

Click to select distinctive shades of gray
that are well-suited to the screen display.

T

.
TR T T {10

If you’re working with both color and shades of gray, you can also select shades
of gray with the other models. In the RGB model, you set the same values for
all three sliders. In the CMYK model, you set the cyan, magenta, and yellow
sliders to 0 and adjust the black slider. In the HSB model, you set the hue and
saturation sliders to 0 and adjust the brightness slider.
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Using an image as a palette

Open the Colors panel. You can use an image as a color palette. For example, if you have a cover
image for a color brochure, you can keep it in a list of palettes in the Colors
panel. Then you can pick up one of the colors from it to use in the text of
the brochure.

Click the palette button.

Choose an image from
the pop-up list at the
top of the panel.

st Palette button

Click or drag in the
image to select the
color you want.

‘Spectrum szt s YOU choOSE 2N image from
- this pop-up list of palettes.

e Click or drag in the image
to select a color.

Palette

i i

Some applications come with several images to use as palettes. You can also
add your own images as described next.

You can also select a color
directly from an image on the
screen. See “Selecting Colors
from the Screen” in this chapter.
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Adding an image to the list of palettes

Open the Colors panel.
Click the palette button.

Press Palette and choose

the New from File
command.

Select an image file
and click OK.

You can add images to a list of palettes in the Colors panel to turn any image
file into a palette.

When you add an image, it
Worlds e arrerreet L e appears in this pop-up list.

Choose New from File to
add the image.

Palette AT
Newfrom File.. R’

Rename.. ——————
Remove 2

Copy New Color Palette
New from Pasteboard
[ R J§| Gy i

Inthe browser, select the Audio = AppS =
image file you want to slbasil BP logo.iff
add to your list of ey . PbilefCatalogs 1T
palettes and click OK—or  |hohner - | |CD Coverrid
drag a file or selection of | ' From Morm.fax

. g g y ‘|Print I Library "
files directly from the File i |video i~ L& Mailboxes -
Viewer to the image area . Y llmy signature it
of the Colors panel. l] c |

Name:|CDCoverrid

o 11 1 ¢;n;;{’ﬂ|ﬂ 5],(,.“.‘.1

Il

You can press Palette and choose Rename to change the name of an image.
You can also remove images from the list with the Remove command. All the
images you add are saved as TIFF files in your ~/Library/Colors folder.

Tip: If you want to use part of a color image as a palette, you can select the part
you want and copy it to the pasteboard. Then open the Colors panel, click the
palette button, press Palette, and choose the New from Pasteboard command.
The image on the pasteboard appears in the Colors panel, and it’s listed as an
unnamed palette in the list at the top of the panel. Also, if you want to use the
image in the color palette in a document, you can press Palette, choose Copy,
and then use the Paste command in your application to paste it.
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Opaclty ak’hdjTranspar’éncyf—‘WhénVYo‘u Want Layers of c«(:"lor" Thlens

Sometimes you want layers of color. Maybe you
want to show color text over a color photograph.
Maybe you want the text to block part of the image
behind it. But maybe you don’t. Maybe you want
the image to show through your words.

Or maybe you want to blend two or more images into
a collage of semitransparent objects that overlap
each other but don’t block each other out.

In some applications, the Colors panel has an
Opacity slider. You can use this slider to make
selected objects and text as opaque or transparent
as you want.

When you move the Opacity slider, you begin to see
a split pattern in the color well. It's as though you
were looking through a colored glass at a surface
that’s half black and half white. The more transparent
the color becomes, the more clearly you see the
black-and-white contrast.

Suppose you want to
combine these images
into a single image.

This image is opaque.

Here the image is
e partially transparent.

$NOUINCOYd 1INV 3me

== The background is
completely transparent.

n—-——:—{-— Here it's opaque.

| Your color looks like thfs: [
e When layered over black. = = -

\ It looks like this when

layered over white.

The higher this value
e jS, the more opaque

YPrTPCTPRRIITYY|  thecoloris.

1

In some applications, you can select individual pixels
and change their opacity, so you can make parts of
the image transparent. For details, see the user’s
guide for your application.

a04d 1INV1d In9

This is the composite image.




Simulating PANTONE Colors

Open the Colors panel.

Click the PANTONE
button.

Choose one of the
PANTONE lists from
the pop-up list at the
top of the panel.

Click the color you
want in the list.

PANTONE Colors are part of a proprietary system designed by Pantone, Inc.,
for matching colors with professional printing inks. This system includes
several thousand colors, each of which has a name and formula. People who
work with professional printers use these color names to specify the exact color
they want on the final printed copy. You can simulate these colors on the
screen with the PANTONE lists in the Colors pancl.

PANTONE Colors are outlined in
the color well and in the color
e swatch bar below.

e | TR | PANTONE
o l -&—I i T
PANTONE -]

i 208
< B anTONE 208 Cv
PANTONE 210 CV
PANTONE 211CV
IPANTONE 212CV
_|PANTONE 213 CY  wame]

Colok, T! List '[
@ Pantone; . 1986, 1932
o

PANTONE button

—— Click to select the color you want.

] 1 |- ]

Scroll to see the complete list of

PANTONE Colors.

If you know the name

of the color you want, you can press Color, choose Find,

and type the name—or part of the name—in the panel that opens.

Type all or part of the PANTONE
Color name here.

Find color:| 3265 ¢

|

Uncheck this box if you don't want to

ﬁlgnare case ;*ﬁreviouks I

- Next i'<’t"" I

match upper- and lowercase letters.

Why You Need Two PANTONE Lists

The Colors panel has two PANTONE

lists—PANTONE an
Process.

The PANTONE list simulates
custom-blended color inks. These
are the inks that printers typically
use on a one- or two-color press

when you specify a

PANTONE Color computer hard copy

When you're printing with process
colors—cyan, magenta, yellow,

and black—to get full-color images,
you can specify a color from the
PANTONE Process list. Such a color
is produced by a mathematically
defined combination of the four
process colors.

d PANTONE

PANTONE Color.

simulations used in this product are four-color process simulations and may not match PANTONE-

identified solid color standards, Use PANTONE Color Reference Manuals for accurate color. Pantone, Inc., assumes no responsibility for color
inaccuracies on non-icensed output devices. Contact Pantone, Inc., for a current list of qualified licenses.
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Creating your own color list

Open the Colors panel.

Select the first color you

want to put in the list.

Click the PANTONE
button.

Press List and choose
New.

Select another color,
click the PANTONE
button, press Color,
and choose New.

Repeat step 5 for each
color in the list.
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You can create your own list of colors and select them by name in the Colors
panel. For example, if you have a publication that uses a standard palette of
colors, you can name the colors and save them in a list like the PANTONE

Colors described eatlier.

PANTONE

m" I:?J‘“”‘I oo

Unnamedt |

4. JUnnamedt-1 !

Color T{ Lisf /“
New )¢7

T (} Qpen...

I —1'Rename...
Remove

Select a color using
any of the methods
in this chapter.

When you choose
New here, a new
unnamed list opens.

The currently selected
color is the first color
in the new list.

When you create a new list, it appears as an unnamed list in the pop-up list at
the top of the panel. You can press List and choose Rename to give it a name.
You can press Color and choose Rename to name individual colors in the list.

Rename Color List

Press List and choose Rename

Cancel " Rename <"‘l

New name for Iist:l Blue PInet Colors et t0 name the list.

Renamé Color List

Press Color and choose Rename

© Cancel l -Rename <©

New name for list[Blug Planet Colors e e t0 Name the selected color.




You can add as many colors as you want to the list. You just select each color
one at a time, press Color, and choose New.

REET kA PA‘"‘W-
~ ‘ . > 12 When you choose New here,
Blue Planet Colors | the color in the color well is
Orchestral Green added to the list.
o [ —vazz Magenta v
Soprano Yellow
— " 1Treble Purple
Al viorato Red )
¥ I[_1Blue Planet ghlors-1
Color /_ List 7 Or you can drag a color directly
New K from the color well or a color swatch
Rename... PRSI to the list. You can also drag-from a
[] Remove I color well in another application.
Find...

You can press Color and choose Remove to remove selected colors you don’t
want in the list. If you no longer need the list, you can press List and choose
Remove to remove it. You can’t remove, rename, or change a PANTONE list.

If Your Application Supplies Color Lists

Some applications supply color
lists. They're stored in files with
the extension .clr. You can open
these lists in the Colors panel and
use them like the PANTONE Colors
or color lists you create. You can
press List and choose Open to find
them in your file system. When
you select a .clr file and click OK, it
appears in the list. You can also
drag the file icon directly into the
list in the Colors panel.

All color lists that you create as well
as those you get from applications

are kept as .elr files in your
~/Library/Colors folder. When you
open an application’s list with the
Open command, a copy of the
original file appears in the folder.
When you remove the color list,
the original file remains in your file
system. However, if you remove a
list you created, the Remove
command permanently removes it
from the file system, and it can no
longer be retrieved.

For more information, see the user’s’

gu;de for your application.




You can drag or paste graphic images into your pages. You can even link the
images you add to the originals, so the copies in your pages are always up to date.
You can preview how your pages will appear before you print them. And you can

use the Grab application 1o take pictures of all or part of the screen.

Source: /LocalLibrary/Images/Current Lago.ohjlink

i . g s

S
Break = |
Link |1

' 'When Source Saved -il Last Update: JQn 03 1247 |

Open | Update i
- Source - | . from Source

' ' Festival Release.rtfd

PO Box 334579
San Francisca, CA 94105

In 1920, jezz and blues legends at the Blue Planet Festival's Paris debut
claimed the *90s as the decade of the Earth.

In 1921, record crowds swarmed the Berlin Wall in the largest peace and
music gathering in recorded history.

Now, in 1994, over 3 million people are expected to gather once again for
a five-day extravaganza in Washington, D.C. when...

Biue Pilanet FProductions presents:

THE THIRD ANNUAL BLUE PLANET



Adding a graphic image
Adding linked graphics
Adding a link button

Publishing an image as
a link file

Editing and updating
links

Previewing pages

Previewing graphic
images

Starting up the Grab
application

Grabbing the screen

Grabbing the screen
with a time delay

Grabbing a window

Grabbing a portion of
the screen

Inspecting an image
you grabbed

Working
with Graphics

[ have a single eye of glass. I can make an exact copy of
anything I see, surround it with glorious scriptures, change
a hundred faces with a single command, and show you
what 1 see before you see it. What am 12

You have three minutes to solve the riddle. The
priestess sets the sands in motion. The pot of gold is
inches away.

Seconds pass. Your mind drifts to what you’ll do with
all those riches—a yacht, a totally intense stereo, a
gigabyte disk drive. No, you have to concentrate.
Exact copies, text integration, automated updates,
image previews—only five seconds left!

"Then you see it in a flash. It’s your computer. You
gasp the word NEXTSTEP as the last grain of sand
falls noiselessly into place. The priestess hands you

the gold, but you’re not quite satisfied.

Wait, you say. You forgot the part about user-defined link
buttons, timed snapshots, detailed color analysis...
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Adding a graphic image

Click in the document
where you want the
graphic image to appear.

Drag the icon for the
graphic file from the
File Viewer into the
document window.

For more information about file
packages, see “File Packages—
Files That Are Really Folders”
in Chapter 3.

You select graphic images you
want to copy differently in
different applications. For more
information, see the user’s guide
for your application.
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You can add a graphic image to documents, such as Edit documents or
Mail messages. The image may be a file in TIFF, EPS, or another graphics
file format.

If you add a graphic image to an Edit document that contains only text, the
document is converted to an untitled RTFD file. (RTFD files are Edit file
packages that contain Rich Text and one or more graphic images.)

NextApps -
227MB availakle on remote disk

_— F| |é \ﬁ ;\uer R —

© BFLogosdraw- . Logo 14

, Here are two versions of the logo.
Which do you prefer?

- / : & {ue Planet Productions
You drag the icon for a ' s

graphic file into the document.

The cursor changes to a E] to
show that you‘re adding a copy—
not the original file.




If you want to add only part of a graphic image, you can use the commands in
the Edit menu to copy the part of the image you want and then paste it in the
document where you want to add it.

You can’t modify the contents of graphic images you add to text documents.
You can only move, copy, or delete them with the commands in the Edit menu.

Graphics File Formats

Graphic images and the documents
they're created in can be stored in a
number of different formats. The
most common are:

TIFF Tag Image File
Format is a format for
single-page or smaller
images. TIFF files typically include
grayscale or color halftones (such
as photographs or shaded art) or
screen images, as well as other
kinds of art. The Grab application
creates TIFF files. TIFF files have

a .tiff extension.

EPS | EPS Encapsulated
2 PostScript is another format
1 for single-page or smaller
images. EPS files typically include
black-and-white, grayscale, or color
text or line art (such as technical
drawings), as well as other kinds

of art. Unlike TIFF files, EPS files
can look good at almost any scale
or resolution. Many illustration
applications create EPS files. EPS
files have an .eps extension.

PS PostScriptis aformatfor
single- or multiple-page
files. They can include the
same kinds of information as EPS
and TIFF files, but they also include
information about how text and
images are oriented on one or more
pages. PS files can include fonts and
printer-specific information for

how they should be printed. As a
rule, you can’t add PS files to your
documents, but you can open them
in Preview and print them. PS files
have a .ps extension.

3

For more information, see “What Is :
a PostScript File?” in Chapter 15.
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Adding linked graphics

Select the graphic image
you want to add in the
graphics application and
choose Copy from the
Edit menu.

You can add a linked graphic image to your documents. Then if the original
image is changed, the linked copy in your document is updated automatically.

BP Logos.draw — ~jprojects/Logo Studies

; L] L] L]
Eﬁ Blue,Planet I’mdutlinn;. }_—— Select what you want to

link to and choose Copy.

- Click in the document
where you want to add
the linked image.

Click where you want
the linked image and
choose Paste and Link.

Choose Link from the
Edit menu.

ﬁ BLuE
! PLANET

Festival- Edition.rtfd fl(ellwerlmnglf’(esse Kit’s Mai

1991 haben Jazz- und Bluesstars beim Debut des Blaver Planet Festvals in
P Paris die 90er zum Jahrzehnt der Erde erklért.

Choose Paste and Link
from the Link menu.

A

«

Blue Plunet Prndudioml

1992 versammelten sich rekordverdéchtige Menschenmassen an der
Berliner Mauer, um eines der gréBten Musikereignisse mit einer
Friedenskundgebung zu vereinen,

] Indiesem Jahr, 1994, werden iiber 3 Millionen Menschen zum finftasizen

You can use the commands in the Edit menu to copy, move, or delete the

For information about
selecting and copying the
images you want to paste and
link, see the user’s guide for
your graphics application.
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linked image.

What You Can Link

To work with linked graphics, your
application must be able to receive
linked information. Such applica-
tions have a Paste and Link com-
mand in the Link menu. In addition,
the application where the graphic
image was created must be able
to supply linked information. For
example, the Edit application (in
/NextApps) can receive linked
information, while the Draw appli-
cation (in /NextDeveloper/Demos)

can both receive and supply linked
information.

Some applications can supply linked

~information that isn't a graphic

image, such as text or database in-
formation. You add this information
to a document the same way you
add linked graphics.

“See the user’s guide for your appli--

cation to find out whether it can re-

- ceive and supply linked information.



Adding a link button

Select a graphic image
or other information
you want to link to and
choose Copy from the
Edit menu.

Click in the document
where you want to add
the button.

Choose Link from the
Edit menu.

Choose Paste Link Button
from the Link menu.

To find out whether your
application can add link
buttons and supply linked
information, or for more
information about selecting
and copying information you
want to link to, see the user’s
guide for your application.

In some applications, you can add a link button to a document. The button is
linked to a graphic image or other information in another file. If you click the
link button, the file the button is linked to opens in a window.

[=] BP Logos.draw — ~/projectsiLogo Studies =

r E«& Blue Planet Productions
L
B ¢

=l

You select what you want to
link to and choose Copy.

BL(/g
'o% When you choose Paste Link
el Button, a link button appears

on the page.

Lngb Hote Linked.draw — ~projectsiLogo Studiey/

<

Here are two versions of the logo.
Which do you prefer?

<J»]
;

Clickto see Logo 1 & BP Logos.draw — ~projects/Logo Studies

) E& Blue Plunet Productions

Bl(/g >

Clickto see Logo 2 24

i
o S

1

When you click a link button,
the linked graphic opens in a
window, surrounded by a
chain-link pattern. L

< € Fﬂfﬁn

I R - T

>

You can select a button in most applications by dragging across it. Then you

can drag one of its corners to resize it, or you can copy, move, or delete the

button with one of the commands in the Edit menu.

"To add a link button, your application must have a Paste Link Button
command in its Link menu. In addition, the application where the original
information was created must be able to supply linked information. For
example, the Draw application in /NextDeveloper/Demos can both add
link buttons to its documents and supply linked information.
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Publishing an image as a link file

Select a graphic irhage In some applications, you can select part of a graphic image or other
in a document. information you want to share and “publish” the selection as a link file.
Then you can drag the link file into other documents to add the graphic

Choose Link from the . . ..
image as a linked graphic image.

Edit menu.

When you choose Publish Selection from the Link menu, the Publish
panel opens.

Choose Publish Selection
from the Link menu.

Type a name for the |
link file and select the ' L
folder where you want ﬁ Publish
to save it. .

[ L iy M O v s

Click OK.

Name:[Current Logo L When you click OK, the
¢ 1 image is saved as a link file.

You can share link files with others by storing them in a folder that others
can open, or by mailing them.

Link files have an .objlink extension.
Their icons look like this.

"To publish a selection, your application must have a Publish Selection
command in its Link menu. In addition, an application must be able to
receive link files for you to be able to drag them in. For example, the Draw
application in /NextDeveloper/Demos can both publish selected images
as files and add a link file as a linked graphic image if you drag one in.
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Editing and updating links

1 Select a linked graphic

or link button.

2 Choose Link from the

Edit menu.

3 Choose Link Inspector

from the Link menu.

You can use the Show Links
command in the Link menu
to highlight all the linked
graphic images in your
document with a chain-link
* pattern. See “Standard

Commands” in the Reference -

at the end of this book.

You can use the Link Inspector command to update and get information about
linked graphic images, link buttons, and other linked information.

The Link Inspector panel shows the pathname of the file the linked graphic
image is linked to and the date and time the link was last updated.

[a) Select a linked graphic image
- and choose Link Inspector
PO Box 334578 .
/ Son Frandiscs, CA 94105 from the Link menu.
[e—— o ,{
& Blue Plunet Productions’
In 1990, jazz and blues legends atthe Blue Planet Festval's Paris debut
. claimed the "90s as the decade of the Earth.
In 1991, record crowds swarmed the Berlin Wall in the largestpeace and
music gathering in recorded history.
Now, in 1994, over 3 millicn pecple are expected to gather once again for
afive-day extravaganza in Washington, D.C. when..,
Blue Planet Productions presents:
THE THIRD ANNUAL BLUE PLANET
“We are the Earth” = Lnknspector
JAZZ & BLUES HERITAGE FESTIVAL Source: fLocalLibrary/images/Current Logo.objlink
1  Onthe Madl in Washington, D.C + September 17-21 b0
1 2] Featuring: Queen ofthe light, Betty James + Master of the Open Update Break Break Al
n Francois de la Patisse /Big Daddy Jordan and his Trygm i = i N i
2 Caccitore etil suo Jggf ltaliano + Saxophone virtuo erhardt ooes from Source | 4 Link Links
L As well as new Blyg/Planet artist Emily Bright, Didg#stevan, and s ————————— Updde-
%l of our planet’s At jazz and bluss superstars. "When Source Saved 4] Last Update: Junp3 14:00
T A v e yf -
Click to open Clickto incorporate Click to break the link so Click to break
the file the any changes from that subsequent changes all the links in
graphic image the original file. to the original won't the document.
is linked to. change the copy.

You can change how and when a link is updated by choosing an option from
the Update pop-up list.

‘Manually
| When Source Saved =4
| Continually i

If you choose Manually, the link is updated only when you click “Update from
Source” in the Link Inspector. If you choose When Source Saved, the link is
updated only when the original file is saved. If you choose Continually, the
link is updated as soon as the original is changed.
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Previewing pages

» Choose Print from your

application’s main menu
and then click Preview.

Or

» Double-click a PostScript

(PS) file, if you've saved
your pages in this format.

For more information about
PostScript files and how to
create them, see “Saving Your
Pages as a PostScript File” in
Chapter 15.

For more information about
the commands in the Display
menu, see “Preview Com-
mands” in the Reference at
the end of this book.
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You can preview your pages on screen before you print them, so you can see
how they will look when you print them.

When you click Preview or double-click a PostScript file that has a .ps
extension, the Preview application starts up and displays the first page of
the file in a window.

preview290745.ps — ftmp

FO Box 334578
San Froncisco, CA 94105

vl

Z= Blue Planet Productions

In 1990, jazz and blues legends at the Blue Planet Fesival’s Paris debut
daimed the "90s as the decade of the Earth.

In 1991, record crowds swarmed the Berdin Wall in the largest peace and
music gathering in recorded history.

Now, in 1994, over 3 million people are expected to gather once again for
afive-day extraveganzain Washington, D.C, when..,

Blue Planet Productions presents:

Type the number
of a page you
want to view and

THE THIRD ANNUAL BLUE PLANET

“We are the Earth”

JAZZ & BLUES HERITAGE FESTIVAL press Return.
£
B On the Mall in Wasington, D.C + September 17-21 Page 2 /7
' Featuring: Queen of the torch light, Betty James + Master of the 88 PR |

Francois de la Paisse + Big Daddy Jordan and his Trumpeteers + Emilio
Caccitore et il suo Jazz Italiano + Saxophone virtuoso Berhardt Sprecht «
As well as new Blue Planet artist Emily Bright, Dido Estevan, and scores more
of our planet’s best jazz and blues superstars.

S i Page]t
Fess

You can use the commands in the Display menu to switch pages, enlarge or
reduce the scale of the pages in the window, and change how your pages are
displayed in other ways.

Tip: If you’re having trouble previewing a file, start up the Preview application
in the /NextApps folder. Then try to open the file with the Open command
in Preview’s File menu, but click Use Simple Mode in the Open panel before
clicking OK. Some of Preview’s commands aren’t available in simple mode,
but you can open a wider range of graphics files.



Previewing graphic images

Start up the Preview
application by opening
the /NextApps folder
and double-clicking
Preview.app.

Choose File from the
Preview menu.

Choose Open from the
File menu.

Select a graphics file
in the panel.

Click OK.

You can also use the Inspector
command in the Workspace
Manager to preview a graphic
image. See “Previewing the

Contents of a File” in Chapter 7.

You can preview a graphic image in TIFE EPS, and other graphics file formats
to see how it will appear when you add it to a document or print it.

Graphics files open in a Preview
window sized to fit the image.

You can use the Zoom In and Zoom Out commands in the Display menu to

enlarge and reduce the image.
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Starting up the Grab application

» Open the /NextApps
folder in the File Viewer
and double-click
Grab.app.

You can use the Turn Sound
Off command in the Info menu
to turn off the sound effects
that accompany the screen

grabbing animation. See “Grab

Commands” in the Reference
at the end of this book.

164

You can use the Grab application to take a picture of your computer screen—
or part of the screen. You can print the image you grabbed or save it as a

TIFF file.

The Grab application
icon looks like this.

Normally when you start up Grab, the Grab menu appears, but the rest of the
screen remains unchanged. You can grab the entire screen, a window, or a part

of the screen you select.

If You Want to Grab the Cursor

When you use the Grab application,
you can pick a cursor style you want
toinclude in the images by choosing
the Choose Cursor command from
the Grab menu.

The cursor you pick appears in place
of Grab's cursor wherever you place

it at the moment the picture is taken.

Click the cursor you want to include
in your images. If you click the top left
button, no cursor is included.

Ifyou click the top left button, no cursor.

This option applies when you
grab the screen, grab the screen
with a time delay, and when you
grab a window. These techniques
are described in this chapter.

T S S—

Choose Cursor

is included.




Grabbing the screen

Start up the Grab
application.

Choose Grab from the
main menu.

Choose Screen from the
Grab menu.

Arrange the windows,
panels, and other images
on the screen the way
you want them.

Click the camera icon at
the top of the dock.

Click anywhere on the
screen.

You can use Grab to take a picture of the whole screen.

When you choose Screen from the Grab menu, a camera icon appears in the
upper right corner of the screen, usually replacing the NeXT icon at the top
of the application dock. When you click the camera icon, an eye behind the
camera looks left and right as you move the cursor to remind you that, when
you next click the mouse button, the whole screen will be grabbed.

’ ___
Info r 2 File Viewer
Document )

3

.
- .
v e
Windows - . & . ‘:.r" . 5 frﬂ i
Pinl.__p M av W L;,d
Services ¢ craative basil projects 1 Logo Studies ¢
Hide h 5] - |
Quit q
TIFF]
Tools ] ek
RS BP Logos.draw Logo LT
. L
AT 0

GIT ON DOWN THE RDAD

: S o /. "%4!»! - / I
7 7
Click here when you're ready to grab the Then click anywhere to
screen. The cursor changes to 3] (or the grab the whole screen.

cursor you chose in the Choose Cursor panel).

Each image you grab is displayed in a new, untitled window. You can use the
Save command to name the image and save it as a TIFF file.
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Grabbing thé screen with a time delay

Start up the Grab
application.

Choose Grab from the
main menu.

Choose Timed Screen
from the Grab menu.

Click the camera icon at
the top of the dock to
start the timer.

Arrange the windows
and cursor on the screen
the way you want, and
“hold the pose” until the
screen is grabbed.
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You can use Grab to take a picture of the screen after a 10-second delay. The
delay gives you time to set up images that are possible only when the mouse
button is pressed, such as choosing an option from a pop-up list or dragging a
file to a folder.

When you choose Timed Screen, a camera icon appears at the upper right
corner of the screen, usually replacing the NeX'T icon at the top of the
application dock.

When you click the camera icon, the stopwatch behind the camera counts off
the seconds until the screen is grabbed.

Info -

SECH ‘{g
Document +}
Edit v : ﬁ ﬁg
Format " E =&

Font basll NextApps

File Viewer

227MB availsble on pmmate disk

Tools

Windows N [@ N ﬁg oo T 1!
Print.. . i i

Services Logo Studiss . ogo 11l -
Hide - Y i
Qul__a}. . —

T T

x

A stopwatch counts the seconds You can use the Timed Screen command
before the screen is grabbed. to capture images that appear only when
the mouse button is pressed.

Each image you grab is displayed in a new, untitled window. You can use the
Save command to name the image and save it as a TIFF file.



Grabbing a window

Choose Grab from the
main menu.

Choose Window from the
Grab menu.

Open and arrange the
window you want to
grab.

Click the camera icon at
the top of the dock.

Click in the window you
want to grab.

You can use Grab to take a picture of a single window on the screen. The
window you grab can be a standard document window, a panel, a menu, or
even an icon in the application dock.

When you choose Window, a camera icon appears at the upper right corner of
the screen, usually replacing the NeX T icon at the top of the application dock.
When you click the camera icon, an eye behind the camera looks left and right
as you move the cursor to remind you that, when you next click the mouse
button, the window you click in will be grabbed.

D
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Document +°
Edit
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Select the window you want to Then click in the window
grab and click the camera icon. you want to grab.

Each image you grab is displayed in a new, untitled window. You can use the
Save command to name the image and save it as a TIFF file.

Tip: If you want to grab an image that includes transparent elements, you must
grab the window that contains the image. Otherwise, information about
transparency is lost.
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Grabbing a portion of the screen

Start up the Grab
application.

Arrange the screen so
the windows, icons, and
other parts you want to
grab are visible.

Choose Grab from the
main menu.

Choose Selection
from the Grab menu.

Drag across the
rectangular area of
the screen you want
to grab.
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You can use Grab to take a picture of any portion of the screen.

When you choose Selection, the cursor becomes a right angle to help you
position the top left corner of the area you want to grab. As you move the
cursor on the screen, a pair of numbers shows you the distance (in pixels) from
the bottom left corner of the screen to the top left corner of the cursor. When
you press the mouse button and start to select part of the screen, the numbers
change to tell you the width and height (in pixels) of the area you’re selecting.
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Window
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The numbers show you the width and height—
in pixels—of the area you've selected. \

When you release the mouse button, the selection is displayed in a new,
untitled window. You can use the Save command to name the image and

save it as a TIFF file.



Inspectiﬁg an image you grabbed

» Choose Inspector from
the main Grab menu.

You can use the Inspector command to get information about the screen

images you grab.

When you choose Inspector, the Image Inspector panel displays information
about the grabbed image in the main window.

=

Dimensions in Pixels
Image width: 500
Image height: 671

The numbers show the
width and height—in
pixels—of the image.

0 X

Image depth: 2 '

JIrnage has alpha

Alpha and Depth—What They Nean

The image Inspector panel includes

two pieces of information you
may not be familiar with: alpha
and depth.

Alpha is the part of the image that
contains information about what
areas are transparent and how
transparent they are (on a scale from
transparent to opaque). “Image has
alpha” is checked only if you're
inspecting an image you grabbed
with the Window command, and if
the application whose window you

grabbed includes transparency
information in its documents.

Depth indicates how much
information there is for each pixel
(or picture element) in the image.
For example, if the depth is 2, only
one of four colors or shades of gray
is possible for each pixel (as on a
monochrome display). If the depth
is 24 or higher, each pixel can be
one of over 16 million colors or
shades of gray.
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On-line references give you access to information when you need it. Digital Webster
gives you definitions and synonyms. Digital Librarian turns your folders into
indexed collections of information for easy search and retrieval. And for addresses

and phone numbers, you can keep an on-line address book.

 Digital wenste.? i

" Dictionary | Thesaurus

harerel+house V'bar-al- hal s\ »

(1863)

1: a cheap drinking and usu. dancing establishment

2: a strident, uninhibited, and foreefully rhythmic style of jazz or blues

Librarian.bshif — ary/Bookshelves

§ Thesaurus:

barrelhouse # »
syn DIVE, hangout, honky-tonk, jo
harrelhouse vé
syn HURRY 2, barrel, bucket, iy, h

- Notehnok

E!ea!e Street

71“5ear‘ch i 4fnund ‘"n Contents it

. 2 e starr ...‘
»'E,Heactlon F:epnrtstut nfTownfBeaIe S’treet-’Joe 5, m’

' ,‘Snngstyncszeale Street Blues. rff
Venues/Artist Bios.rif
| Venues/Drat Arlst Bios.rf




Starting up Digital
Webster

Starting up Digital
Librarian

Looking up a definition
or synonym

Looking up information
Viewing results
Sorting results

Choosing a search
language

Adding a target to the
bookshelf

Indexing targets

Creating a new
bookshelf

Setting up a search
service

Setting up a jotting
service

Looking up an on-line
address

Adding an on-line
address

Using On-Line

References

It’s your first assignment for the toughest editor in
the industry. Few have survived working for him,
and now you know why. You’re supposed to dig up
articles about oil tycoons in banking—every single
one that’s appeared in the last year. It’s a daily paper
with two editions. You have two hours.

You feign dismay and then trot home to your
computer. You log into the paper’s archive server.
While the computer indexes articles, you compile
personal data on major oil tycoons. Then you run a
search for articles with the words dan# and 0:/ and
finish with a half hour to spare.

The editor just scowls and assigns you a day-in-the-
life-of-a-driller piece, due tomorrow morning. You
suppress a grin. You worked in the oil fields
summers to put yourself through college. But you
don’t tell him that.
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- Starting up Digital Webster

» Double-click the Digital
Webster icon in the dock.

Or
» Open the /NextApps
folder in the File Viewer

and then double-click
Webster.app.
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Digital Webster gives you on-line access to two standard reference guides:
Webster's Ninth New Collegiate Dictionary and Webster’s Collegiate Thesaurus.

The on-line versions supply nearly all the information you would find in the
hardbound editions.

The Digital Webster
¥ "*ail application icon

When you start up Digital Webster, a window with several search
options opens.

This button
opens and
closes the
- dictionary.

f _DigitnaT\'!ebster I

\ This button
opens and
closes the
thesaurus.

You can use the dictionary to look up the meaning and pronunciation of a word
and to check its spelling. You use the thesaurus to find synonyms.



Starting up Digital Librarian

» Double-click the Digital

Librarian icon in the dock.

Or

» Open the /NextApps
folder in the File Viewer
and then double-click
Librarian.app.

To start up Digital Librarian
automatically when you enter
the workspace, see “Starting Up
an Application Automatically”
in Chapter 4.

To use Librarian’s services in
other applications, see “Setting
Up a Search Service” and

“Setting Up a Jotting Service”
in this chapter.

You can turn any file or folder into an on-line reference. You just put it on
your Librarian bookshelf or another bookshelf that you create with Digital
Librarian. Then you can search in it for words or phrases—or for file and
folder names. -

L The Digital Tt A bookshelf icon

s TE R Librarian ; £

, E application icon P
=5 |-

When you start up Digital Librarian, it opens the Librarian bookshelf.

Librarian.hshif — ~/Library/Bookshelves These are t{ir gets,_

: folders or files with
‘ - information that

ZEAN you want to use as

on-line references.

s You can add as
many targets as you
want to a bookshelf.

InContents =] ‘Word 4]

i} 1

If Digital Librarian is running, you can also search from other applications
by setting up a search service. Or you can file information from documents
or Mail messages in a notebook folder on the bookshelf. So you may want
to start up Digital Librarian automatically when you enter the workspace
and use the Preferences command in Librarian’s Info menu to hide the
application automatically.
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Looking up a definition or synonym

Start up Digital Webster.

Type the word you want
to define.

Click to open the
dictionary or thesaurus
or both.

Click Define.
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You can look up the meaning and pronunciation of any word in Webster’s
on-line dictionary.

|barrelhouse ¢

Type a word here.

Click to open

, . Defie, | . Fnde | Dictionary esaurus the dictionary

: kN = h or thesaurus,
barerelehouse \'bar-al-,hau s\ z if necessary.
{1883)
1: a cheap drinking and usu. dancing establishment Click to get the
2: a suident, uninhibited, and forcefully rhythmic style of jazz or blues definition. Or

press Return.
== Click here to find
| thenextoccurrence

of the word in
the definition.

The definition
appears here.

When you click the Define button, it becomes a stop sign. You can click it to
interrupt the search. You can also click the up and down arrow buttons to see
definitions of previous words that you’ve looked up.

How Digital Webster Looks for Words

When you type the word you

want to define, Webster normally
searches the dictionary for all the
definitions in which the word
appears in bold type. If you want
to search in every dictionary
definition where the word appears,
you can click Other Word in the
Digital Webster Preferences panel.

If you want to find derivative
words, you can click Prefix in the
Preferences panel. Then, when
you type legend, Webster finds
the definition of legend as well
as legendary.

For more information about the -
Preferences command, see the
Info menu under “Digital Webster
Commands” in the Reference at
the end of this book.




When the thesaurus is open, you get a list of synonyms for the word you type.

You can double-

Digital Webster ’/
o click a synonym
8 and then click
X .
| barretnouse A 'ﬁoﬁwg Define to
' | hesr : display a list of
Define | Find Dictionary | _Thesaurus | ispiay a isto

synonyms for
the new word.

barerelshouse \'bar-al-,hau s\ »
(1883)

1: acheap drinking and usu. dancing establis
| 2: a strident, uninhibited, and forcefully rhy

ent
ic style of jazz or blues

i § Thesaurus:

barrelhouse 7
syn  DIVE, hangout, honky?tonk, joint

-| barrelhouse vé

Syn HURRY 2, barrel, bucket, fly, hasten, hustle, rocket, rush, whiz, zip

Tip: If you’re working in another application, such as Edit or Mail, you can
select a word in your document and choose Services from the main menu.
Then choose Define in Webster to see the definition. Digital Webster starts
up automatically and finds the definition for the word, provided the dictionary
is open in the Digital Webster window. It also finds synonyms if the thesaurus
is open.
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Looking up information

Start up Digital Librarian.

Select a target from the
bookshelf.

Type the word or phrase
you want to search for.

Click Search.

Double-click a file to
show its contents.

Your search goes faster if you
index your target before you
search. See “Indexing Targets”
in this chapter.

You can print the list of files and
folders you find with the Print
command. For information, see
Chapter 15, “Printing.”
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Digital Librarian comes with your home folder and an empty notebook on the
Librarian bookshelf. You can search these folders—or folders that you add—
for any word or phrase.

Type a word or Click here to start Press to choose the
phrase here. the search. search options you want.

When you select
@ file, its icon
. /| appears here.

[Béate street

4 found InContents =] “ward

- ez You can click

e St e o here to list all
& Reaction Reports/Out of Town/Beale Street/Joe’s.if 5 the files in the
B Songs/Lyrics/Beale Street Biues.Hf ; | selected folder

Bl Venues/Arist Bios.if ' I instead of

— - | searching for
Bl Venues/Draft Artist Bios.rf -! \ | aword

I R T
This symbol means These files contain the word or phrase
the folder is indexed you're searching for. You can double-click

for faster searches. one to find the text you want.

When you click Search, Librarian starts searching the selected target for the
word or phrase you typed. As it searches, Librarian displays each file that
contains the word or phrase you’re searching for. If you select more than one
target, it lists the files by target. '

If the target folder is large and the search takes more than a few moments,
a stop sign appears. You can continue working while Librarian searches. For
example, you can open one of the files you find while Librarian continues
searching for others. Or you can click the stop sign to interrupt the search.

Note: If the target folder you're searching contains a second target folder on your
bookshelf, Librarian skips all the files in the second target. You must search that
target separately.



Options for Your Information Search

When you search a folder for information, you can
choose several options from two pop-up lists in the
bookshelf window.

. Where Librarian Searches

The first pop-up list gives you choices for where
Librarian searches for the word or phrase you type:

In Contents To search the complete contents of the
files for the word or phrase.

In File Names To search only the folder and file
names in the target folder for the word or phrase.
What Librarian Searches For

The second pop-up list gives you choices for what
Librarian searches for:

Words To search for every occurrence of a word or
set of words that you type in the search field. For

example, if you type oldtime fiddle in the field,
Librarian finds every document in which both
oldtime and fiddle occur, whether they occur
together or not.

Prefix To find every occurrence of a search word and
words that start with the word. For example, if you
type fiddle, Librarian also finds fiddler.

Within To find every occurrence of a search word,
even if it appears within another word. For example,
if you type rise, Librarian also finds arisen.

Literal To search for every occurrence of the
complete phrase as you type it. For example, if you
type oldtime fiddle in the search field, Librarian finds
every occurrence of the phrase oldtime fiddle.

Expression To search for UNIX regular expressions,
which are described in the UNIX manual page for ed.
Manual pages are available on-line in the extended
configuration of the software.

*.t. . »."Ubranianbshif'— ~fLibrary/Bookshelves

List Titles

4

Choose where you want
to search from this list.

Choose what you want to
search for from this list.
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Viewing results

To view a file that
contains your search
word, double-click
the file name in the
bookshelf window.

To see related files or
folders, select the file

or folder that contains
your search word,
choose File from the
Librarian menu, and
then choose Open Folder
from the File menu.

If you want to open text files in
a window other than a Librarian
window, use the Preferences
command in the Info menu to
choose this option. See

“Digital Librarian Commands”
in the Reference at the end of
this book.

You can use the standard Edit,

Format, and Print commands

in a Librarian window. See
“Standard Commands” in

the Reference at the end of

this book.
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When you find a file or folder that contains the word or phrase you’re searching
for, you can open it to view it. If it’s a text file, it normally opens in a Librarian
window, where you can search it quickly. Other types of files open in the
appropriate application.

When you open a file in a Librarian window, the first occurrence of the search
word or phrase is highlighted.

= Click here to find the next
occurrence of the word.

Select a new word in the
text and click here to search
the target folder for other
files that contain the word.

Bessie Smith
The Empress of the Blues, she was born in poverty
only to become one of the most renowned—and
highest paid—blues performers of her day.

Memphis Slim
Over the course of half a century, this Arkansas
pianist took the Blues from the barrelhouses and

world of Chicago, and across the ocean to the world,

Reverend Gary Davis
He rose from playing hard-time gospel on the streets
of Harlem to becoming one of the great folk legends
. 1

Sometimes you may find that a file contains only part of the information you’re
looking for. A quick way to find related information is to select the file and
choose Open Folder from the File menu. Librarian opens a folder window for
the folder that contains the file. You can then browse to see other files and
folders that may be related.



Sorting results

Start up Digital Librarian.

Select a target from
the bookshelf.

Choose Target from-
the Librarian menu.

Choose Inspector from
the Target menu.

Choose Searching
from the pop-up list
in the panel.

Click the sort option
you want.

Librarian only sorts the
results of searches of indexed
targets. For information about
indexing, see “Indexing
“Targets” in this chapter.

When you look up information in a target, Librarian normally displays the
results—the files and folders that contain your search word—in alphabetical
order. But you can choose to display them in other ways.

| Target Inspector

X]

Choose Searching from this pop-up list.

Searching K =&
Indexing 2
.| Services 3
Languages 4

Sort results:
description

o

Y
FWeIgnt
y

/ Lists files alphabetically.

Lists files with the most “matches”

c
-
=
-

by aare
N
Lnsunen”
LN

b S e S

for your search word first.

\Lists files according to the date they
were last changed—oldest first.

\Lists files in the order they are found.

You choose a sorting option for each target on your bookshelf. It applies to all
subsequent searches of the selected target until you choose a new option.
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Choosing a search language

Start up Digital Librarian.

Select a target from a
bookshelf.

Choose Target from the
Librarian menu.

Choose Inspector from
the Target menu.

Choose Languages from
the pop-up list at the top
of the panel.

Click the language you
want to search in.
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Librarian uses different approaches to indexing for different languages. So if
you look up information in documents written in different languages, you
should choose the appropriate language for searching and indexing them. You
can choose a different language for each target on your bookshelf.

‘Languages il

Choose Languages from this pop-up list.

Japanese Notebook

Path: .../starr/Library/Japanese Notebook

Select the language for reading
target documents

CGfEnglish.
Japanese - e Select the language that matches the
: language of the target shown above.

Which Languages Are Available

The list of languages in the For example, Engl'ish.reader sets

Target Inspector depends on up indexes for English-language
which readers you have installed. materials. Japanese.reader sets
Readers are files that are used to up indexes for Japanese-language
set upindexes for differentmaterials materials. These files are in the

in different languages. INextLibrary/Readers folder.



Adding a target to the bookshelf

Start up Digital Librarian.  Any information in your file system can be part of your on-line reference
library. You simply add files and folders to the bookshelf to include them
Select the file or folder as targets

you want to add in the
File Viewer.

__ Fleviewer

Drag the file or folder icon ]
to the bookshelf.

=5

’ sEm NektApps
Choose BOOkSheIf from 227WB available on rerote disk
the Librarian menu.

Choose Save from the
Bookshelf menu.

‘|LocalApps barcelona
‘|LocalLibrary betlin
“|Mailboxes, I creative
5| Net g london
i |NextAdmin marketing
- [NextApps N milan
+INextDeveloper
- INextLibrary

Chants

Drag a file or
folder to the y
bookshelf to / -
make it a target. o

inContents =t} Word |

Drag here
to make the
bookshelf
bigger.

1 1

You can add the target temporarily to search for information when you need it.
If you want to keep the target on the bookshelf permanently, you must save

the change to the bookshelf. When you no longer need a folder as an on-line
reference, you can drag it off the bookshelf to remove it. '

The contents of a target change as you work—so they are always up to date
with the corresponding file or folder in the File Viewer.
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Indexing targets

Start up Digital Librarian.

Select a target from
the bookshelf.

Choose Target from
the Librarian menu.

Choose Inspector from
the Target menu.

Choose Indexing from
the pop-up list at the
top of the panel.

Click Set Up.

Click Update.

Indexes take up space on
your disk. For more
information, see “How the
Index Works” in this chapter.
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You can index your target files to search more quickly. When you index a
target, Librarian creates a list of all the significant words and marks them with
pointers to their location in the file or folder. Then Librarian uses the index to
find your word or phrase quickly. '

You index a target in two stages. First you set up the index. This step creates
an empty index. Then you update the index. This step finds all occurrences
of all the words and records their location in the index. You must index each

target individually. '

__Target inspector

Indexing. 1 Choose Indexing from
this pop-up list.

< Charts

Path: /Net/repertoire/Charts )
P i Click here to set up

/ Index - the index.

1Sl

Set Up Delete

Click here to complete
the index.

. Update

Date: )
Size:
- Owner:

e Periodic Update —————mr

Z"Jupdate every |W"H‘?i7'r'ninhtes T




For information about file
and folder permissions, see
“Permissions Granted” in
Chapter 6 and “Changing
Permissions for a File or
Folder” in Chapter 7.

You can update when you first set up the index or just before you search. You
can also update the index periodically to include new information that you’ve
added to the target folder. Periodic updating is particularly useful for your
home folder, which changes frequently, and for folders with large volumes of
technical information, such as program code, that you may need to refer to as
you work.

) Target Inspector

Indexing dl
{ Charts

Path: /Net/repertoire/Charts

Index
QO
Set Up Delete Update

Date: FridJun0314:42:26 1994
Size: 780.972 KB , ,
Check this option to update an

Owner: ;;a;ry’

index periodically.

Periodic Update — :
Zlupdate every |2§ hours | Type minutes or hours here to
update the target index periodically.

You can index only folders and files that you have permission to read or
write in.
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- How the Index Works

Digital Librarian uses indexes to make searching for
information faster.

What's In an Index

Librarian’s standard indexing scheme creates

- indexes that contain all words of two or more letters
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other than common words such as the, like, and me.
Also, as it indexes a target, Librarian removes all
punctuation except hyphens, apostrophes, and
underscores. A word that contains a hyphen,
apostrophe, or underscore is indexed as a single
word. For example, honky-tonk, is indexed as one
word, not two.

When You Don't Want to Index

You can search targets whether you index them or
not, and in some cases, you may not want to use
an index.

For example, if you want to be able to find every
word, don’tindex the target. Librarian excludes some
words from an index.

Also, indexes occupy disk space. You may not want
to keep a lot of indexes on your disk.

How Much Space It Takes

Indexes are stored in the folder they indexin a hidden
file named .index.store. (See “Displaying UNIX Files”
in Chapter 20 to display hidden files.)

The size of index files depends on several factors,
including the number of files in the folder you index,
the absolute size of the data, the number of distinct
terms, and the distribution of terms. Some folders
and files thus require proportionally larger indexes
than others.

For example, an index for a file that contains ASCII
text may be as large as 30 percent of the size of the
file. An index for a file in Rich Text Format (RTF)
requires less space because formatting characters—
which take up space in the original file—are not
indexed in the index file. An index for your home
folder requires still less space because applications,
Mail messages, and some other types of files are not
indexed at all. ’

If You're a Programmer

If you're a programmer, you can also create your
own custom indexing scheme and use it to index
individual targets on your bookshelf. For more
information, see the NEXTSTEP Developer's Library.

E SRR



Creating a new bookshelf

Start up Digital Librarian.

Choose Bookshelf from
the Librarian menu.

Choose New from the
Bookshelf menu.

Choose Save from the
Bookshelf menu.

Type a name for the
bookshelf and click OK.

For more information about

the commands in the Bookshelf
menu, see “Digital Librarian
Commands” in the Reference at
the end of this book.

If you have a lot of folders that you want to use as on-line references, you may
want to create additional bookshelves to organize them. A bookshelf'is a file
that contains all the information about the targets you add and their indexes.

When you choose New from the Bookshelf menu, a new, empty bookshelf
window opens. When you choose Save, a browser panel opens. You can use it
to type the name of the new bookshelf and choose a folder to put it in.

B e il i

same way you
create any file.

c

gt

List Tles

AM[ifeErRy BooRsHelves: -
- [addresses 1= [ [Librarian bshif [~ Abookshelf is
..~|Bookshelves ™~ ] ;
| Japanese Notebo ~ | - a file w'/th the
| Notebook - e xtension .bshif.
. jid Tupe th
e ——e e the name
<> PR Gy [ yp
[=l>] ' of the new
Name:| Music Archive bookshelf here.

_ﬁ_ﬂ‘ﬁﬂl—g} Cancv‘e‘lyly OK I

Once you create a new bookshelf, you can open it directly from the File
Viewer or you can use the Open command in Librarian’s Bookshelf menu.
You can use the other commands in the Bookshelf menu to save changes to
the bookshelf, revert to a previous version of the bookshelf, and close a
bookshelf window.
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Setting up a search service

Start up Digital Librarian.

Select a target from
a bookshelf.

Choose Target from
the Librarian menu.

Choose Inspector from
the Target menu.

Choose Services from
the pop-up list at the
top of the panel.

Check “Search in.”

Restart your applications.
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If you want to be able to search a folder as you work in another application,
you can set up a search service. For example, if you have a catalog of products,
you may want to be able to refer to the product numbers in memos, reports,
or other documents you create in Edit. If you set up a search service for the
file or files that contain your catalog, you can choose a command from the
Librarian Services menu in Edit or another application to search those files.

You use the Target Inspector to set up a search service.

| Targetinspector

Services il Choose Services from this pop-up list.
Charts

Path: /Net/repertoire/Charts

Services menu items: ——

_1Jotin

V]Search in

Check here to set up a search
service for the target named above.

The next time you start up an application, the Services menu has a Librarian
menu that includes a new command for searching in the target file or folder.
You select a word or phrase in the text of the document you’re working in and
then choose the command. Librarian searches the target for the selected word
and displays the results in the bookshelf window. The command is dimmed if
no text is selected.

You can add as many search services as you want. A new service appears
when you next start up an application or when you log out and log back into
your workspace.



Setting up a jotting service

Start up Digital Librarian.

Add a new folder to one
of your bookshelves.

Choose Target from the
Librarian menu.

Choose Inspector from
the Target menu.

Choose Services from the
pop-up list at the top of
the panel.

Check “Jot in.”

Restart your applications.

Not all applications support
jotting services. For
information, see the user’s
guide for your application.

You can set up a jotting service to save text from other applications in an
indexed folder on your bookshelf. For example, Librarian comes with a folder
called Notebook on the Librarian bookshelf. You can file important bits of
information from other documents in this notebook and search it by topic
when you want to find the information quickly. You can also create additional
notebook folders.

You use the Target Inspector to set up a jotting service.

Services =l

Choose Services from this pop-up list.

gg Prelim Bios

Path: /Net/repettoire/starr/Prelim Bios

v Check here to set up a jotting service
ssfices menu items: —— for the target named above.
Z|Jotin
__|searchin

The next time you start up an application, its Services menu includes a
Librarian command that lists two new commands for jotting in the target file
or folder. One files the currently selected text as an unnamed file in the target
folder. The other files the entire document—or message if you’re using the
Mail application—in the target folder.

You jot in different folders. Just add a jotting service for each folder you want
to jot in. A new service appears when you next start up an application or when
you log out and log back into your workspace.
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Looking up an on-line address

Open the Addresses
folder in your Library
folder.

Double-click an
address book.

Double-click a name
in the address book.

The information in your address
book is used in the Fax panel to
address faxes (but not in Mail,
which has its own address book).
For more information, see

“Updating Fax Addresses” in
Chapter 16.

For information about copying
files, see “Copying a File or
Folder” in Chapter 6.
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Your workspace comes with two built-in address books—the User address
book and an Example address book. If you are working on a network, the
addresses of other users on the network are automatically included in the User
address book. You can also add names and addresses to the Example address
book—to organize your business contacts, for example.

ldresses — ~/Library/Addresses B3

Address book icon

User.addresses
28 addreszes [

You double-click a name in the
address book.

The address
information
appears in an
Inspector panel.

Path: ../Library/Addresses/User.addresses
£ Full Nare: | Kyung Kim [
Kim_ , o M"il]ﬁ__———__—-_- e You can get
¥ilaurier : i : ‘ different kinds
] Fax| ik of information
work Tel: [ aboutthe person
Home Tel:| [ by c_‘hoosmg
! S o options from
<~ Other Information o) 1 this pop-up list.
Coordinator of Autumn Moon Festival in |-
San Francisco :
Rev‘e’n‘

The User address book is a public, read-only address book. It’s stored in
/NextLibrary/Addresses/User.addresses.

The Example address book is your own private file, stored in
~[Library/Addresses/Example.addresses. You can create a new address
book by copying the Example address book the same way you copy any file.



Adding an on-line address

Open the address book.

Choose File from the
Workspace menu.

Choose New Address
from the File menu.

Type a name for the new
address in the icon path.

Double-click the new
address icon.

Type the name and
address information
in the Inspector panel.

For information about the
Inspector, see Chapter 7,
“Inspecting Files and Folders.”

You can add new addresses to your address books and organize the addresses

into groups.

(O] SN = AR RIS IZJ

i

/0

Smith, Jog' £_>. Ramirez, Gloria
. ced

ath: ../Addresses/JS Work.addresses

JS Work.addr... b
13 addresocs < A new icon You type the
’“':"5 : appears with the new name.
r ; name Joe Smith.
JS Work.addres... | Ramirez, Glotia.
‘|Big Daddy Jordan "
Crenshaw, Smiley All addre and group names appear
: gutskin. Rg&' [ in this column—as well as in individual
:::|Estevan, Dido s
IFeliz. pilar - group folders.
“.1James, Betly o
“|Lazlo,Bary . 1
./|Ramirez, Gloria i
.| Sasparilla, Felicia ; Address Inspector When you
Spero, Carmen [ - L double-click the
~|Agents i Contents | o e €W adldress
glﬁiz% i icon, this panel
S U WNEers [t s 3
o ~ Ramlrez Gloria opens.
P

Full Name:| Gloria Ramirez

E-Mail: | gramirez@vocres.com

new address

i '| You type the

information here.

Fax|1-213-552-5552

WorkTel:| 12136525256

Home Te_l:l

Other Infarmation ]

|Agent for Dido Estevan

Reveri ‘

You can add
notes here.

ok«

You can choose New Group from the File menu to create a new group. A group

is a folder in the address book. You add addresses—or other groups—to a
group by dragging them into the group the same way you drag a file into a

folder in the File Viewer. You can then use the Inspector to sort addresses in

the group and record information about it.
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If your computer is connected to a network, you can use the Mail application to
exchange messages with others on the network. The messages can be in a number of
Jormats. They can be simple text, or they can include files and folders, graphics,

and even sound recordings. The Mail application is in your dock.

| OMpa

To:[BluePlanet_sF

Subject:| Big Concert Friday!

Ce:| sammi_wright@globalvoice.com, poupon

Cof

fie K
Deliv

Fa b H A
s

Forward

 Reply &I

1 Lip Service | Addresses © NeXTMail | No Receipt

Hey Everybody!

Don’t forget that this Friday night is the first-ever Bay Area
appearance of recent Blue Planet “sighee™ and scat sensation

Dido Estevan
8:00 PM at the Sweetwater Pavilion

== - Come early for press hour and hors d’oeuvres
1 (don’t forget your badges).

P.S. Whoops, | almost forgot—here are directions
to the Pavilion.

| Active.mbox

 Maihoxes |

Lunch Spol
Materials fc
Big Concer
WVoiceovers
Pragram me
Sprecht inte

0600

 preliminary designs
|applauds. As for the
- pfore we can send tt

_that won't slow you

L E

AU revoir

[look fonward much to seeing you again at this year’s fes



Starting up Mail
Opening messages

Opening a file or folder
in a message

Listening to a recording
Sending a message

Sending a MIME or
plain text message

Attaching afile or folder
Saving a draft
Restoring a draft
Forwarding a message
Replying to a message

Recording and inserting
sound in a message

Editing sound

Getting and
Sending Mail

You have to get a package to Stockholm—tomorrow.
You have the copy, photographs of the musicians, a
cassette tape of releases, and a letter laying out specs
for the brochure.

You pack it all up in a box wrapped over and over in
thick plastic tape, the kind that’s impossible to cut
without a serious pair of scissors. Then you get to the
post office—and just miss overnight delivery.

Later at dinner, a friend tells you what she would
have done—type the letter in her computer, drag
scanned images into the letter along with the copy,
even record samples of the tape and stick #em in the
letter, too. It’d be in Stockholm within minutes.

When you drop her off, she hopes you’ll come in for
a while. You hope she keeps her computer at home.
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Starting up Mail

Double-click the Mailicon
in the application dock.

Or

Open the /NextApps
folder in the File Viewer
and then double-click
Mail.app.

You can also use the Mail
application by choosing a
command from an application’s
Services menu. See “Standard
Commands” in the Reference
at the end of this book.
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. The Mail application is a tool for exchanging electronic messages with other

people over a network or with others who have home folders in your computer.

When Mail starts up, a window displays the contents of your Active mailbox.
The Active mailbox is where all new messages are delivered to you.

Active.mbox

v

< /1 &gﬂ
SN~
Compos:

NS

. Delete

o ;SNI}

A one-line summary

Mailboxes
32 May 29 Anne Winn Lunch Spols

®A 33 Junot Pierre Poupon

Materials for festival program

of each message you

®A 34 Juno1l AnneWinn
®A 35 Junoil MoxBasil
®M 36 Junoz UriKohn
@ 37 Jun03 UriKohn

Big Concert Friday!
Yoiceovers for TV promo
Program materials

f TR p

Bl \

_Sprechtinterview on BBC

receive appears in the
summary area.

N\

, Drag to see more or fewer
: summaries at once.

When a Mailbox Is Already in Use

If a panel warns that your mailbox
is locked when Mail starts up, one
of two things is going on:

* Your Active mailbox is open
on another computer on the
network. Click Cancel in the
panel so the mailbox doesn’t
open on this computer.

* Your last Mail session ended
abnormally, because of a power
failure, for example. The mailbox
isn’t open anywhere else so you
can click OK to open it now.

When working on a network,
don't open the same mailbox on
more than one computer at once
or you might lose mail from that
mailbox. If you tend to log into
several computers and you've set
Mail to start up automatically, you
should set it to start up hidden,
which prevents your Active
mailbox from opening at startup.
Choose Preferences from Mail's
Info menu, and then check the
Hide on Auto-Launch box in the
Preferences panel.



Opening messages

1 Select the message Messages you receive are listed in the summary area of your Active mailbox.
you want to look at You select a message in the summary area to open the message and see its
by clicking it in the contents below.
summary area.

. Click to step Active.mbox Sender’s
2 Click the large down through T pa— icture
: {r 1) A P
arrow button to select messages. —»\~\-:__ ® N gm-ﬁ T E
the next message, or click A " D e’ Delete Compose | _Maikoxes find L{;g;l\ :
the up arrow to select marks a'th I 32_Way 25_Anne vinn Tunch Spots . Date and time
. message wi =3 A 33 _Junol_ Pierre Poupon Materials for festival program the message
the previous one. formatting, e[ <3 32 Juno1 Anne winn Big Concert Friday!
graphics, or A 35 Junot  MaxBasil Yoiceovers for TV promo was sent
4 Allem 35 Junoz UriKoehn Program materials
other Adid 37 Juno3d  UriKohn Sprechtinterview on BBC
attachments. Date: Mon, 1 Jun 94 03:20.02 GMT-0800 1 The
Fﬂm: poupon (Pierre Poupan) message
T gre :
Q mar ksd_-/ St ;.jgecty_: Materials for festival program area shows
an unrea (‘AJ1 laurier, mathieu, bourget, starr ’ the current
message. Bdhjour, Kayal i message.
€ JLLrdceived the fax yesterday with the preliminary designs for the festival program and have
M marks a pra sed lhemearouxd hzrre. éveryunzgpplat]dsyﬁs 10?319 photug?a;;hs ypougvequested, I'm
MIME message afraid itwill be the end of the week before we can send them to you. M. Laurier in our legal
with formatﬁng department has to clear them. | hope that wont slow you down.
or attachments. 1 look forward much ta seeing you again at this year's festivall
Au revoir
"
v ' . J

You can hide Mail when you’re done reading messages. As long as Mail is
running, its icon in the dock shows if you have new messages.
To: preceding an address in
a message summary marks Y p Number of unread I3 7T
a message you sent. See - messages ?
“Sending a Message” in

this chapter. ; New messages . No new messages

For information on MIME
message, see “MIME
Messages and Encoded
Attachments” in this chapter.

Shortcuts from the Keyboard

You can get a sound signal

k You can also open messages by * Hold down Alternate and press
when new messages arrive. typing: the down arrow key to scroll to the
See “Setting a Sound to next “page” in a message. When
Announce New Messages” * To open the next message, press you get to the end of a message,
in Chapter 14, Return or the down arrow key. Alternate-down arrow opens the
If you don't see the sender’s « To open the previous message, next message. Press Alternate-up

. n som hold down Shift and press Return, arrow to similarly scroll to the
PIcture, ask your sy or press the up arrow key. previous page or message.

administrator to set up Mail
to show pictures.
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koptions forkShowing Information about Messages ;

Here are some options for displaying information
about messages in a mailbox window.
Show Message Totals and Sizes

You can see the size of each message and the
total size of all messages in the mailbox. Just
choose Show Sizes from the Mailbox menu.

37 messages (220KE)

‘ The Show Sizes
; ¥ command
“wy4~11  displays the
Svn total number of
Delete Compuse || [11€5Sages in the
F50KB) i mal'lbox an d
32 May2s Anmewmn ., theirtotal size.
A 33 Juno0i Pierre Poupon
34 - Junot! - Anne Winn
35 Juno1. Max Basil

Lunch Spots |~ 4.8KB"
Materials for festival program 27KB |
Big Cancert Friday! 3.7KB
Voiceovers for TV promo 0.9KB
Program materials- ‘ 29KB
Las

__ Sprechtinterview on BBC

You also see the size of each individual message,
including any files or other attachments in it.

If you've recently deleted messages, information
about them might appear, too. See “Compacting
a Mailbox to Free Disk Space” in Chapter 14.

You can have all mailbox windows report message
totals—with or without sizes—using the Preferences
command in the Info menu. For information, see

“Mail Buttons and Commands” in the Reference at
the end of this book.

Mark a Message as Unread

If you've opened a message, you can mark it with a

1 so it looks like you haven't opened it. You might do
this if you don't plan to read the message until later.
Choose Mark as Unread from the Message menu.

Select a messagem—="A 33 Juno1

; Pierre Poupon
you've opened. oA 34 Junoi

Anne Winn |

Choose Mark ¢ A 33 Jun01 Pierre Poupon
as Unread and ©A 34 Junot AnneWinn |

a o appears.

Show Additional Headers In a Message

Each message you receive includes information
about who sent the message and when. This
information is at the top of the message, in fields
called headers.

You can show additional headers that provide tech-
nical information about the message by choosing
Show All Headers from the Message menu.

A system administrator might show all headers to see
the exact path a message traveled over the network.

From: poupon Mon Jun 103:20:02 1994 7
Retum-Path: <Plerre_Poupon>

Date: Mon, 1 Jun 84 03:20:02 GMT-0800

Received: from bp by repertoire blues com (NX5.67e/NeXT0. 1-Aleph-bf) id AA 11408;
Mon, 1Jun 84 03:19:67 -0800

& From: poupon (Pierre Poupon)

Message-ld: <9405 160031.AA24 190@pb.blues.com>

Received: by france (NX5.67d/NX3.0X) id AA00340; Mon, 1 June 94 03:19:56 -0800
Date: Mon, 1Jun 94 03:19:56 GMT-0800

Received: by NeXT.Mailer(1.100)

Received: by NeXT Mailer(1.100)

|- To: grey

| Subject: Materials for festival program

Ce: laurier, mathieu, bourget, starr

Bonjour, Kaya!

I received the fax yesterday with the preliminary designs for the festival program and have
passed them around here. Everyone applauds. As for the photographs you requested, I'm

i
¥{ afraid itwill be the end of the week hefore we can send them to you. M. Laurier in our legal

You can use Mail’s Preferences command to choose
which headers appear in all your messages. You can
also create headers for messages you send. See
“Tailoring Headers in Messages You Receive” and
“Creating Headers for Messages You Send” in
Chapter 14. B




Opening a file or folder in a message

» Double-click the file or You might receive a message with a file attached to it—or a folder containing
folder in the message. several files. The file or folder appears as an icon that you can double-click to
see its contents.

1 O+ &

A file opens in its
associated application.

Delete Find

= FesuvaiCopy.nit — _ive.mbox/Program_materials.attach

32 May29 Anne winn Lunch Spots Berhanit Sprecht
«d A 33 Junoi Pietre Poupon Matestals for festival program ;"h?ﬂh;umeﬂ Suﬂ:v*;:;e:lmm of all tme,
) . . err Sprechtreturns to the Blue Planet stage
el A 34 Junot! Anne er\n Big Concert Friday! conducting bis famous Swing Jugend orchestra.
A 35 Junol MaxBasil Voiceavers for TV promo .
- Blaue Reiter
Al M 38 Junoz2 UriKohn Program materials Heavy mecal Blues? These guys are ouxageous, ugly,
[ ¥ e 37 Juno03 UriKohn Sprecht interview on BBC beautiful, and just out for a good dme. And yeu
(4 thought spandex was going out of style!

Date: Tue, 2 Jun 94 14:10:54 GMT-0800
From: kohn (Uri Kohn)

To: grey

Subject: Program materials

Eva Deitz
-] Jazz violinist Eva Deitz blends the artiswy and

1 precision of 2 classical master with the romance and
freeform magic of her genre,

<

Dear Kaya:

Enclosed is the text for the German portion of the festival program:

Also, | am including the TIFF files containing the three photagraphs you requested. We
have rights to all three of these, so use them however you wish. We would, of course, like
to see a proof of the pragram before you send itto your printer.

- a1 Photos — ~/Mailboxes/Active.mbox/Program_materials.atiach A folder opens in its
: e oW Workspace
Manager folder window.

eI,

Elaue Redert
Eva Dletzo tif
Sprechti

You can edit the contents of the file and save your changes. If you then send
the message to anyone else—for example, by forwarding it—the file with your

_ changes goes with it.
Edits you make to a file

that’s attached toa MIME If you want to keep a copy of the file or folder, drag it out of the mailbox
message—one with an M window to one of your folders in the File Viewer. You can also drag a graphic

NEXL L0 Its summary—arent image out of the window to keep a copy of it.
saved with the message.

When you forward the 1| When you drag a
message or open another - TIFFE lL graphic image out
one, your edits are lost. | # ’ of the window, its
For information on MIME ' - __] m f file icon appears.

messages, see “MIME
Messages and Encoded
Attachments” in this chapter.
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Listening to a recording

1 Double-click the sound You might receive a sound recording in a message. The recording appears as
icon in the message. an icon. If your computer can play sounds, you can play back the recording.

2 Click Play in the Lip
Service panel.

N N:u:v—e._mho;i

__—‘S' X ik [:2\ §MDN
i ‘g’ - Deets | " Compise | - Mailhoes  Fnd EiJ“‘—J”
32 Mayz9 Anne winn R LCnch Spats
wf A 33 Juno1- Pierre Poupon * - Materials for festival program
e A 34 Junot Anne Winn ; Big Concer Friday!
A 35 Junoi MaxBasil Voiceovers for TV prome 1
|AjloM 36 Junoz. UriKohn Program materials i
[ Y] 37 Juno03 UriKohn . Sprechtinterview on BBC N

Date: Mon, 1 Jun 94 13:46:50 GMT-0800
From: basil (Max Basil)

To: grey

Subject: Voiceovers for TV promo

Cc: creative, starr

Kaya,
I've sifted through all the available voice people and have narrowed the list down to three

possibilities for the voiceovers an the television promo spots for the festival. Could you
listen to these clips and cast your vote? | need to hear from you by the end of the day.

<> Sarah Rail (my first choicel)
<= pearl Jackson

| ‘e\ Al Soriano When you double-click

L Best, a sound icon, the Lip

. Service panel opens.
Med Becil pancl p

<

Click to play the recording.

Lip Service

During playback, this
meter indicates the sound

S ’ R g level of the recording.
S B
~Stop \ Play Pause\ﬁecord Erase Inzert
N N
Click to stop playback Click to pause during playback.
before the end. Click again to resume.

The buttons in the Lip Service™ panel work like those on a standard
tape recorder.

You can adjust the speaker
volume with the Preferences
application’s Sound Preferences.
See “Adjusting Volume and
Input Gain” in Chapter 21.
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; MIME Messages and Encoded Attachments

In addition to messages from NEXTSTEP computers,
you can receive formatted MIME messages and
encoded attachments in plain text messages from
other kinds of computers.

What Is a MIVIE Message?

A MIME message is a message that people using
different kinds of computers can use to exchange
formatted text, images, sound, files, folders, and
even video attachments. MIME is the set of technical
formats that makes this possible. It stands for
Multipurpose Internet Mail Extensions.

To maximize the variety of computers that can
display a message properly, MIME messages often
provide multiple representations of their contents—
each in a different format. For example, a message
might include a plain text and formatted version of
the same text, or two versions of the same file
attachment. When you open the message, Mail
usually shows you just one version of its contents—
the one that Mail displays the best.

If a MIME Message Doesn’t Look Right

If any part of a MIME message is in a format Mail
can't display properly, that part may appear as
unintelligible text.

When this happens, you can see the plainest version
of a message—the one most likely to be readable—
by choosing Show First Alternative from the MIME
menu. To see the entire message—including multiple
versions of the same contents—choose Show All
Alternatives. For more information, see “MIME
Menu"” in “Mail Buttons and Commands” in the
Reference at the end of this book.

If a MIME Message Has Been Split

You might receive a MIME message that's split into
pieces, for example, if it's otherwise too large to go
through a gateway between networks. The pieces
appear as separate messages in your mailbox

4

window. To assemble the pieces, select their
summaries—either by dragging or by holding down
the Shift key and clicking each one. Then choose
Combine Messages from the MIME menu. The
pieces are replaced by the assembled message.

Retrieve a Remote MIME Attachment

Anicon that looks like the one below represents a file
or folder that's not actually in the message. Instead,
the icon is a pointer to a file or folder that resides
somewhere else on yours or another network.

. An external attachment
in a MIME message

Someone might send a pointer if the real file or folder
is very large, especially if they're sending it to a large
number of people. To see the actual file or folder,
double-click the icon. A panel asks if you want to
retrieve the attachment. Click OK and one of three
things happens:

» The file or folder opens in your workspace.

_» Apanelasks you to log into the network where the

file or folder resides. You must have a password to
log into that network. After you log in, the file or
folder opens in your workspace.

» The file or folder arrives in a separate message.

Decode a Plain Text Attachment

Unintelligible text in a message might be a file that's
been encoded with the UNIX uuencode command.
You might receive such a file from a computer that
can't send NEXTSTEP or MIME messages.

You can see the actual file by selecting the message
summary and choosing Decode Foreign Attachment
from the Message menu. The Workspace Manager
opens a folder window that contains a temporary
copy of the file. To keep your own copy, you must
drag it into another folder.
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Sending a message

Click the Compose You can send a message to one person, a group of people, or a combination of
button in a mailbox individuals and groups. You address the message directly to at least one person
window.

or group. You can also send a “carbon copy” to anyone else who should see the
group 1% Y

Address the message
and type a brief summary
of its subject.

Compose your message.

Click the Deliver button.

For a summary of the buttons
in a Compose window, see

“Mail Buttons and Commands”
in the Reference at the end of
this book.

If your message is particularly
large, a panel may tell you so
when you try to deliver it. For
information, see “Expert
Preferences” in Chapter 14.
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message. You address and compose a message in a Compose window.

Cﬂmpﬂse—BiQ m'lﬂertfmlayl e

Enter at least one

- To;|BluePlanet SF

address here.

subject: Big Concert Friday!

S Ce |samm| wnght@glubalvmce com, poupon

} Deliver - :‘Lip Service | ' Addresses | ' Reply &lf . Forward

- NeXT Mail

A \ Type a brief
summary here.

\ Send carbon copies by

:No Receipt

Hey Everybody!!!

Dido Estevan
8:00 pm at the Sweetwater Pavilion

(don’t forget your badges).

Don’t forget that this Friday night is the first-ever Bay Area
1] appearance of recent Blue Planet “sighee” and scat sensation

Come early for press hour and hors d’oeuvres

: entering addresses here.
Separate addresses with
a comma or a space.

= Compose the
message here.

Click to deliver

e

What'’s an Address?

A person’s address is usually his or
her user name. Your system-
administrator may also have set up
group addresses, such as publicity,

that you can use to send a message
to a specific group of people.

You can look up the address of a

person or a group on your network .

with the Addresses panel. See
" “Looking Up Mail Addresses” in
Chapter 14.

the message.

_To send a message to someone on

another network, you use an
address that includes information
about the network. Such an address
might look like jstarr@blues.com.

A person’s address appears at the -
top of any message that person
sends you. You can quickly reply
to that address by using the Reply
button. See “Replying to a
Message” in this chapter.




You can type your message, set fonts, and make ruler settings just as in any
standard document, such as an Edit document. To add a graphic image, drag
a'TIFF or EPSfile into the message from the File Viewer or from another Mail
window. You can also paste text or images copied from a Mail window or from
another application.

- When you set fonts, make ruler settings, or add

; o / images, a triangle reminds you to send the message
TN 7 only to people whose computers can display

i NEXTSTEP or MIME messages. :

Deliver

When you send a graphic image in a message, Mail delivers a copy of the
image. The file that contains the original remains where you dragged it from.

If you change your mind about sending a graphic, you can delete it just as you
would delete text—for example, by pressing Backspace to back up over it.

When you send a message to yourself—for example, by including your
address in the Cc field—the summary that appears in your mailbox window
when you receive the message lists who you sent the message to, instead of
your address, as in To: starr.

Shortcuts Typing Addresses

You can type part of an address and  window or in the Send Options
press Escape to have Mail fillinthe  panel. Mail can fill in any address
rest. Try this in a field in a Compose  that's listed in the Addresses panel.

Type the first few characters
of the address.

T ! - — e i
Press Escape and Mail fills TOM’?&WEH - - I
in an address from the ' ' —

Addresses panel.

Press Escape again and Mail fills
in another address that begins
with the same characters. o

For more information on typing,
formatting, and adding images,
see Chapter 9, “Iyping and ‘ S
Editing,” and “Adding a Pl
Graphic Image” in Chapter 11. Ll
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Sending a MIME or plain text message

To send a message to
anyone whose computer
can display MIME
messages, select the
MIME Mail format and
compose the message,
including formatting

and attachments.

To send a message to
anyone whose computer
can'’t display NEXTSTEP
or MIME messages,
select Plain Text and
type a message with

no formatting or
attachments.

Some computers that can
display MIME messages
can’t display certain types of
formatting and attachments.
Check with recipients to find
out what their computers
can display.

You can change the maximum
line length of plain text
messages. See “Expert
Preferences” in Chapter 14.
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You can send your message to people usirig non-NEXTSTEP computers.
If the computers can receive MIME messages, you can include formatting,
graphics, and attachments. Otherwise, you must type a plain text message.

Click this button in a Compose window to select a format for your
message. As you click, the button switches among three formats.

i Forward’

LN
- NeXT Mail

Use this format to send
the message to
NEXTSTEP computers.

Use this one to send formatted
messages to computers that
can display MIME messages.

Phain Text

Use this one to send plain
text messages to other
non-NEXTSTEP computers.

Caution: Formatting, graphics, sounds, or file or folder attachments generate
unintelligible messages on computers that cant display NEXTSTEP or MIME
messages. If your message is going to such a computer, choose the plain text format.

' : When you select the Plain Text

o length is limited to 70 characters

- such as fonts, ruler settings, or

L What Is a Plam Text Message?

- As you type your message, lines
o Wformat in a Compose window, text
©in your message appears in a fixed-
- width font, such as Courier, and line - ,
reqmred by the recelvmg computer

If you've added any formattklng, Yok
- characters in a plam text message
‘Mail converts any other characters
- to ASCII. For example, it converts
‘anemdash (—)toahyphen(-).

~ attachments, they're removed—
~ but they come back if you choose
the NeXT Mail or MIME Mail format.

“wrap” as usual. But when you send : ‘
the message, Return characters are
added to the ends of lines, as

You should include only Ascl




" Press here to choose a type of address.

Options for Sending Messages

You can set options for a message you send. When
working in a Compose window, choose Send
Options from the Message menu. Then make the
following settings in the Send Options panel.

You can select options for all messages you send
with the Preferences command in the Info menu. See
“Preferences for Messages You Send” in Chapter 14.

You can also use the Send Options panel to select a
header you've created. See “Creating Headers for
Messages You Send” in Chapter 14.

Enter a Long List of Addresses

The Send Options panel has a large area for listing
more addresses than can fit in a Compose window
field. Press the button at the top of the panel to
choose To or Cc—whichever field you want to enter
addresses in. Type the addresses in the panel and
press Return to enter them in the Compose window.

Send a Hidden Copy of a Message

You can send a copy of a message to one or more
addresses without other recipients knowing it.
Choose Bcc (“blind carbon copy”) from the pop-up
list at the top of the Send Options panel. Type the

Settings you make in the Send Options
panel apply only to the message in your

addresses in the panel and press Return. A copy of
the message goes to the addresses, but no other
recipients know because the Bcc list doesn't appear
in the message.

Reroute Replies

You can have replies to your message go to one

or more addresses other than your own. Type the
addresses in the Reply-To field. When recipients
click Reply in their mailbox window to reply to your
message, any address you type here is inserted in
their To field. If you also want a reply, type your
address here, too. See “Replying to a Message” in
this chapter.

Archive a Copy of the Message

You can save a copy of a message you send by
checking “Archive in Outgoing mailbox.” Mail
creates a mailbox named Outgoing and puts the
copy in it.

As a shortcut, you can hold down the Alternate key
and click Deliver in the Compose window to archive
the message. Or if you've used the Preferences
command to archive all messages, Control-click
Deliver to not archive this message.

Send Options

current Compose window.

tarr, s

Type a list of addresses here. Separate
addresses with a comma or a space.

o oEniit:

nternational, publicity, marketing

address Fields

ammi_wright@globalvoice.com, creative,

Type the address of any person or group
who should receive replies to the message.

Reply-To: | pliblicity A

Check this box to save a copy of the

message in your Outgoing mailbox. RS
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Attaching a file or folder

Click in the Compose
window where you
want the file or folder
to appear.

In the Workspace
Manager’s File Viewer,
select the file or folder
you want to send.

Drag the selection from
the File Viewer’s icon
path into the Compose
window.

A link you send in a Mail
message is just like one you
create in the File Viewer. For
information, see “What Is a
Link?” in Chapter 6.
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You can include a file or even an entire folder in a message. Just drag the file or
folder from the File Viewer. Drag a selection icon into your message to attach
all the files and folders in the selection. You can also copy or drag a file or folder
from another Compose window or from a mailbox window.

To:[BluePlanet_SF i [

Suplect{Big ConcerlFridey! ot A triangle reminds you
: o to send the message
only to people whose

W ; computer can display
: ‘Delkver 3L Lip Servics: ‘ NEXTSTEP or MIME
N : messages.

Dido Estevan
8:00 pm at the Sweetwater Pavilion

Come early for press hour and hors d'oeuvres
(don’t forget your badges).

Aeilidin

P.S. Whoops, I almost forgot—here are directions
to the pavilion.

Drag a file or folder
from the File Viewer.

ok

The file or folder appears
where you last clicked or
in place of the current
selection.

|
|
1
|

When you click Deliver, Mail delivers a copy of the file or folder. The original
remains wherever you dragged or copied it from.

If you change your mind about attaching a file or folder, you can delete it from
the message, for example, by pressing the Backspace key to back up over it.

Tip: If a file or folder takes up a lot of disk space, you should send a link to it
rather than sending the actual file or folder—especially if you’re sending it to
a large number of people. Just hold down the Control key while dragging the
file or folder into the Compose window.



For more information on
the UNIX uuencode and
uudecode commands, see
the UNIX manual pages
for these commands. .

You can send a file or folder attachment to any computer that can receive
NEXTSTEP or MIME messages. To send a file or folder to other computers,
you must instead select the Plain Text format and paste an encoded version of

the file or folder in your message.

To[BluePlanet SF
Subject | Big Concert Fridayl _

Co:[ sammi_wright@globalvoice.com, poupon

s Py . Pt
-‘ g N Aot
e 4 \ﬁi 2 W <L/ R
i - .
Deliver Lip Service Addresses Feply &t Forward Plain text No Recelpt

Dido Estevan

8:80 pm at the Sweetwatgf Pavillion

5 Paste File

You can't add attachments to a plain text séage. Do you want to _:1
paste the attachment’s pathname or its p/icoded contents?

Click here until you select
Plain Text.

Drag a file or folder into
the message.

A panel provides a few
options.

Click here to paste an
encoded version of the
attachment in your message.

Ccancel | Paste Encodéd C‘omea’mts\' " Paste Pathname - C‘—]‘-— Click here to paste the full

pathname of the attachment.

When you click Paste Encoded Contents, Mail inserts a block of unintelligible
text that is your attachment encoded with the UNIX uuencode command.
The recipient of your message can “decode” the attachment using the UNIX

uudecode command.

Caution: File or folder icons in a message generate unintelligible messages on
computers that can't display NEXTSTEP or MIME messages. To make sure that
recipients can read your message, choose the Plain Text format and send either

a pathname or an encoded version of the file or folder.
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Saving a draft

1 Choose Compose from

the Mail menu.

2 Choose Drafts from the

Compose menu.

3 Choose Save in Drafts
from the Drafts menu.

Remember to delete drafts

you don’t need anymore from

the Drafts mailbox so they
don’t take up disk space.

See “Deleting Messages” in

Chapter 14.
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You can save the contents of a message you’re composing, much as you save
the contents of a document. You might do this when composing a message you
want to finish later or to save versions of a message as you type it.

You can choose Save in Drafts by

typing Command-s, just as when
saving changes to a document.

To: [ BluePlanet_SF
Subject: | Big Concert Friday!
Cc:l sgmmI_\J{(Ight@globalvolce,com, poupon

g
3 o~
AEw

: Mail saves the contents
of your Compose window
as a message in the Drafts

Bty Al

“Lip Service | ' Addresses

117 - mailbox, which it creates
Hey Everybody!!! for you
Don'’t forget that this Friday night is the first-ever Bay Area
c} appearance of recent Blue Planet “signee” and scat sensation \
Dido Estevan ‘ \ The subject and addresses
8:00 pm at the Sweetwater Pavilion you've typed are saved, too.

Come early for press hour and hors d’oeuvres
(don’t forget your badges).

At

If you close a Compose window without saving or delivering it, a panel asks if
you want to save your draft before closing it. If you click Save, the message is
saved in your Drafts mailbox.

Al
Y

Each time you save a draft, Mail saves another version of the message in the
Drafts mailbox—it doesn’t replace the last version you saved.



Restoring a draft

To restore the last draft You can restore the last draft of a message you saved so you can resume

you saved, open the working in it. Just choose the Restore Draft command. A Compose window
Compose menu and opens that contains your draft, exactly as when you last saved it.

choose Restore Draft

from the Drafts menu. Restore Draft restores the

last message you saved,

To:l BluePlanet SF i e b if he D ft .Ib
To restore an earlier draft, Subject|Big Concert Friday! — ’es\;e'?o‘ gne rafts mailbox
open the Drafts mailbox, Ce samml_wright@glotalvaice. : pen

r g 1‘, L ‘ S
select the message, and <y \?«Q” @
Choose ReStore Draﬂ' i Deliver ‘ilin Service ijMdressea Reply 4l : .
, Mail opens a Compose
Hey Everybodyl /! —a e window containing the draft.

‘ Don't forget that this Friday night is the first-ever Bay Area
¢] appearance of recent Blue Planet “signee” and scat sensation

Dido Estevan \ Mail restores your addresses
8:00 pm at the Sweetwater Pavilicn and subject, too.

ke Come early for press hour and hors d’oeuvres
i (don’t forget your badges).

: _
% (oo :

To restore an earlier draft, you must open the Drafts mailbox, select the
message summary of the draft you want to restore, and choose Restore Draft.

You open the Drafts mailbox
‘using the Mailboxes panel. For
information, see “Organizing
Messages in Mailboxes” in
Chapter 14.
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Forwarding a message

Open the message. You can quickly forward a message to others who may want to read it.

Click the Compose Click to copy the current
button in the mailbox message and its subject
window. into a Compose window.

Click Forward in the
Compose window.

Hiall you guys outthere In publicity fand! Fill in the addresses.

Address the message.

Max is about to make the final choice of the voice to do our TV spots for the festival, but [
thought you should getto vote, too. Here are the finalists. (I vote for Pearl Jackson. She’s
gotthat great gravelly voice, but she sounds like she really cares—which Is what this

festival’s all about, right?) \ ) »
% Insert anything you want
: to add to the message.

Begin forwarded message:

Click Deliver.

Date: Mon, 1 Jun 94 13:46:50 GMT-0800
From: basil (Max Basil)

To: grey
Subject: Voiceovers for TV promo

Cc: creative, starr

Mail adds information
about where the
message came from.

Kaya,

I've sifted through all the available volce people and have narrowed the list dowh fo three
possibilities for the voiceovers on the television pramo spots for the festival. Could you
listen to these clips and cast your vote? I need to hear from you by the end of the day.

€= Sarah Rail (my first choicel)
<@ Pearl Jackson
> Al Soriano

Best,

Mo Bt

You can forward several messages all in the same message. Just open each
message in your mailbox window and click Forward in the Compose window.
Each message is inserted following anything that’s already there.

When you copy a message into a Compose window with the Forward button,
all formatting is copied, too, as well as any recordings, graphics, or file or -
folder attachments.

You can also forward a message

by choosing Forward from the

Compose menu. And you can

remove formatting from a

message you're forwarding

by choosing Make ASCII from

the Compose menu. See “Mail

Buttons and Commands” in

the Reference at the end of

this book.
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Replying to a message

Open the message.

Click the Compose
button in the mailbox
window.

Click Reply in the
Compose window.

Click Reply All to

also send the reply

to those who received
a carbon copy of the
original message.

Type your reply.
Click Deliver.

You can also reply to a message
by choosing Reply or Reply All
from the Compose menu. See

“Mail Buttons and Commands”
in the Reference at the end of
this book.

If the sender used the Send
Options command to route your
reply toanaddress other than his
or her own, clicking Reply fills
the To field with that address.
See “Options for Sending
Messages” in this chapter.

If you want to reply to a message, you can quickly copy the sender’s address
and subject into a Compose window. Just click the Reply button in your

Compose window. To copy the addresses listed in the original message’s Cc
field, click the button again.

Covhpnsé — Re: Materials for feélivaivglfaﬁrah{ )
To:|poup0n(ﬁierre Poupon) / ]
Subject [Re: Mageriaior festival program /

Ce:[grey, Jaulyy, m‘.‘&igﬁuurget, starr
30| =
R g/ ?}r

Deliver Forward NeXT Mait
" | Bonjour Pierre!

i&mi' Q.’:’-h?‘ £
N\

Friday is fine for your photographs, but dont keep me waiting any longer, okay? Also, it
I would be great if you could get me the text before then.

“1 A vendredi,

e

The Reply button
alternates between
Reply and Reply All
when you click it.

Reply fills these fields.
Reply All fills this one.

You just type your reply.

Tip: Use Forward and Reply together to include a copy of the message you’re
responding to. If recipients of your message do the same thing, their replies
will contain all earlier messages in the exchange, and a message history grows.
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Recording and inserting sound in a message

Click the Lip Service
button in a Compose
window.

Click Record in the

Lip Service panel and
record through your
computer’s microphone.

Click Stop when you're
done.

Click in the Compose
window where you want
the sound icon to appear.

Click Insert.

You can adjust the sensitivity
of your microphone with the
Preferences application’s
Sound Preferences. See

“Adjusting Volume and Input
Gain” in Chapter 21.

For more information on
using a microphone with your
computer, see the owner’s
guide for the computer or for
any devices you’ve attached
toit.
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If your computer can record sounds, you can include a sound recording in
a message.

" Compose — Check out this voice!

‘ To:| starr o -
Subject:[Check outthis voice! Click to open the Lip
cef / Service panel.

4 Reply 4 * Forvard |

Addresses

i mme The sound icon is inserted
where you last clicked.

| Hey Jason,

This Dido Estevan s far out! | ook this off his new CD Cosmic Percussions €=,
1know he’s new talentNqut | think we should schedule him more prime time in the festival,
if you know what | mean. Wge early evening on day 2.

Let me know what you think,

e "“f"”]m

The triangle reminds you to
send the message only to
people whose computers
can display NEXTSTEP or
MIME messages.

This meter indicates the
recording’s sound level.

,DD ‘: %

Stop . - Play Pause .. Record . . Erase < Insert
. N 7
Click when you're Click to insert the recording
done recording. into your message.

You can use the Play button to play back your recording before inserting it. If
you don’t like the recording, just record over it or click Erase. You can also close
the Lip Service panel without inserting the recording. Unless you erase it, the
recording will be there when you next open the panel.

If you change your mind about sending a rcéording after you insert it delete
the sound icon, for example, by pressing Backspace to back up over it.



Editing sound

Double-click the sound
icon.

Click the waveform
button in the Lip
Service panel.

Select a portion of
the waveform or click
somewhere in it.

Use Edit menu
commands to edit
the waveform. Or
click Record to insert
new material.

Click Play to listen to
the result..

You can edit a recording you’ve made or received by modifying its waveform
in the Lip Service panel.

’—_-——T'W ™M Click to display the
: waveform for the
] current sound. Click
— again to hide the
[_ l > | |T | | N | \/ waveform.
Stop Play Pause Record Erase Insert

Scroll to see the
entire waveform.

PPt P
ey

<> c S

[} 1

Resize to see more of
the waveform at once.

You can select a segment of the waveform. Then click Play to play back the
segment. Click Record to record over it. Or choose Cut or Copy from the Edit
menu to move or copy it.

u*\uw«
N W’W

Drag across the waveform
to select a segment of it.

=

You can also click in the waveform where you want to insert new material.
Then click Record to record the material, or choose Paste to insert a segment
you cut or copied.

An insertion point appears
where you click.

Caution: The Erase button erases the entire recording, even when only a segment
is selected.
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The Mail application has tools to help you manage your messages—including

matlboxes for storing messages you want to kecp and a special Mail address book

that mates it easy to address your messages. And like other NEXTSTEP

applications, Mail can be tailored to your needs.

Mailhoxes = BX

Active
Festival |

Addresses

MName: | Festival [ =t

~ Delete

Gabriella_Rosa

{Harmany_Hohner

Jan_Baorg

Mev ]

l ransferﬁ;'ﬂ %

Opeh

Name:| Jason_starr

Date: Mon, 1

TR

— Additional Outgoing Headsrs -

From: grey (K
To: starr

Subject: Brigl
Cc: grey, basi

Howdy Jason

Here’s our fin
the country la

| she’s about. ¥

s
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Deleting messages

Compacting a mailbox
to free disk space

Looking up Mail
addresses

Creating a Mail address
book

Creating your own
group address

Organizing messages
in mailboxes

Finding a message

Focusing on a group of
messages

Tailoring how you
get new messages

Setting a sound to
announce new
messages

Creating headers for
messages you send

Tailoring headers in
messages you receive

Managing the
Mail Application

You’re getting ready for a meeting with your new boss,
and you can’t find last week’s sales report. You’ve looked
everywhere. You check to make sure no one’s around and
start digging through the trash. You’re elbow-deep in |
yesterday’s lunch when your boss walks in. She’s 20
minutes early.

T'he alarm sounds and you wake up with a feeling
of relief. You got that report last week in a Mail
message and put it in your Reports mailbox. You’ll
just do a search for messages dated last Friday and
forward the report to your boss. It won’t take more
than a second to look up her address.

Later that morning, your computer beeps to
announce an incoming message. It’s from your boss.
She needs more than a sales report—she wants sales
forecasts. You’re typing out some figures when the
computer beeps again. She wants to know if you can
meet 20 minutes early.

213



Mail » Chapter 14: Managing the Mail Application

Deleting messages

1 Select the message You can let important messages accumulate in your mailbox. But you should

or messages you delete messages you don’t need, to get them out of your way.
want to delete in the

summary area. ) ) ~ activembox

2 Click the Delete
button or press the
Backspace key.

Deletes the selected
— TIESSAgE O MESSAagES

Delete \i : Compose

B9 Junoi Erials for festival pr

60 Jun 01 KayaGrey "~ " Bright CD Cover
Jun01__Anne Winn Big Concert Friday!

62 “Juno!  MaxBasil Yolceovers for TV promo
63 Jun 02 *Jumpin® Jack Sly Check outthis guy’s voicel
84 Junps = UriKohn Sprechtinterviewon BBC .

> bl
b

RO

Date: Mon, 1 Jun 94 12:00:24 GMT-0800
From: winn (Anne Winn)

To: BluePlanet_SF

Subject: Big Concert Friday!

Cc: sammi_wright@globalvoice.com, poupon

Hey Everybody!!!

Don’t forget that this Friday night is the first-ever Bay Area
appearance of recent Blue Planet “signee” and scat sensation

Dido Estevan
8:00 pm at the Sweetwater Pavilicn

X ;

Come early for press hour and hors d’oeuvres

e

If you can tell without reading a message that you want to delete it, hold down
the Control key while clicking its summary to select the message without
waiting for its contents to appear. Then click Delete to delete the message.

Ways to Select Messages

What You Do What Happens

Drag Selects the messages you drag across

Shift-click Adds the message to the selection, or removes
, it from the selection

Alternate-click Selects all messages between the one you click
A message you delete isn’t : : - and the last one you selected

removed from your disk, and

you may be able to restore it. See
“Compacting a Mailbox to Free

Disk Space” on the facing page.

- Control-click Selects a message without opening it
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Compacting a mailbox to free disk space

Open the mailbox you
want to compact.

To see messages you're
about to destroy, choose

Show Deleted from the N
Mailbox menu. ® § Bt ® 1 ®
To undelete a message ,.,,93[%!?”"4; < Delete .______’g' Delete
you want to keep, select Jun o1 Pier T & 59 Junoi Pier A 59 Junol Pien
it and choose Undelete Juno1l  Kays 3 A 60 Junol  Kay? A 60 Junot Kaye
Jun01_ Ann s A 82 Junot  Max il A 61 Jun0t Ann
from the Message menu. Junot1  Max; Ll A 63 Junoz  Jum] 78 A 62 Juno1 Max
: Junoz  Jumg A 64 Junos Uriﬁ Al" A 63 Junoz Jum
Choose Compact from Junos UriK Ai Ad B4 Junoa UriK
] i

the Mailbox menu.

Deleting a message removes it from the summary area of a mailbox window,
but not from your disk. In fact, you can see a dimmed summary of it and other
deleted messages by choosing the Show Deleted command.

You delete a message.

The message no longer
appears in your mailbox.

But you can see its dimmed
summary by choosing
Show Deleted.

You can undelete a message you want to keep by selecting its dimmed
summary and choosing Undelete. To destroy remaining deleted messages—
whether they’re showing or not—choose Compact.

i 59
; Rgey i e
f ® < f ®|<<‘3;i 50
i e —~Z { B pd 61
g’ Delete | Comp 5’ - Delete "] . Comp
BS Messanes (420KB) — 2 deleted (17KB) 63 messages (403KB) i 62
SETTATTEYTTJUND T TP ePuu)p}' 2] A 59 Jurgt  Pierre Poup B3
A B0 Juno%;'aerey A 0 4Un D1 Kaya Grey
A 51 Junoy AnneWinn ] A 81 Juno1l MaxBasil
A 62 Jupf01_ MaxBasil £l A 62 Juno2 Jumpin Jack
A 63//un02 Jumpin Jac A 63 Jun©3 UriKohn
When deleted messages - 54Aun 03_ UriKohn . A S '

aren’t showing, the Undelete
command undeletes the last
message you deleted. For
more information, see “Mail
Buttons and Commands” in
the Reference at the end of
this book.

4
Display the total number of deleted messages
and the disk space they occupy by choosing
Show Sizes from the Mailbox menu.

Choose Compact to destroy deleted
messages and free up disk space.
Remaining messages are renumbered.

Caution: If you don't regularly compact your Active mailbox, deleted messages
accumulate and take up disk space unnecessarily. However, compacting destroys

You can have all mailbox deleted messages permanently.

windows show deleted
messages or report message
totals and sizes using the
Preferences command in the
Info menu. See “Mail Buttons
and Commands.”

"To hide deleted messages, choose Hide Deleted from the Mailbox menu.
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Looking up Mail addresses

Open a Compose
window and click the
Addresses button.

Click the type of address
you're looking for.

Select an address.

Click the To or cc button
to copy the address into
your Compose window.

216

You can look up the addresses of other people and groups on your network
with the Addresses panel. This panel lists addresses in a browser.

T addresses B Click the type of address
you're looking for in the
Types column.
Gahriella_Rosa i ) o
s Harmony _Hohner . = Click to select an
|l dan Borg- . L. | PR i address.

Jason_Starr [

JI_Gilt

e The person’s picture appears.

e Click to copy the address
into a field in a Compose
window.

You can copy several addresses, one after the other, into a Compose window.
Just select an address and click To or cc. The button appends the address to
any already in the corresponding Compose window field.

The Types Column
You can look up addresses in one Private Users Lists addresses that

of five lists. You select a list from you use frequently.

the Types column: Private Groups Lists group

Users Lists all addresses for addresses you create.

everyone on your network. .
Y y Addresses in Users, Groups, and

Group Lists group addresses  Login Names are defined by your
available to everyone on the system administrator. You add
network. the Private Users and Private

Groups addresses yourself. See
““Creating a Mail Address Book”

and “Creating Your Own Group~

Address” in this chapter.

~ Login Names Lists the user name
that each person on the network
uses to log in. Look up an address
here rather than in Users if you
know only a person’s user name.



When you select an individual’s address, a picture appears if your system
administrator has set up Mail that way. For groups, and for people who don’t
have pictures in the system, the panel displays silhouette icons.

Individua/ e

Group

Shortcuts Selecting Addresses

Try these shortcuts in the Addresses
panel—when typing in the Name
field or browsing addresses.

Browse Using Arrow Keys

You can browse in the Addresses
panel using arrow keys, just as you
can in the File Viewer's browser.
Press the up or down arrow key to
select the previous or next address
in a list. Press the left or right arrow
key to move between lists.

Type the First Few Characters

You can select an address in the
current list by typing the first few
characters of its name. For example,
select the Users list and type Jas to
~ select Jason_Starr.

You can find an address in any list by
typing the first few characters and
pressing Escape, justasin a
Compose window. For more
information, see “Shortcuts Typing
Addresses” in Chapter 13.

Search for Any Text

You can use the Find button to
search for an address in the current
list based on any text in the address.
For instance, if you type kim in the
Name field, Mail can find addresses
like Kimberly_Osorio or Kyung_Kim.
Click Find again to find the next
occurrence of text in the list.
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Creating a Mail address book

Open a Compose
window and click the
Addresses button.

Click Private Users in
the Types column of
the Addresses panel.

Type an address in
the Name field.

Click Add.
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You can keep your own list of addresses in the Private Users list in your
Addresses panel. You might keep addresses you use frequently here so you
don’t have to search through long lists to find them.

Type an address here.
Click Add.

Users
Groups

The address is added to

Private Users _ | Y : ‘ your Private Users list.
Private Groups y

Once an address is in your Private Users list, you can select it and click the To
or cc button to copy it into the Compose window.

To remove an address from your Private Users list, select the address and click
the Remove button. |

Tip: If you open a message from someone whose address you want to add to
your Private Users list, choose Add Private User from the Message menu. The
sender’s address is automatically added to your list, even if the Addresses
panel isn’t open.



Creating your own group address

Open a Compose
window and click the
Addresses button.

Click Private Groups
in the Types column of
the Addresses panel.

Type a name for the
group address and
click Add.

In the Private Groups
column, select the
group address you
just created.

Type an address you
want assigned to the
group and click Add.

Repeat step 5 for each
address in the group.

For information on naming a
group address, see “Guidelines
to Naming Files and Folders” in
Chapter 5.

Only you can send a message
to a private group you create.
But you can make it easy for
recipients to reply to the group.
See “Preferences for Messages
You Send” in this chapter.

Ifyou create a shorthand address
for yourself, make sure to add it
to the list of addresses Mail
recognizes as you. See “Expert
Preferences” in this chapter.

In addition to the group addresses set up by your system administrator, you
can create some for your own use. You might create an address for sending
messages to everyone working on a particular project. When naming a group,
don’t use a comma or a space. Otherwise, follow the same guidelines as for
naming files and folders.

Addresses

—

RERSET e sTRRAR | B8 Private GrounS i

! ::;q[Festival_Planners ~

rOTeTd

~|Groups ol : Select Private Groups.

{Login Names By V24 S .

»|Private Users 147 ‘

[prvte Groups 1| m : v

o ¢ R —— Type a name for the group here.
> . i A Click Add.

T — . ‘

‘Jamezl Festival_Planners ¢ /' |

H pe e Pl /v e .": Tl A o ',"M - et . 3

| Remove I add <] |~ Fing | e | T ¢r| The new group appears in Private

Groups when you click Add.

"The group automatically includes your own address. You can add other
addresses by selecting the group, typing an address, and clicking Add again.

To remove an address from the group, select the address and click Remove.
You can’t remove the last remaining address associated with a group (so if you
want to remove your own address, you have to add another one first). But you
can remove the entire group by selecting its name in the Private Groups list
and clicking Remove.

Tip: You can create a shorthand address for one person. Just create a group and
assign only that person to it. For example, if you send messages frequently to
the address sammi_wright@globalvoice.com, you might create the group
sammi, add his address to it, remove your own, and then send messages to
him using the shorthand address.
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Organizing messages in mailboxes

» To create a new mailbox,  Instead of letting messages accumulate in your Active mailbox, you can
click the Mailboxes organize them in other mailboxes. You do this with the Mailboxes panel.
button in a mailbox
window, type a name for
the mailbox, and click —

Active
New. Festival

» To open a mailbox, select
it in the Mailboxes panel
and click Open, or double-
click it in the panel.

= Type a name for a mailbox.

» To delete a mailbox,
select it in the Mailboxes
panel and click Delete.

Click New to create it.

e et The new mailbox appears in
open__| [ Transter <] the list, and an empty mailbox
» To move messages to — = window opens for it.

another mailbox, select
the messages. Then in You can also organize mailboxes in folders. You create a folder while creating

the Mailboxes panel, a mailbox. Just type a pathname in the Mailboxes panel that includes the

select the mailbox you , .
want to move them to folder’s name and click New.

and click Transfer.

Type Festival/1994 and click
/ New to create a Festival folder

and save the 1994.mbox in it.
You can select a mailbox by
typing the first few characters of
its name or by pressing arrow
keys, just as when selecting .
addresses in the Addresses o——c — Resize the Mailboxes panel to
panel. See “Shortcuts Selecting K== show two columns.
Addresses” in this chapter. ’

Name/ You can then select the folder and
g create other mailboxes in it, too.

] . You can also open an existing mailbox to see its messages. Or delete a mailbox
To reorganize existing destroy all the messages in it. If you delete your Active mailbox, Mail
mailboxes, open your to destroy . £ y ¥ . Y . ?
/Mailboxes folder in the creates an empty Active mailbox the next time you start it up.
File Viewer and move ’
mailboxes into folders there,
just as you move a file. See
“Moving a File or Folder”
in Chapter 6.
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After you create a mailbox, you can move messages to it from your Active
mailbox. You can also move messages between any mailboxes you create.

ey

0

Q [TRTEED)
i MON

& i
Delete Compose Mailboxes Find )d
§ 55 May 25 KayaGrey R CD CoverBudget Select the

1 A 53 Junoi_Pierre Poupon Materials for festival program / / / messages you
.| A 60 Jun01 KayaGrey Bright CD Cover
] A 51 _Juno1_ Anne winn Big Concen Friday! / want to move.
Al A 62 Jun01 MaxBasil Voiceovers for TV promo v
.Y A 63 Junoz JumpinJack Sly Check outthis guy’s voicel

P

Date: Mon, 1 Jun 94 11:03:13 GMT-0800 !
From: grey (Kaya Grey) !
To: starr SN E—
Subject: Bright CD Cover | Mailhoxes
€ # Cc: grey, basil B ——

S Select the
Howdy Jason, mailbox you
f Here’s our final take on Emily Bright’s CO cover. We had a lot of troubl{ | . want to move
+1 the country lane and the highway. In the end, we thought the modern Iq them to

she’s about. We can go ahead and send both versions to Emily and he

Name:|Festivalmbo |
TR " oerts_| i | ymma Click Transfer.

Open | Transferf¢a |

EMILY BRIGHT

You can also use Edit menu commands to move selected messages. Choose
Cut from the Edit menu. Then click in the summary area of the mailbox
window you want to move the messages to and choose Paste.

After moving messages out of a mailbox window, remember to compact
the mailbox.

A Mailbox Is a File Package

Your Active mailbox and any You don't have to open a file
mailboxes you create are actually package to read the messages
file packages with an .mbox in a mailbox. It's easiest to read

For information on selecting ~ extension. Mail keeps these file -and maintain messages in the
packages in the Mailboxes folder mailbox window. .

several messages to move at
once, see “Ways to Select
Messages” in this chapter.

in your home folder.
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Finding a message

Click in the summary area
of a mailbox window.

Click the Find button.

In the Find panel, type
what you want to find.

Select the options
you want.

Click Next or Previous.

If you click in the body of a
message in a mailbox or
Compose window and open the
Find panel, you can search for
text in that message. See
“Finding Text” in Chapter 9.

You can use commands in the
Sorting menu to sort message
summaries in a variety of orders.
See “Mail Buttons and

Commands” in the Reference at

the end of this book.
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You can find a message in a mailbox by searching for any text in its summary
or in the message itself.

+i Compose |

.84 Jun03 UrKohn. - - Spre;:htlntervlewonBBC\ .

o

Date: Tue, 2 Jun 94 18:13:31 GMT-0800
i From: sly (JumpinJack Sly)
“| To: starr

~

: - Delete % N
T AT E§ Junof  Fiere Foupan Mm'a'f's'%n Stval program
A 80 Jun01. KayaGrey . . Bright CD Cc\k\ :
4:l- A 817 Jun01  Anne Winn Big Concert Friday) .
] A 82 JunDi ‘MaxBasil Voiceavers for TV pro 1 .
Al A 83 Juno2  Jumpin Jack Sly Check out this guy’s voi e mas. ([{CK any summary.
= :

Subject: Check outthis guy’s voice!

Hey Jasen,

This Dido Estevan catls far out! 1 took this off his new CD Casmic Percussions €=,
1 know he’s new talent, but | think we should schedule him more prime time in the festival,
if you know what | mean. Like early evening on day 2. !

Click to open the Find panel.

Type the text you want to

Let me know what you think,

search for here.

Choose whether you want
to search for text in the

FrafSoe? f

summary or in the message.

: Replace vith:[ J/

< PN Stope —— —— Find Options =
- C:Summaries ilignore Case -
. (".Messages . | | - fReguiar Exp}e}ﬂﬂ"

4/ Next <¢'

¢ Find Al I IRepiace |- Replace & Find

Click to search forward
or backward.

To search for a message based on text in its summary, click Summaries under
Find Scope in the Find panel. You can search for text in the message’s subject,
message number, date, or sender’s address. To search for a message based on
text that’s in the message, click Messages in the Find panel.

Any message that’s found is highlighted in the summary area and opened in
the message area below.

Tip: You can search for an unread message—one with a @ next to it. Just select
Summaries under Find Scope, type a bullet in the Find field (by typing
Alternate-7), and click Previous or Next.



Focusing on a group of messages

Clickin the summary area
of a mailbox window.

Click the Find button.

In the Find panel, type the
text you want to find.

Select the options
you want.

Click Find All

Open the Mailbox menu
and choose Focus.

When you're done
reviewing the messages
resulting from the search,
choose Unfocus.

You can find all messages in a mailbox that have your search text, either in
their summaries or in the messages. You can then “focus” on those messages,
temporarily hiding others so it’s easy to find a particular message.

"Type your search text and select Summaries or Messages in the Find panel.
Then click Find All

[w] ’ Active.mhox
4 s ,
| |
0’  Delete Compose Mailtioxes Find CiZ:]

" T6_ May 29_Kaya Grey Fe: CD Caver Budget - /:Z 7 When ypu click Find /,‘”
{_A 53 Junoi Pierre Poupon Materials for festival program 7y o in the Find panel, Mail
.| A 80 Junot KayaGrey Bright CD Cover 7 selects 6” messages that
A 81 _Junot AnneWinn Big Concent Friday! .
Af A 82 Junoi_ MaxBasil Voiceovers for TV proma 7 [ contain your search text.
Y A 63 Junoz JumpindJack Sly Check outthis guy's voice!

Choose Focus to have Mail
display only the selected
messages.

Active.mbox

Compose Mailboxes

A 53 Jun01\Pierre Poupon

Q IR
8 i MON
‘ By
frd o5
Materials for festival program .
A 60_Junot_RuyaGrey Bright CD Cover Y == When you focus on the
Voiceovers for TV promo =l messages you found, you

T2 6z Juno1 Max Rasil
N can open one without

G losing track of the others.

Date: Mon, 1Jun 94 11:03:13 GMTYg00
From: grey (Kaya Grey) \
To: starr

Subject: Bright CD Cover

€| Cc: grey, basil

20

Delete

A note in the window reminds
you that you‘re focused on
Howdy Jason, only some of the messages in
— : the mailbox.

i1 Here’s our final take on Emily Bright’s CD cover. We had a lotoffrouble deciding between -

7 the country lane and the highway. In the end, we thought the modern look Is more what
she’s about. We can go ahead and send both versions to Emily and her agent.

GIT OK DOWN THE RO4D

DI

| EMILY BRIGHT

T

"To narrow down your search, you can do another Find All search and choose
Focus again to display the results of that search in the mailbox window. You
can keep selecting messages and choosing Focus as many times as you want.

To see all your messages again, choose Unfocus. Mail also displays all
messages the next time you open the mailbox.
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Tailoring how you get new messages

Choose Info from the
Mail menu.

Choose Preferences
from the Info menu.

Choose General from the
pop-up list at the top of
the Preferences panel.

Click Automatic
or Manual.

If you clicked Automatic,
type a value for how
often Mail checks for
new messages.

Click Set at the bottom of
the Preferences panel.

If you clicked Manual,
click the Get Mail button

to retrieve new messages.
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Before messages addressed to you actually reach you, they’re collected in a
central “post office”—a folder on the network that your system administrator
maintains. Mail is set up to check this post office at a regular interval and to
retrieve new messages it finds there, putting them in your Active mailbox.

Normally, Mail retrieves message automatically, and you can set how often
Mail checks for new messages in the Preferences panel. If you prefer to control
how quickly messages accumulate in your mailbox, you can select Manual to
retrieve new messages yourself.

= Choose General from the pop-up list
at the top of the Preferences panel.

[ NewMail Retrigval ————
" Manual - (g Automatic ' ., .
i (xoutomat When Automatic is selected, Mail

 Query Eviry|s, s retrieves messages for you.
i sodhe: [ |
1 Mailbox Wilepe——— You can type an interval, in minutes, for
wMessage Totals -~ | how often Mail retrieves messages.

WMessage Sizes .l
W Deleted Messages :
_Juse Fixed Pitch Font for Plain Text

Or click Manual to retrieve new
messages yourself,

—— Mall Application =
Hide on Auto-Launch- . .~
¥|Show Unread Countinlcon

Click here to put your new settings
into effect.

ot /|

When you select Manual, Mail no longer retrieves messages automatically.
Instead, the next time a mailbox window opens, a Get Mail button appears
in place of the Find button. To retrieve messages, you must either click the
Get Mail button or choose Get New Mail from the Mailbox menu. When
new messages are ready to be retrieved, a fan of letters appears in Mail’s icon
in the dock.

Tip: When you retrieve messages automatically, you can choose the Get New
Mail command to speed up retrieval. You might do this when you’re expecting
a particular message.



Setting a sound to announce new messages

Choose Info from the
Mail menu.

Choose Preferences
from the Info menu.

In the Preferences
panel, click Set under
New Mail Retrieval.

In the Open panel,
select a sound file.

Click OK in the Open
panel.

Click Set at the bottom of
_the Preferences panel.

You locate and select a sound file
in the Open panel just as you
open a file from any standard
Open panel. For more
information, see “Opening an
Existing File” in Chapter 5.

When new messages arrive, a fan of letters appears in the Mail icon in

the dock. You can also have a sound notify you of new messages. If you receive
messages automatically, the sound tells you that there are new messages in
your Active mailbox. If you check for messages manually, the sound tells you
that there are messages for you to retrieve with the Get Mail button.

You select a sound file from an Open panel.

Preferences X

General Hl

New Mail Retrieval
(" Manual (" Automatic

Query Every:'s ) i minutes
. | H
__}Suund.] . Set..=q Click to open a panel where
‘ - you can select a sound.
s A
st
_lsq ¢
_u
! [HeRTORracy] 1] Soundsl ]
1 |Preferences ™ Basso.snd
ZHif - PrinterTypes r~ Bank.snd _ o
v|si -2 |PSzResources Frog.snd s m— Select a file with an .snd
Receipts "~ Funk.snd ! extension.
Services Pop.snd
Shaders I SystemBeep.snd
Sounds Tink.snd
¥l Textures il .
(=l - |
Name:| Frog.snd , i
STt =
_@_l Ijl Ei‘ Cancel I oK —.LL- When you click OK, you hear
; 0 the sound.

You can select a sound file from the /NextLibrary/Sounds folder. If your
computer can record, you can also make your own sound with any sound
application, such as the Sound.app application in /NextDeveloper/Demos.
You can use any sound file, as long as it has an .snd extension.

If your computer makes only one sound, you’ll get that one, no matter which
sound file you select.
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Creating headers for messages you send

Choose Info from the Mail
menu.

Choose Preferences from
the Info menu.

Choose Expert from the
pop-up list at the top of
the Preferences panel.

Double-click in the Key
field and type the name of
a header you want to
create.

Press Tab, type any text
you want to appear with
the header in the Value
field, and press Return.

Click Set.

You open the Send Options
panel by choosing Send Options
from the Compose menu. For
more information on this panel,
see “Options for Sending
Messages” in Chapter 13.
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You can create headers of your own that will appear in messages you send. You
do this using Mail’s Expert Preferences. You can create up to two headers.

G R pre erences iy

Choose Expert from the pop-up list at
the top of the Preferences panel.

Expert ‘{ti

Additional Outgoing Headers

Double-click in the Key field and type the

[REV] et St
X-Company ¥ : Blue Planet Productionse,
N

X-Bulletin \

N

name of the header.

Other Adtgsses for Self

Administration
Mail Dir:[~/Mailboxes N\

Press Tab and type an optional
“value”—the text that appears with the
header—in the Value field.

You can press Tab again to move to the

Spool Dir:| /Nettinman/mail i

Mailer:|usr/lib/sendmail

SendLimit|soo KB

LineLength:f7o

next field and type another header.

Click Set when you‘re done.

CRever | st &

If you type a value for the header, the header appears with that value in all
messages you send. To send a different value in a message, choose the header
in the Send Options panel when you send the message and type another value

for it there.

If you leave the Value field empty, you must choose the header from the Send
Options panel and type a value for it to include it in a message.

" vﬂ% Choose a header you created from the

= pop-up list in the Send Options panel.

To S
Ce 5
T § Bee 7
X-Company 8
X-Bulletin <k

| Today is Kaya’s birthday!

Type a value for the header here. The
value replaces any value set in the
Preferences panel for just this message.

Reply-To:|

" |Archive in Outyoing mailbox




Your headers appear at the top of your message in each recipient’s
mailbox window.

r
gﬁa

Compoj

Delete Mailhoxes Find
"AT 59 Junot  FPlerre Foupon alerials for festivel program
A 650 Juno! KayaGrey Bright CO Cover
- & 81 Junot Anne Winn Big Concert Friday!
0) A 62 Junot  MaxBasll Voiceovers for TV promo
Al A 83 Juno2 JumpinJack Sly Check out this guy’s vaicel
Al 64 Juno03 UrKohn Sprechtinterview on BBC

-

Date: Tue, 2 Jun 94 18:13:31 GMT-0800
From: sly (JumpinJack Sty)
To: starr

1 Subject: Check outthis guy’s voice!

X-Bulletin: Today is Kaya’s bithday!
X-Company: Blue Planet\Pruductinns

Header “value”

Hey Jason,

| This Dido Estevan catis far out! | took this off his new CD Cosmic Percussions <=
| know he’s new talent, but | think we should schedule him more prime time in the festival,

if you know what I mean. Like early evening on day 2.

Let me know what you think,

-« .

wfw{’Sbl«

Header name, or “key”

Guidelines for Naming Headers

Follow these guidelines when
typing a name in the Key field of
Mail's Preferences panel.

Mark Custom Headers with “X-"

It's common protocol among
network users to precede the
name of headers you create with
an X-, as in X-Quote-Of-The-Day.

Don‘t Use Spaces

Don't use a space to separate words
in a header, or else Mail won't
recognize the header and include it
in your messages. If a header
contains more than one word,
separate words with a dash, as in
X-Quote-Of-The-Day.
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Tailoring headers in messages you receive

To make a header that's
normally hidden appear
in messages you receive,
remove it from the
Hidden Headers list in the
Preferences panel.

To prevent a header from
appearing in your
messages, add it to the
Hidden Headers list.

To see all headers in a
message—whether or not
you’ve hidden them in the
‘Preferences panel—choose
Show Headers from the
Message menu. For more
information, see “Options for
Showing Information about
Messages” in Chapter 13.
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You can choose which headers normally appear in messages you receive. You

do this in Mail’s Preferences panel.

Dyoaferance b4

Headers [

==

ontent-Type
ontent-Transfer-Encoding 1
rrors-To !

s ety S il

key:[Content-Type

[removt]]

 Revert | set ezl

Preferences

ontent-Type
ontent-Transfet-Encoding -
rrors-To T

Choose Headers from the pop-up

list at the top of the panel.

These preferences list headers that
are hidden in messages you receive.

Select a header that you want to
appear in your messages.

Click Remove to remove it from
the list of hidden headers.

Click Set to make it appear in
your messages.

To hide a header that currently
appears in your messages, type its
name here. Type the name exactly
as it appears in your messages.

Click Add to add it to the list of
hidden headers.

The header appears in the list.

Click Set to hide it in your messages.
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Preferences for Messages You Send
You can set options for all messages you send.
Choose Preferences from the Info menu and then
choose Compose from the pop-up list at the top of

the Preferences panel. Make settings in the panel to
choose any of the following options.

Format Press the Format button to choose a format—
NeXT Mail, MIME Mail, or Plain Text— for all your
compose windows to open in.

Indent New lines When you check this option,
pressing Return in a Compose window indents the
next paragraph the same as the previous one. This
option is useful for typing UNIX code.

Emacs Key Bindings Check this option to use Emacs

~ text editor commands in a Compose window. Emacs

commands are popular among UNIX programmers.

Reply in Same Format Check this option to reply to
messages in the same format as the original
messages. When you click Reply in a Compose
window, the window selects the format for you.

Remove Self from Replies Check this option to not
receive replies you send using the Reply All button. If
you are “carbon copied” in a message and you click
Reply All in a Compose window to reply to that
message, Mail doesn't copy your address from the
message’s Cc field into your Compose window. For
this option to work, Mail must recognize your
address in the message as being you. You can make
Mail recognize an address if it doesn't already. See
“Expert Preferences” in this chapter.

Reply-To You can have all replies to your messages
go to someone other than yourself. Enter one or
more addresses in the Reply-To field. When anyone
uses the Reply button to respond to one of your
messages, the To field of his or her Compose window
is filled with the addresses you enter here. (To also
have replies go to you, enter your address, t00.)

Request Read Receipt Check this option to receive a
notification message when each NEXTSTEP recipient
reads any message you send.

Archive Outgoing Mail Check this option to collect
copies of all messages you send in the Outgoing
mailbox. Mail creates this mailbox for you, if it
doesn't already exist.

Expand Private Groups You can make it easy for
recipients of messages you send to a private group
address to reply to others in the group. When you
check this option, individual addresses in the group,
rather than the group address, are listed in each
recipient’s message. Recipients can then click Reply
All to reply to everyone in the group.

Send MIME Alternatives Check this option to send
contents of MIME messages in plain text as well as
using formatted text. You might do this if you're not
sure which formats recipients’ computers can
display.
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Expert Preferences
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The Preferences panel has options for how Mail
manages messages. Choose Expert from the pop-up
list at the top of the panel and type in these fields:

Other Addresses for Self If you're known by addresses
that Mail doesn‘t recognize as you, type them in this
field. Mail already recognizes your user name and your
full name in the format Jason_Starr. But it doesn't
recognize addresses used from other networks, like
jstarr@blues.com, or ones you create in the Addresses
panel, until you type them here. )

When you reply to a message sent to an address

entered here, Mail can remove you from that reply. See
“Preferences for Messages You Send” in this chapter. If

you send a message to one of these addresses, To:

followed by recipients’ addresses appears in your

mailbox window rather than your address. See
“Sending a Message” in Chapter 13.

Administration System administrators can modify
how Mail stores, retrieves, and delivers messages by
replacing pathnames in these fields:

+ Mail Dir: The folder where Mail keeps your
mailboxes. Normally this is Mailboxes in your

home folder. If your home folder is on another
computer on the network, you might want to
specify a folder on your computer’s own disk.

* Spool Dir: The “post office” folder that collects in-
coming messages. If your system administrator is
using a folder other than the one currently named
here, you should specify that folder here, instead.

» Mailer: The program Mail uses to deliver mail.
You might want to use another program, such as
one that tracks statistics.

Line Length This value is the maximum number of
characters per line in messages you send in Plain
Text format. You might want to change this value to
send messages through a gateway to a network that
supports fewer than 70 characters per line.

Send Limit You can set a size limit for messages you
send. Type the number of kilobytes in this field. If you
compose a message that’s larger than this size, a
panel tells you so when you click Deliver in the
Compose window. To still send the message, click
Deliver Anyway in the panel.

el (RSN
— Additional Outgaing Headers S v\*_——* ‘Headers
TN Expert =

Type addresses you're known by

——— Other Addresses for Self ————
|istarr@blues.com, jason .

== 0 Other networks or that you

Administration =—————

created yourself. Separate each

Only your system administrator

" Mail Dir.[~/Mailboxes
. Spool Dir:[/Nettinman/mail

Maiter.[/ustiib/sendmail G

address with a comma.

should ediit these fields. You can type a new line length,
) e ; in characters, for plain text
Line Length:|7o —t— Messages here.
] o - send Limit.[oo ke |
Type a maximum size, in kilobytes, T sk
for messages you send, S Revent | set ] '
k = — =‘]~—— Click to put new settings into effect.
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Ifyou have your own printer—orif one is available on a network—you can print
most documents that you create in your NEXTSTEP workspace. You can

print one copy of 20 pages or 20 copies of one page, sideways, reduced, or on

custom-sized paper.

Mame: FRepertoire Color Frinter

Note:  /n the record fibrary. | BHFAEESS (MEEESES (MEY G
Progress: o . s
By (e | Lo first album:
ocal_Printer NeXT 400 dpl Levelll Prlnter i ﬂ?&' mad

eperoire_Color_Pri MNeXT Calar Printer I
ly_Personal_Printer MNeXT 400 dpi Level Il Printer '

L e e e t on a stormy horizon. The

— Copies — - — Pages —— Is of Chicago combines the aching
1 {'"1 all (‘ mel TUI pessage from her generaton. But
S ated passion—doesn’t let you
PaperFeed o Resolutmn — pmake a difference.

?;j?o;j{ionfs}ﬂf; Cassette = astldpl -A‘

legend, Skip James, but Brightis

ey i ebee e e oot Bright learned her craft hanging
 Save.. | Preview | Fax.. Cancel, I I Print":(‘:‘J 1d clubs on Chicago’s South Side.
e ——— - ———lelf, kids living on the streets. The
s message is not What you rmght expect. These kids are not just locking for a
free meal or a dealer. They're looking for a future, not only for themselves
but for the planet. And Bright sings the message loud and clear.

Emily Bright may have her roots in a blues past, but she’s got her eyes

on the future. Her sound is soulful, down-and-dirty, and innocent at the
same time. This woman’s going to soar, and G o dowse I road is going
to get an old tradition moving in a fresh, new direction.

Sammi Wright
Giobal Voice




Printing

E:fn'i?;g‘g afile for Your grandfather was a printer. You remember his
Printing a file stories about staying up all night to roll the presses
Checking the print for the next day’s edition.

queue

Managing the print Yessiree, those were the days, he’d say, puffing on his

queue pipe. Those old printing presses and folks like me—

Saving your pages

26 a PostScrint filo we changed the way the whole world communicates.

You once tried to explain what you do for a living,
Bah, computers, he puffed. You tell me what a little box
of wires can do that a good man with a vat of ink and a
well-oiled press can’t do a lot better—and a lot faster:

He blew a smoke ring that spiraled gracefully up
through the branches of the old magnolia tree. You
thought about the high-resolution laser printouts of
complex documents you churn out every day in your
spare time. Then you shook your head and smiled.
Can’t think of a doggone thing, gramps.
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Preparing a file for printing

Open the file and
choose Format from
the application’s
main menu.

Choose Page Layout

from the Format menu.

Choose a paper size
from the Paper Size
pop-up list. Or type
custom dimensions
in the Width and
Height fields.

Click Portrait or
Landscape.

Choose how many
pages you want to fit
on each sheet of
paper from the Layout
pop-up list.

Type a percentage in
the Scale field.

Click OK.

You can change the default

paper size and units of measure
for the Page Layout panel with

the Preferences applications.

See Chapter 20, “Personalizing

Your Workspace.”

The Page Layout command

may not be in the Format menu

in your application. See the

user’s guide for your application.
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Before you print a file, you can change its paper size and orientation. You can
also scale your pages to enlarge or reduce them.

Page Layout‘ e :

- r——Paper Slze —
i i

§ The miniature page changes
e size and orientation to reflect
your settings.

—
, i —— Layout

—— Units ——
Tinches.

Select the options you want
and click OK.

You can make the size of the pages in your file match the size of the paper in
your printer with the Paper Size pop-up list. When you choose a paper size, its
dimensions appear in the Width and Height fields.

If your paper size isn’t included in the list, you can type custom dimensions in
the Width and Height fields in inches, centimeters, picas, or points. (Picas and
points are commonly used to measure typographical material. A point is 1/72
of an inch, and a pica is 12 points, or 1/6 of an inch.) You can choose the units
of measurement you want to use from the Units pop-up list.

You can print your pages upright or sideways on the paper by clicking the
Portrait or Landscape button.



Scaling works differently in
different applications. See the
user’s guide for your application.

You reduce or enlarge printed pages by changing the percentage in the

Scale field. Scaling doesn’t change the actual contents of a file, and in many

applications, it doesn’t change how the file appears on screen.

Your pages are normally printed “1 Up”—that is, with one page on each sheet

_ of paper. But you can choose one of the other Layout options to print 2, 4, 8,

or even 16 pages on each sheet of paper. The following examples were all

printed with Portrait selected.

2Up

4Up

16 Up
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Printing a file

Open the file and
choose Print from the
application’s main menu.

Click the name of the
printer you want to use.

Type the number of
copies in the Copies field.

Click All to print the
whole file. Or type page
numbers in the From
and To fields to print part
of the file.

Choose Paper Feed and
Resolution options.

Click Options to set
any special options for
your printer.

Click Print.

You can preview on screen what
your pages will look like on
paper with the Preview button.
See “Previewing Pages” in
Chapter 11.

You can fax your pages instead

of printing them by clicking

the Fax button. See Chapter 16,
“Sending Faxes.”
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When you’re ready to print a file, you select a printer, the pages you want to
print, and the number of copies.

Print

Name:  Repertoire_Color_Printer
Note: In the record fibrary.
F’rogress:

Local_Printer NeXT 400 dpi Level Il Printer
Repertoire_Color_PriNeXT Color Printer _;ﬂ— Select the printer you want to use.

Sly_Personal _Printer. NeXT 400 dpi Level ll Printer

Type the number of copies and range
of pages you want to print.

Choose the other options you want
LT T et and click Print.
| “cancer [ pant‘e|

e G o T
1 Save.. I Preview I Fax.

The name of the current printer appears at the top of the Print panel. It
remains the current printer until you select a different one. If only one printer
is available, the scrolling list doesn’t appear in the panel.

You type the range of pages you want to print in the To and From fields.

zPages e : If you type a starting page
(' All - ('"1 From|4 | Toflast s number, the To field
o : automatically changes to last.
- Pages — e If you type an ending page
m Fromlfrst 71 Tola I number, the From field
automatically changes to first.

You can type 0 or even a negative number in the From field if you want to print
pages that come before page 1.

When you click Print, your pages are prepared for printing. A temporary file is
created and sent to the print queue for the printer you selected. If no other
files are in the queue, your file is printed immediately.



Print Panel Options

Different printers offer different options in the Print
panel. You choose the options you want from the
pop-up lists in the Print and Printer Options panels.

Paper Feed

Lists the sources of paper available to your printer.
Some common sources are as follows:

Cassette Uses the paper in the printer’s cassette.

Manual Uses envelopes, acetate, or other stationery
you feed into the printer by hand. (For instructions on
feeding paper manually, see the owner’s guide for
your printer.)

Upper, Lower, or another named cassette Uses
paper from a specific cassette, if your printer has
more than one.

Any Tray Automatically uses paper from the cassette
that matches the size of your pages.

Split Uses multiple cassettes. The paper in the
second cassette is used for the first page, and the
paper in the first cassette is used for the second and
following pages in the file. This option is commonly
used to print cover sheets on letterhead or other
special paper.

Resolution

Lists the resolutions your printer can print at,
expressed in dots perinch (dpi). You can print sharper
lines and smoother gradations of shading by
choosing a higher resolution. High-resolution

printing may take longer than low-resolution printing.

Options

If your printer offers other options, you can click the
Options button in the Print panel to set them. The
Printer Options panel displays the special settings
for your printer in a series of pop-up lists. For
example, a printer might offer several printing -
modes for different paper stocks and ink coverages.
For more information about the options offered by
your printer, see its owner’s guide.

If you select a printer and no options appear in the
Print panel, it's probably because you don't have its
PostScript Printer Description (PPD) file installed.
For more information, see “About PostScript Printer
Description {PPD) Files” in Chapter 18.

Printer Options

- 360 dpi

—— Paper Feed -
_ Cassette ';tl

- Resolution - ] Printing Mode —
 at|| | Coated Paper al |§

Ccancel | ok <]
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Checking the print queue

Open the /NextApps
folder and double-click
PrintManager.app.

Choose Printers from the
PrintManager menu.

Click the name of the
printer whose queue
you want to check.

Click Queue.

For more information about
PrintManager, see Chapter 18,

“Managing Printers and Fax
Modems.”
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When you print a file, a copy is prepared and stored in the queue for the
printer you selected. If no other files are in the queue, yours is printed right
away. But if other files are in the queue, your file is placed at the end. You use
PrintManager to see what’s in the print queue.

A
NN

— : Click to open the queue
AN N - : for the selected printer.
| s

Local_Printer NeXT 400 dpi Level Il Printer  rpm |
Repertoire_Color_Print . NeXT Color Printer marion
Sly_Personal_Printer = NeXT 400 dpi Level ll Printer - axe

The Printers window lists printers connected to your computer first, followed
by those available on a network. You can open Printer Queue windows for as
many printers as you want. '

A Printer Queue

e , . window shows
 Name: Loca/ Frinter the files currently
Type: NeXT400 cpi Level 1] inthe print queue
.+ ~Note: - GiEaT for the printer
~ Status: Frinting you selected.

Attist Bios.nf -
Festival Releasetfd - -~ Eq

7
M indicates that manual feed
was chosen in the Print panel.

The owner is the user name of )
the person who printed the file.

The Printer Queue window lists the files in the order they’ll be printed.
The one at the top is printed first.



Managing the print queue

1 Start upihe PrintManager
application.

If you change your mind about printing a file after you’ve clicked Print in the
Print panel, you can delete the copy that was sent to the print queue to stop it

2 Open the queue from printing. You can also temporarily pause and then resume all printing,

window for the printer

Printer Queue

whose queue you want p Click to stop
to manage. ame: Local_Frinter S ——— all printing
9 Type: NeXT 400 dpi Level I Printar abg | ® temporarily.
. Note:
3 tSelec*t fllesfyou \;vl;'mt Status: Printing Pause Delete «
O remove 1rrom the - , - o
- L [ii3mel || I appiicatonl | KOwnerd | [Pagest| Mize e | [Feea]| .

queue and click Delete. Attist Bios.nif Edit starr 3 12K M | \ gIth7de¢fjte

. : i - e selecte
Or c"_Ck_Pause to stop | Festival Release.rifd - Edit starr 2 8K files from the
a“_ printing on th_at || Active.mbox Mail starr 1 4K queue.
printer temporarily.

1 1

For more information about
PrintManager, see Chapter 18,

“Managing Printers and Fax
Modems.”

When you click Delete, selected files are removed from the print queue. If
you delete a file that was being printed, no more pages in the file are printed.
If you share a printer, you can delete only your own files from the queue.

Remember that the files in the print queue are just copies. Deleting them has
no effect on the original files.

files are simply added to the queue

What Happens When You Pause

When you click the Pause button, it

changes to Continue and the printer
stops printing until you click the
button again. All files in the queue—
including any file that was being
printed when you clicked Pause—
are held in the queue until you
continue printing. While printing is
paused, anyone with access to the
printer can still use it. However, their

until printing is resumed.

If you click Pause in the queue
window for a printer that’s not
connected to your computer, you
don‘t stop printing any files that are
already in the queue. You also don't
stop anyone else from using the
printer. Instead, you sim